


   Df

2 Copyright

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 COPYRIGHT

No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of Digital Film Tools.

Copyright © Digital Film Tools, LLC. 2012. All Rights Reserved

April 30, 2012
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 ABOUT US

Tiffen has been a leading manufacturer and supplier of photographic filters and 

lens accessories for the consumer/professional imaging and the motion picture 

and broadcast television industries for over 69 years.

The company has a rich history of innovative product design, superior optical 

consistency and unparalleled quality. Tiffen has been recognized for its product 

and engineering excellence earning two Technical Achievement Awards and a 

Scientific and Engineering Award from the Academy of Motion Picture Arts & 

Sciences, as well as an Emmy Award from the Academy of Television Arts and 

Sciences.

The company's Special Effects optical filters, once an exclusive of the Motion 

Picture and Television industry are now available to still photographers and 

videographers through the Tiffen Hollywood F/X filter line and digitally through 

the Dfx line of software. The Dfx software is produced in collaboration with 

Digital Film Tools, a computer software company which is an off-shoot of a Los 

Angeles based motion picture visual effects facility. Their work includes 

hundreds of feature films, commercials and television shows. Together, our 

combined understanding of optical filters and computer software creates an 

unbeatable combination.
Dfx User Guide    
• 
• 
•
•
•



   Df

4 About this Guide

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 ABOUT THIS GUIDE

This User Guide is a reference for the Tiffen Dfx Digital Filter Suite. You can 

read from start to finish or jump around as you please. This guide is available 

in Acrobat PDF format.

Trademark Recognition
Black Diffusion/FX®, Black Pro-Mist®, Bronze Glimmerglass®, Color-Grad®, 

Glimmerglass®, Gold Diffusion/FX®, HDTV/FX®, HFX® Star, Nude/FX®, Pro-

Mist®, Smoque®, Soft/FX®, 812® Warming, Warm Black Pro-Mist®, Warm 

Pro-Mist® and Warm Soft/FX® are trademarks of The Tiffen Company, LLC.

All other product names used in this manual are the properties of their 

respective owners and are acknowledged. All other references to trademarks 

or registered trademarks are the property of their respective owners.
x User Guide
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 INSTALLATION

Video/Film Plug-ins
1 Install Dfx using your installation CD.

or

2 Download Dfx at www.tiffen.com

3 Double-click on the file that was downloaded and run through the installation 
process.

4 When prompted, select the destination programs to install to. You can choose 
from After Effects, Avid, Final Cut Pro and Premiere Pro.

5 Start your program and apply Dfx:

• Adobe After Effects: Apply Dfx to a clip in the timeline from one of the Effects > 
Tiffen Dfx v3 menus.

• Adobe Premiere Pro: Apply Dfx to a clip in the timeline from one of the Effects > 
Video Effects > Tiffen Dfx v3 groups.

• Apple Final Cut Pro 6&7: Apply Dfx to a clip in the timeline from one of the 
Effects > Video Filters > Tiffen Dfx v3 groups.

• Apple Final Cut Pro X: Select a clip in the timeline and apply Dfx from one of the 
Effects > Tiffen Dfx v3 groups.

• Apple Motion: Drag a Dfx filter from one of the Library > Filters > Tiffen Dfx v3 
groups to the image in the Canvas.

• Avid Editing Systems: Apply Dfx to a clip in the timeline from one of the Effect 
Palette > Tiffen Dfx v3 groups.

A dialog box pops up when you run Dfx.

6 If you purchased the software, select Activate Dfx and follow the instructions.

or 

7 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of Dfx for the specified trial period. At the end of the trial 
period, Dfx reverts to a limited demo mode.

or

8 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, a watermark is superimposed over the image.
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 UNINSTALLING

Windows
From the Windows Start Menu, select Programs > Digital Film Tools > Dfx v3.0 

> Uninstall Dfx.

Macintosh
Go to Applications/Digital Film Tools/Dfx v3.0 and double-click on Uninstall Dfx.
x User Guide
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 ACTIVATING, DEACTIVATING AND 
TRANSFERRING LICENSES

Activation Options

Internet Activate (Recommended)
Activates Dfx over the Internet.

Request License from Self-Service Website
If you do not have an Internet Connection on the computer where you want to 

run Dfx, use this option. The self-service website will generate a license file 

which you can then transfer to the desired computer.

Install a License File
Loads a license file obtained from the self-service website or received by email.

Note: If you experience an error when using Internet Activate, it is because you or your 
company uses a proxy server to access the Internet and/or your firewall is blocking our 
program’s access to the Internet. For proxy server users, select Advanced Options and 
enter the appropriate proxy server settings. For firewall users, open your firewall 
software and allow our software to access the Internet.

Deactivation Options
Once Dfx has been activated, you can access the Deactivation Options by 

selecting the License menu.

Internet Deactivate
Deactivates Dfx over the Internet and is only available if you initially activated 

over the Internet. Use this method to return your Product Code back to the 

activation server. You will then be able to use your Product Code to activate Dfx 

on another computer.
Dfx User Guide    
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License Transfer
Your Product Code allows you to run Dfx on one computer at a time. However, 

you may transfer the license by deactivating on one computer and activating on 

another.

Internet Deactivate / Internet Activate is the preferred method of license 

transfer between computers, but is only available if you initially activated over 

the Internet and currently have Internet access. If you do not have Internet 

access, you will need to contact customer support to assist you in transferring 

the license.

To transfer a license:

1 Open the License menu.

• After Effects / Premiere Pro: Apply a Dfx filter and click on License at the bottom 
of the Effect Controls window.

• Apple Final Cut Pro 6&7: Apply a Dfx filter and click on License at the bottom of 
the Filters tab.

• Apple Final Cut Pro X / Motion: Apply a Dfx filter and click on License at the bottom 
of the Inspector.

• Avid Editing Systems: Apply a Dfx filter and click on License at the bottom of the 
Effect Editor.

2 Choose Internet Deactivate (Recommended) and click Next.

Dfx is now deactivated.

3 On the target computer, select Activate Dfx and follow the instructions.

Dfx will then activate on the new computer.
x User Guide
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 INTRODUCTION

Tiffen Dfx Digital Filter Suite
The Tiffen Dfx digital filter suite is the definitive set of digital optical filters. Up to 

2000 filters, including simulations of many popular award-winning Tiffen glass 

filters, specialized lenses, optical lab processes, film grain, exacting color 

correction plus natural light and photographic effects--are now in a controlled 

digital environment with either 8 or 16 bit per channel processing.

Available in various configurations: as a powerful but user friendly standalone 

application, or as plug-ins for either photo or video and film post production 

software, Tiffen Dfx filters expand your creative experience.

Dfx provides you with everything you will need to enhance your images using 

a staggering amount of filter presets. Using the Dfx Standalone or photo plug-

in versions, any filter can be limited to a portion of the screen using 

sophisticated but simple to use masking controls. A layering system to apply 

multiple filters as well as the Standalone’s batch processing system rounds out 

Dfx’s set of tools.

Whether you are an amateur or professional photographer, a video or film 

editor, or graphic designer, Dfx’s visual workflow and easy to use tools will help 

you create stunning images.

Dfx is comprised of the following filters: Ambient Light, Black and White, 

Black/White Looks, Black Diffusion/FX®, Black Pro-Mist®, Bleach Bypass, 

Blur, Bronze Glimmerglass®, Center Spot, Chromatic Aberration, Close-Up 

Lens, Color Compensating, Color Conversion, Color Correct, Color-Grad®, 

Color Infrared, Color Looks, Color Shadow, Color Spot, Cool Pro-Mist®, Cross 

Processing, Day for Night, DeBand, DeBlock, DeFog, DeFringe, DeNoise, 

Depth of Field, Diffusion, Dot, Double Fog, Dual Grad, Edge Glow, Enhancing, 

Eye Light, Faux Film, Film Stocks, Flag, Flashing, Fluorescent, Fog, F-Stop, 

Gels, Glimmerglass®, Glow, Glow Darks, Gobo, Gold Diffusion/FX®, Gold 

Reflector, Grain, Halo, Haze, HDTV/FX®, High Contrast, HFX® Star, Ice Halos, 

Infrared, Kelvin, Key Light, Lens Distortion, Light, Light Balancing, Low 

Contrast, Match, Mono Tint, ND-Grad, Night Vision, Nude/FX®, Old Photo, 
Dfx User Guide    
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Overexpose, Ozone, Pencil, Photographic, Polarizer, Printer Points, Pro-

Mist®, Rack Focus, Radial Exposure, Rainbow, Rays, ReLight, Selective Color 

Correct, Selective Saturation, Sepia, Sky, Silver Reflector, Smoque®, Soft 

Contrast, Soft/FX®, Soft Light, Split Field, Split Tone, Star, Streaks, Strip Grad, 

Sunset/Twilight, Telecine, Temperature, Texture, Three Strip, Tint, Two Strip, 

Ultra Contrast, Vari-Star, Vignette, 812® Warming, Warm Black Pro-Mist®, 

Warm Center Spot, Warm Polarizer, Warm Pro-Mist®, Warm Soft/FX®, Water 

Droplets, Wide Angle Lens, and X-Ray.

Dfx Features
• 121 individual filters

• Thousands of customizable presets

• Simulation of Tiffen glass camera filters, specialized lenses, optical lab 
processes, film grain, exacting color correction as well as natural light and 
photographic effects

• Rosco and GamColor Gel libraries

• Rosco and Gam Gobo libraries for lighting effects

• 8 or 16 bit image processing

• Multi-processor acceleration
x User Guide
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Filter Categories
The Filters are categorized by filter function: Film Lab, HFX Diffusion, HFX 

Grads/Tints, Image, Lens, Light, and Special Effects.

Film Lab
1 Bleach Bypass

2 Cross Processing

3 Faux Film

4 Film Stocks

5 Flashing

6 Grain

7 Overexpose

8 Three Strip

9 Two Strip
Dfx User Guide    
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HFX Diffusion
1 Center Spot

• Center Spot

• Warm Center Spot

2 Diffusion

3 Diffusion/FX®

• Black Diffusion/FX®

• Gold Diffusion/FX®

4 Glimmerglass®

• Glimmerglass®

• Bronze Glimmerglass®

5 HDTV/FX®

6 High Contrast

7 Low Contrast

8 Pro-Mist®

• Pro-Mist®

• Cool Pro-Mist®

• Warm Pro-Mist®

• Black Pro-Mist®

• Warm Black Pro-Mist®

9 Smoque®

10 Soft Contrast

11 Soft/FX®

• Soft/FX®

• Warm Soft/FX®

12 Ultra Contrast
x User Guide
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HFX Grads/Tints
1 812® Warming

2 Color Spot

3 Color-Grad®

4 Dual Grad

5 Gels

• GamColor

• GamColor Cine Filters

• GamColor Naked Cosmetics

• Gels

• Rosco CalColor

• Rosco Cinegel

• Rosco Cinelux

• Rosco Storaro Selection

6 Mono Tint

7 ND-Grad

8 Nude/FX®

9 Old Photo

10 Photographic

• Color Compensating

• Color Conversion

• Light Balancing

• Photographic

11 Sepia

12 Split Tone

13 Strip Grad

14 Sunset/Twilight

15 Tint
Dfx User Guide    
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Image
1 Black and White

2 Color Correct

3 DeBand

4 DeBlock

5 DeNoise

6 FL-B/D®

7 F-Stop

8 Haze

9 Kelvin

10 Match 

Note: Match is not supported in Final Cut Pro X because of limitations in it’s plug-in 
format.

11 Ozone

12 Printer Points

13 Selective Color Correct

14 Selective Saturation

15 Sky

16 Telecine

17 Temperature

Lens
1 Blur

2 Chromatic Aberration

3 Close-Up Lens

4 Defringe

5 Depth of Field

6 Lens Distortion

7 Rack Focus

8 Radial Exposure

9 Split Field

10 Vignette

11 Wide Angle Lens
x User Guide
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Light
1 Ambient Light

2 Dot

3 Edge Glow

4 Eye Light

5 Flag

6 Glow

7 Glow Darks

8 Gobo

9 Halo

10 HFX® Star

11 Ice Halos

12 Key Light

13 Light

14 Rainbow

15 Rays

16 Reflector

• Gold Reflector

• Silver Reflector

17 ReLight

18 Soft Light

19 Star

20 Streaks

21 Vari-Star

22 Water Droplets
Dfx User Guide    
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Special Effects
1 Color Infrared

2 Color Shadow

3 Day for Night

4 Defog

5 Double Fog

6 Enhancing

7 Fog

8 Infrared

9 Looks

• Black/White Looks

• Color Looks

10 Night Vision

11 Pencil

12 Polarizer

• Polarizer

• Warm Polarizer

13 Texture

14 X-Ray
x User Guide
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Dfx User Interface
1 Apply a Dfx filter that contains presets. For instance, Special Effects > Looks.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out the various filter presets.

4 Adjust the filter parameters to your liking.

5 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.
Dfx User Guide    
• 
• 
•
•
•



   Df

18 Introduction

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Tagging and Sorting Favorite Presets
Presets can be tagged as a Favorite allowing them to be sorted separately in 

the Presets window.

1 Apply a Dfx filter with presets.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Tag a preset as a Favorite by selecting the preset and pressing the Toggle 
Favorite icon located at the top right of the Presets window.

Presets tagged as a favorite display a yellow star at the top right of the preset.

4 To sort the Presets window by Favorites, select Favorites in the Presets pop-up 
menu.
x User Guide
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Comparing Images
Dfx can compare images using Side-by-Side, Vertical Split, Horizontal Split or 

A/B comparison modes. By default, the current filter and original image are 

selected for comparison.

1 Apply a Dfx filter and make sure it is affecting the image in some way.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Click on the Side-by-Side Comparison icon.
Dfx User Guide    
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Horizontal images are stacked vertically and vertical images are placed side by 

side.

4 Click the Vertical Split Comparison mode icon.
x User Guide



• 

Introduction  21 

• 
• 
• 
•
•
•

You can now compare the images using a vertical split.

5 Move your cursor into the image area over the split line and when the cursor 
changes to a double-arrow, click and drag to move the split. 

Depending on the filter used, the split line may not be obvious, so triangular 

sashes on the outside of the image help you find it. If you drag the sash all the 

way around, it will swap directions.

6 Click the A/B Comparison icon repeatedly to cycle the current filter with the 
original image.

7 When done, press the A/B Comparison icon to turn it off.
Dfx User Guide    
• 
• 
•
•
•



   Df

22 Introduction

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Creating Variations
Variations based on either one or two parameters can be created and are 

displayed as thumbnails in a window below the Presets window.

1 Apply a Dfx filter.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.
x User Guide
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3 Click on a parameter name in the Parameters window.

Variable parameters are Ranges, Toggles, and Colors.

When you select a parameter, the Variations appear and you'll see the 

variations being generated on that parameter. 

4 Click on a second parameter and it will generate variations between the two.

The first parameter you click on will be the dominant parameter - it'll go across 

the top of the Variations tab. So, you can get different results depending on the 

order you select the parameters.

5 Click on a selected parameter to toggle it back off again.

Note: You can only have one or two parameters selected at a time. If you click on a 
third parameter, the last parameter you clicked on will deselect itself. If you deselect 
both of the parameters, the Variations window will disappear because the variations are 
no longer being generated.

Variations are generated based on the current effect parameters. So, you can 

pick some parameters for your variation, then go back to the Presets window 

and pick a different Preset, and the variations will regenerate.

See Variations for more information.
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Setups
A Setup takes a snapshot of the parameter settings applied to your image. 

Setups can be saved and loaded and are independent of the image they were 

originally applied to.

1 Apply a Dfx filter.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Choose a preset and make some parameter adjustments.

4 Select File > Save Setup.

5 When the file browser opens, enter a name and click Save.

You can now apply this setup to a different image using File > Open Setup.
x User Guide
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 FILTER TUTORIALS

Ambient Light
Ambient creates light without a defined source and contributes to the overall 

brightness of a scene without casting shadows.

1 Apply Ambient Light from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Brightness to set the intensity of the ambient light. 

5 To apply a custom light color to the image, click on the Color box and select a 
color.

Note: The Color picker allows you to treat the light with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

6 To apply a colored gel to the light, select one from the GamColor Presets pop-up 
menu.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Ambient Light filter for more information.
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Black and White
Black and White converts color images to black and white simulating the look 

of Black and White photographic filters.

1 Apply Black and White from the Image category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 From the Filter pop-up, select the type of black and white filter to be applied to 
your color image.

Your choice of filter can dramatically change the black and white result.

5 Use the Brightness, Contrast and Gamma controls to further adjust the image.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Black and White filter for more information.
x User Guide
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Bleach Bypass
Bleach Bypass is a film laboratory technique where, by skipping the bleach 

stage in the color processing sequence, silver is retained in the image along 

with the color dyes. The result is effectively a black and white image 

superimposed on a color image. Bleach Bypass images have increased 

contrast, reduced saturation, often giving a pastel effect.

1 Apply Bleach Bypass from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Use the Amount slider to control the strength of the Bleach Bypass filter.

5 Saturation, Contrast and Temperature sliders are provided for additional 
enhancement.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Bleach Bypass filter for more information.
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Blur
It’s fast, high quality and blurs outside the frame which removes the dark inward 

bleeding edges of most blurs. Horizontal, vertical or both, Blur uses either 

Gaussian or Box quality settings.

1 Apply Blur from the Lens category.

2 Adjust the Horizontal Blur slider. 

Since the Gang button is activated, the Vertical Blur amount will match the 

Horizontal value.

3 Un-click the Gang slider and now the Horizontal and Vertical sliders can be 
moved independently.

4 Change the Quality setting from Box to Gaussian.

Gaussian is a higher quality blur, but comes with a price--it’s slower.

See the Blur filter for more information.
x User Guide
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Center Spot / Warm Center Spot
Center Spot diffuses and blurs distracting backgrounds while keeping a center 

spot in focus. The center spot can be moved, sized and the amount of blur can 

be controlled. Warm Center Spot combines the benefits of Center Spot with a 

warming filter making it ideal for portraits and skintones.

1 Apply Center Spot from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 Adjust the Spot > Position by clicking and dragging the center image point to the 
desired location. 

6 Set the Radius, Falloff Radius and Falloff.

The area covered by the spot will be in focus with all other areas blurred.

7 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

8 Adjust the Horizontal and Vertical Blur to your liking.

9 If you applied a Warm Center Spot preset, adjust the Temperature > Color and 
Opacity sliders to your liking.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Center Spot / Warm Center Spot filters for more information.
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Chromatic Aberration
Chromatic aberration is caused by a lens having a different refractive index for 

different wavelengths of light and is seen as fringes of color around the edges 

of the image. This fringing is removed by un-distorting the individual color 

channels.

1 Apply Chromatic Aberration from the Lens category.

2 Look at the edges of the image and determine if the chromatic aberration is 
red/cyan, green/magenta, or blue/yellow.

3 Start by adjusting the Distortion parameter for the particular color fringing that 
you are trying to remove. For instance, if you see red/cyan fringing, adjust the 
Distortion slider in the Red/Cyan group.

If you are using anamorphic motion picture lenses or are experiencing non-

radial, asymmetric fringing, you may need to adjust the Anamorphic Squeeze 

and Curvature X/Y parameters.

See the Chromatic Aberration filter for more information.
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Close-Up Lens
Simulates close-up lenses that allow you to zoom in extra close using high 

quality digital filtering.

1 Apply Close-Up Lens from the Lens category.

2 Adjust Scale X to zoom into the center of the image.

By default, the Scale X and Scale Y sliders are ganged together so the image 

is proportionately scaled when Scale X is used.

3 To select a different portion of the image to zoom in on, click and drag the center 
image point.

4 You can also use the Rotate slider if needed.

See the Close-Up Lens filter for more information.
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Color Correctors
Dfx includes a number of different color correctors that are handy for adjusting 

an image’s color. They include: Color Correct, F-Stop, Printer Points, Telecine 

and Temperature.

1 Apply Color Correct, F-Stop, Printer Points, Telecine or Temperature from the 
Image category.

2 Adjust any of the controls in the Master group.

The master settings affect the entire image. However, you can also use 

selections in the shadow, midtone and highlight regions to adjust the color 

selectively in those areas.

Note: Lift, Gamma and Gain in the Telecine filter are the same as Shadows, Midtones 
and Highlights.

3 Change your View to Shadows, Midtones or Highlights to see the selection 
values.

The areas that are white in the selection are the areas that will be adjusted by 

the color controls. The areas defined as shadows, midtones or highlights can 

be adjusted by modifying the Position and Range parameters.

4 Use the Shadows, Midtones or Highlights Position parameters if you want to 
select different values to be used for the selection.

5 Increase the Shadows, Midtones or Highlights Range controls to add more 
values to the selection. Decrease for less values.

6 Change your View to Output to see the image.

7 Adjust the color controls in the Shadows, Midtone or Highlight controls to see 
how it affects your image.

See the Color Correctors for more information.
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Color-Grad®
Color-Grad® can transform an average sunrise or sunset into something 

spectacular or convert a dull, washed-out sky to a breathtaking blue. Add color 

selectively while leaving the rest of the scene unaffected by using a graduated 

transition between the colored portion and the original image.

1 Apply Color-Grad® from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

The white area of the Grad will be tinted.

6 If you want less coloring of the image, turn down the Filters > Opacity.

7 Image highlights can be retained by adjusting the Filters > Preserve Highlights 
control to a value of 100.

8 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Color-Grad® filter for more information.
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Color Infrared
Color Infrared simulates infrared filters used in conjunction with infrared 

sensitive film or sensors to produce very interesting false-color images with a 

dreamlike or sometimes lurid appearance.

1 Apply Color Infrared from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Magenta and Blue sliders to your liking.

5 Changing the Hue will only adjust hue in non-blue areas.

Color Infrared images usually have high contrast. 

6 Lower the Contrast setting if it is too high for your image.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Color Infrared filter for more information.
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Color Shadow
Creates a high contrast image overlayed with a gradient.

1 Apply Color Shadow from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Threshold to obtain the desired amount of image detail.

The color gradient can be adjusted to your specific image.

5 Adjust the Grad > Direction, Corner Points and Size to position and adjust the 
grad.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

6 To change the background or gradient colors, click on the Background Color, 
Color 1 or Color 2 > Color boxes and select a color.

Color 1 sets the top of the gradient and Color 2 sets the bottom of the gradient.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Color Shadow filter for more information.
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Color Spot
Tints the image using presets for common photographic filters except for a 

center spot which retains normal color. The center spot can be moved, sized 

and the amount of blur can be controlled. 

1 Apply Color Spot from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Spot > Position by clicking and dragging the center image point to the 
desired location. 

5 Set the Spot > Radius, Falloff Radius and Falloff.

6 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

The white area of the spot will be tinted.

7 If you want less coloring of the image, turn down the Color > Opacity.

8 Image highlights can be retained by adjusting the Color > Preserve Highlights 
control to a value of 100.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Color Spot filter for more information.
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Cross Processing
Cross-processing is a photographic technique where print film (C41) is 

processed in the set of chemicals usually used to process slide film (E6) or vice 

versa. The final result yields images with oddly skewed colors and increased 

contrast and saturation. Different film stocks produce different results, so we 

have created what we feel is a representative look.

1 Apply Cross Processing from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Use the Amount slider to control the strength of the Cross Processing filter.

5 Switch the Mode to Slide to Print.

Both Print to Slide and Slide to Print modes are available.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Cross Processing filter for more information.
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Day for Night
Day for Night simulates a technique used for shooting exteriors in daylight 

made to look like they were photographed at night. 

1 Apply Day for Night from the Special Effects category.

Day for Night uses a type of diffusion that grows darks areas into bright areas. 

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Diffusion > Blur and Opacity parameters to your liking.

The Day for Night effect relies on a blue tint to simulate moonlight. You can 

modify the color of the tint as well as its intensity using the Moonlight controls.

5 Use the Moonlight controls to adjust the tint applied to the image.

Photographically the image is underexposed by two stops or so. We duplicate 

the underexposure by using a combination of color correction controls. Modify 

the color correct presets brighter or darker depending on your image.

6 Change the Color Correct settings if necessary.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Day for Night filter for more information.
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Defog
Using advanced deweathering algorithms, Defog restores clear day contrasts 

and colors of a scene taken in bad weather such as fog and mist. It is also 

successful in removing the effects of optical Fog and Diffusion filters.

1 Apply Defog from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Click on the Defog > Color picker and click on an area of fog.

This sets the color of the fog to be removed.

5 Adjust the Defog > Defog parameter to remove more fog or mist.

The fog is removed in a radial pattern emanating from the vanishing point. For 

instance, if your fog moves in the direction of top right to bottom left, set your 

vanishing point towards the top right corner and the fog removal will be more 

intense at the upper right and fall off at the bottom left. However, in most cases, 

the vanishing point can be left in the center of the screen and you will obtain 

acceptable results.

6 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the screen.

If the defogging operation causes the shadow areas to become too contrasty, 

adjust the Min Depth slider to a lower value. This will bring back some shadow 

detail.

7 Lower the Min Depth value if you have lost to much detail in the shadow portions 
of the image.

8 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.
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See the Defog filter for more information.
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Defringe
Purple or blue fringing around overexposed areas is a result of sensor 

overloading in video as well as digital still cameras. Defringe isolates and 

removes the various types of color fringing.

1 Apply Defringe from the Lens category.

Determine the color of the fringing that you would like to remove. Let’s say that 

you have purple fringing in the highlight areas of your image.

2 Go to the Magenta parameter group.

3 Move the Magenta slider to the right until the purple fringing is gone.

4 If the purple fringing is not being removed when the Magenta slider is adjusted, 
you may need to adjust the Position slider.

5 Change your View to Magenta to see the selection values. 

The areas that are white in the selection are the areas that will be defringed.

6 Change your View back to Output.

7 Move the Position slider to the right or left until you see the fringing go away.

This may be necessary if your purple fringing is not the same hue of what we 

consider to be magenta.

8 If there is still some magenta left, you may want to increase the value of the 
Range slider to include more values considered as magenta.

See the Defringe filter for more information.
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Depth of Field
Depth of Field can be added to a scene by isolating and blurring only a portion 

of the image. The amount of blurring is directly proportionate to the luminance 

of the depth source.

1 Apply Depth of Field from the Lens category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Horizontal and Vertical Blur to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, depth of field.

5 Change your View to Depth to see the selection values. 

The areas that are white in the selection are the areas where blur will be 

introduced. The location of the blur within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

6 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

7 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

8 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

9 Change your View to Output to see the filtered image.

The Depth of Field filter can also use a grad or an image as the depth source 

instead of the selection.

10 Set the Depth to Grad or Strip.

Grad is a linear gradient while Strip is a strip gradient.

11 Adjust the Grad > Direction, Corner Points and Size to change where the blur is 
added.

To adjust the Corner Points, just click and drag them to the desired location.
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Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

12 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

13 To use an image as the depth source in Adobe After Effects:

• Change Depth > Depth to Input. 

• Select the layer you want to use from the Depth > Input selector.

or

14 To use an image as the depth source in Adobe Premiere Pro:

• Change Depth > Depth to Input. 

• Select the track you want to use from the Depth > Input selector located below the 
Depth > Depth pop-up.

or

15 To use an image as the depth source in Apple Final Cut Pro 6&7:

• Change Depth > Depth to Input. 

• Drag and drop a clip onto the clip icon to the right of the Depth > Input parameter.

Note: Using an image as a depth source in Apple Final Cut Pro X is not supported 
because of limitations with it’s plug-in format.

or

16 To use an image as the depth source in Avid Editing Systems:

• Change Depth > Depth to Input. 

• The track below the one that you added Depth of Field to is used as the depth 
source. 

See the Depth of Field filter for more information.
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Diffusion
Diffusion creates atmosphere by reducing contrast while creating a glow 

around highlights or shadows. It simulates diffusion and fog filters as well as 

glows. In addition, a texture library allows you to add realistic diffusion to 

scenes as if you were adding diffusion directly to your camera lens.

1 Apply Diffusion from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

Each preset uses a different texture to create the diffusion effect.

4 Adjust the Diffusion > Brightness parameter to control the amount of diffusion 
added to the image.

You can either use the texture by itself or combine it with a selection using one 

of the Texture > Blend Modes. The areas that are white in the selection are the 

areas where diffusion will be introduced. 

5 Combine the texture with a selection by changing the Texture > Blend Mode from 
Texture Only to Multiply.

I like the Multiply blend mode because it only adds the texture in the areas of 

the selection.

6 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where diffusion will be 

introduced. The location of the diffusion within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

7 Change the Selection > Position parameter if you want to add diffusion to 
different areas of the image.

8 Adjust the Selection > Range slider to increase or decrease the image areas 
affected by the diffusion.

9 Change your View to Output to see the filtered image.

10 Adjust the position of the texture by clicking and dragging the center image point 
to the desired location.
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11 You can also use the Texture > DVE controls to transform the texture.

12 Adjust the Diffusion > Brightness, Blur and Color of the diffusion to your liking.

13 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Diffusion filter for more information.
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Diffusion/FX®
Black Diffusion/FX® gives a silky-smooth look to textured surfaces, suppresses 

facial blemishes and wrinkles, while maintaining a clear, focused image. 

Creates a diffused image that doesn't look like it's been shot through a filter. 

Gold Diffusion/FX® infuses special warmth by adding a soft, golden tint to 

shadows.

1 Apply Diffusion/FX® from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

In some of the filters, a selection is generated to create the desired effect--in 

this case, smoothing of image details.

5 Change your View to Selection to see the selection values.

The idea here is to generate a selection that isolates the areas of the image that 

need to be smoothed. For instance, you might be trying to isolate and smooth 

the skin on a person’s face. The white areas of the selection are the areas that 

will be smoothed. The selection has been preset to a midtone selection. This 

can be modified by using Selection > Position to select the luminance value and 

Selection > Range to select the amount of values to be used for the selection.

6 If needed, change the Selection > Position parameter so that the image areas you 
are trying to smooth are as white as possible in the selection.

7 Adjust the Selection > Range value so that the white values of the selection are 
limited as much as possible to the image areas that you are trying to isolate.

In the case of a person’s face, adjust the Selection > Position so that the face 

you are trying to smooth is as white as possible in the selection, and set the 

amount of white values in the person’s face using Position > Range.
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8 Increase the Selection > Blur parameter if you want to soften the transition areas 
of the selection.

9 Change your View to Edge to see the edge values. 

The areas that are white in the edge is where detail in the image is retained.

10 Adjust the Edge > Brightness of the edge selection to make sure that you have 
sufficient levels of white in areas where you would like to retain detail.

For a person’s face, make sure that you have sufficient levels of white edges in 

areas such as the eyes, nose and mouth.

11 Set the Edge > Blur to smooth out the edge selection.

12 Change your View to Output to see the filtered image.

13 Adjust the Horizontal and Vertical Blur to smooth out detail.

14 If the image is looking too soft, increase the Edge > Brightness, decrease the 
amount of Blur added to the scene or modify the Selection > Position and Range 
parameters.

15 If you applied a Gold Diffusion/FX® preset, adjust the Temperature > Color and 
Opacity sliders to your liking.

16 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Diffusion/FX® filters for more information.
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Double Fog
The Double Fog filter creates a soft, misty atmosphere over the image by first 

applying fog using a vanishing point along the direction of increasing distance 

in the image. Then, a second pass blooms image highlights.

1 Apply Double Fog from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Click on the Fog > Color parameter to set the color of the fog.

This sets the color of the fog to be added.

5 Adjust the Fog > Fog parameter to control how much overall fog is added to the 
image.

The fog is added in a radial pattern emanating from the vanishing point. For 

instance, if want your fog to move in the direction of top right to bottom left, set 

your vanishing point towards the top right corner and the fog will be more 

intense at the upper right and fall off at the bottom left. However, in most cases, 

the vanishing point can be left in the center of the screen and you will obtain 

acceptable results.

6 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the screen.

You can limit where the fog is added to your image by using the Min/Max Depth 

sliders. Min Depth controls how much fog is added in the darker areas of the 

image, while Max Depth controls how much fog is added in the brighter areas 

of the image.

7 Change the Min/Max Depth values if you want to control how fog is added in the 
shadow and highlight areas of the image.

Secondary fogging effects can be achieved using the Glow parameters. A 

portion of the screen is isolated with a selection, and based on this selection, 

additional fog and glow can be added.
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8 Adjust the Glow > Brightness, Blur and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, highlight glow.

9 Change your View to Selection to see the selection values.

The areas that are white in the selection are the areas where glow will be 

introduced. For instance, If you want to put glow around bright lights, make sure 

that the light sources appear as white in the selection. The location and amount 

of the additional glow within the scene can be adjusted by modifying the 

Selection > Position and Selection > Range parameters.

10 Change the Selection > Position parameter if you want to select different 
luminance values to be used for the selection.

11 Increase the Selection > Range value to add more glow into the scene. Decrease 
for less glow.

12 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

13 Change your View to Output to see the filtered image.

14 To create Glow effects around highlights such as bright lights, change your Glow 
> Blend parameter to Add and make sure that your selection includes only the 
light sources.

15 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Double Fog filter for more information.
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Dual Grad
Dual Grad applies two photographic filters to the image which are blended 

together with a gradient.

1 Apply Dual Grad from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

The color gradient can be adjusted to your specific image.

4 Adjust the Grad > Direction, Corner Points and Size to position and adjust the 
grad.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 To apply a custom color to the image, select Custom from the Color 1 or Color 2 
> Presets pop-up menu and click on the Color 1 or Color 2 > Color box and select 
a color.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

6 If you want less coloring of the image, turn down the Color 1 or Color 2 > Opacity.

7 Image highlights can be retained by adjusting the Preserve Highlights control to 
a value of 100.

8 Change your View to Grad to see the color gradient being applied to the image.

9 Change your View back to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Dual Grad filter for more information.
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Edge Glow
Edge Glow isolates lines and edges in an image and then adds glow only to 

these areas resulting in a stylized look.

1 Apply the Edge Glow filter from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Select either the Add or Screen Blend Mode. Add will burn out highlights while 
the Screen Mode will retain them.

5 Adjust the Glow > Brightness, Blur and Color settings to your liking.

In Edge Glow, an edge selection is generated to create the desired effect.

6 Change your View to Edge to see the selection values. 

The areas that are white in the edge selection are the areas where glow will be 

introduced.

7 Adjust the Edge > Brightness to make sure that you have sufficient white areas 
in the edge selection.

8 Set the Edge > Blur to smooth out the edge selection.

9 Change your View to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Edge Glow filter for more information.
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Enhancing
Makes reds, rust browns and oranges pop, with minimal effect on other colors. 

Perfect for fall foliage, earthtone rock formations, architecture, woodwork, 

faded rustic barns and any photos where red, brown and orange subjects 

should be enriched or appear more intense. In addition, the green or blue areas 

of the image can be isolated and enhanced with minimal effect on other colors.

1 Apply the Enhancing filter from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Enhancing slider to make the red, orange and brown values pop.

In some of the filters, a selection is generated to create the desired effect--in 

this case, the enhancement effect. By default, the Selection > Hue is preset to 

red values.

5 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the red, orange and brown areas 

of the image that will be enhanced. The enhancement effect within the scene 

can be adjusted by modifying the Selection > Hue and Selection > Range 

parameters.

6 Choose another Selection > Preset or change the Selection > Hue parameter if 
you want to add enhancement to different areas of the image.

7 Adjust the Selection > Range slider to increase or decrease the areas affected by 
the enhancement.

8 Change your View to Output to see the image.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.
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See the Enhancing filter for more information.
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Eye Light
Creates a targeted light to be placed around a person's eyes.

1 Apply Eye Light from the Light category.

2 Using the DVE controls, you can transform the eye light.

3 Select either the Light > Blend > Add or Screen Blend Mode. 

Add will burn out highlights while the Screen Mode will retain them.

4 Adjust the Light > Brightness to set the intensity of the light.

Note: You can darken the entire image except for the eye light shape by adjusting the 
Shadow > Brightness.

5 Use the Light > Blur sliders to control the softness of the light.

6 To apply a custom light color to the image, click on the Color box and select a 
color.

Note: The Color picker allows you to treat the light with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

7 To apply a colored gel to the light, select one from the Gamcolor Presets pop-up 
menu.

See the Eye Light filter for more information.
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Faux Film
Faux Film attempts to give video or digital images the look of photographic film. 

It reduces contrast, creates a soft mist around highlights and adds film grain.

1 Apply Faux Film from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Mist > Brightness, Blur and Color as well as the Grain > Size and 
Amount settings to your liking.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

5 If you want, you can use the Color Correct controls to modify the color of the 
image.

In some of the filters, a selection is generated to create the desired effect--in 

this case, diffusion.

6 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where diffusion will be 

introduced. The location of the diffusion within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

7 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

8 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

9 Increase the Selection > Blur parameter to soften the transition areas of the 
selection. 

10 Change your View to Output to see the filtered image.

11 The softness of the diffusion can also be adjusted using the Mist > Blur setting.

12 Click the Done button to return to the host application.
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The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Faux Film filter for more information.
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Film Stocks
Film Stocks is a unique filter that simulates a 113 different color and black and 

white photographic film stocks.

1 Apply Film Stocks from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the film stocks are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of film stock presets.

Each preset sets a combination of the various parameters to achieve the 

desired effect, but only the parameters that are necessary. You can modify the 

existing settings including adjusting those controls that were not previously set.

5 Use the Amount slider to set the amount of the selected preset. The Amount 
mixes between the full effect of the preset and the original image.

To mimic the characteristics of a particular film stock, a combination of settings 

for the RGB channels have been set to form a film response curve.

6 Change the Film Response > RGB, R, G and B sliders. They will minimize or 
accentuate the pre-configured film response curve. 

Note: If you are using a black and white preset, the grayscale film response curve is 
adjusted using RGB.

Feel free to modify any of the Black and White, Color Correct, Filter, Sharpen, 

Diffusion, Vignette or Grain settings.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

7 Click the Done button to return to the host application.
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The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Film Stocks filter for more information.
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Flashing
Flashing allows you to use photographic filters to lower the contrast of your 

shadows or highlights. The motion picture lab can expose a small amount of 

light to the film at various stages of the developing and printing process. For 

example, Negative plus Dupe Negative flashing lifts blacks, while Print plus 

Master Positive flashing softens whites.

1 Apply Flashing from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets. When done, select the Custom Preset.

4 Adjust the Shadows > Brightness slider to brighten shadow areas.

5 Adjust the Highlights > Brightness slider to darken highlight areas.

6 To flash the Shadows or Highlights with a custom color, select Custom in the 
Presets pop-up menu and click on the Shadows or Highlights > Color box and 
select a color.

Note: The Color picker allows you to use a custom color, but is only active when the 
Custom option has been selected in the Presets pop-up menu.

7 To choose one of the preset filters, select a filter from the Shadows or Highlights 
> Presets list.

8 Once colors have been chosen, adjust the Shadows or Highlights > Brightness 
sliders to set the amount of color added to either the Shadows or Highlights.

9 Change your View to Shadows or Highlights to see the selection values. 

In some of the filters, a selection is generated to create the desired effect--in 

this case, flashing. The areas that are white in the selection are the areas that 

will be adjusted by either the Shadows or Highlights sliders. The areas defined 

as Shadows or Highlights can be adjusted by modifying the Position and Range 

parameters.

10 Use the Shadows or Highlights Position parameters if you want to select 
different values to be used for the selection.

11 Increase the Shadows or Highlights Range controls to add more values to the 
selection. Decrease for less values.
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12 Change your View to Output to see the image.

13 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Flashing filter for more information.
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FL-B/D®
Provides correct color, removing the harsh green cast caused by fluorescent 

bulbs.

1 Apply Fluorescent from the Image category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Temperature slider as needed.

5 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the FL-B/D® filter for more information.
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Flag / Dot
Flags and Dots are rectangular and circular lighting control devices used to 

create shadow areas on a motion picture or photographic set. This concept has 

been extended to digital so that areas of the image can be selectively 

darkened.

1 Apply Flag or Dot from the Light category.

2 Using the DVE controls, you can transform the flag or dot.

3 Adjust the Flag or Dot > Brightness to set the intensity.

4 Use the Flag or Dot > Blur sliders to control the softness.

See the Flag and Dot filters for more information.
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Fog
The Fog filter creates a soft, misty atmosphere over the image and glows 

highlights.

1 Apply Fog from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Fog > Brightness, Blur and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, fog.

5 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where fog will be 

introduced. The location of the fog within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

6 Change the Selection > Position parameter if you want to select different 
luminance values to be used for the selection.

7 Increase the Selection > Range value to add more fog into the scene. Decrease 
for less fog.

8 Change your View to Output to see the filtered image.

9 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Fog filter for more information.
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Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. We have created digital equivalents of the lighting gels 

and these same exact colors can be applied to the entire image or inside a 

gradient. In cooperation with Gamproducts and Rosco, we have created digital 

versions of their popular gels.

1 Apply Gels from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the gels are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new presets group from the pop-up menu to see 
a different set of gel presets.

5 Adjust the Gels > Opacity, Preserve Highlights and Exposure Compensation 
sliders to your liking.

The selected gel can be applied through a gradient creating a graduated 

transition between the colored portion and the original image.

6 Click on the Grad > Enable checkbox to activate the Grad.

7 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

8 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Gels filter for more information.
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Glimmerglass® / Bronze Glimmerglass®
Softens fine details in a unique manner, while adding a mild glow to highlights. 

Bronze Glimmerglass® adds a warming filter.

1 Apply Glimmerglass® from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 Change your View to Selection to see the selection values. 

In some of the filters, a selection is generated to create the desired effect--in 

this case, smoothing of image details.

The idea here is to generate a selection that isolates the areas of the image that 

need to be smoothed. For instance, you might be trying to isolate and smooth 

the skin on a person’s face. The white areas of the selection are the areas that 

will be smoothed. The selection has been preset to a midtone selection. This 

can be modified by using Selection > Position to select the luminance value and 

Selection > Range to select the amount of values to be used for the selection.

6 If needed, change the Selection > Position parameter so that the image areas you 
are trying to smooth are as white as possible in the selection.

7 Adjust the Selection > Range value so that the white values of the selection are 
limited as much as possible to the image areas that you are trying to isolate.

In the case of a person’s face, adjust the Selection > Position so that the face 

you are trying to smooth is as white as possible in the selection, and set the 

amount of white values in the person’s face using Position > Range.

8 Increase the Selection > Blur parameter if you want to soften the transition areas 
of the selection.

9 Change your View to Edge to see the edge values. 
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The areas that are white in the edge is where detail in the image is retained.

10 Adjust the Edge > Brightness of the edge selection to make sure that you have 
sufficient levels of white in areas where you would like to retain detail.

For a person’s face, make sure that you have sufficient levels of white edges in 

areas such as the eyes, nose and mouth.

11 Set the Edge > Blur to smooth out the edge selection.

12 Change your View to Output to see the filtered image.

13 Adjust the Horizontal and Vertical Blur to smooth out detail.

14 If the image is looking too soft, increase the Edge > Brightness, decrease the 
amount of Blur added to the scene or modify the Selection > Position and Range 
parameters.

In addition to softening fine image details, Glimmerglass® adds a mild glow to 

highlights which can be adjusted using the Mist controls.

15 Adjust the Mist > Brightness and Blur to set the amount of highlight glow.

16 If you applied a Bronze Glimmerglass® preset, adjust the Temperature > Color 
and Opacity sliders to your liking.

17 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Glimmerglass® and Bronze Glimmerglass® filters for more 

information.
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Glow
Glow creates glows around selected areas of the image based on a generated 

selection.

1 Apply Glow from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Select either the Glow > Blend > Add or Screen blend mode. 

Add will burn out highlights while the Screen Mode will retain them.

5 Adjust the Glow > Brightness, Blur and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, glow.

6 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

7 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

8 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

9 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

10 Change your View to Output to see the filtered image.

11 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Glow filter for more information.
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Glow Darks
Glows and grows the darks areas of the image

1 Apply Glow Darks from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Glow > Amount and Blur settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, glowing darks.

5 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

6 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

7 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

8 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

9 Change your View to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Glow Darks filter for more information.
x User Guide
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Grain
Grain simulates film grain with individual control of red, green, and blue grain 

size and intensity.

1 Apply Grain from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Red, Green and Blue Size parameters.

The Size parameters control the size of the grain. Sometimes a film stock’s 

grain structure varies in size from one color channel to another, so individual 

control has been given. The larger the Size settings, the larger the grain will be.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

5 Manipulate the Red, Green and Blue Amount parameters.

The Amount parameters set the red, green and blue intensities of the grain. 

Film stocks generally have varying amounts of red, green and blue intensities 

with the blue intensity generally higher than the rest. If you turn the red, green 

and blue amount sliders to a value of 0, the grain will disappear.

6 Change the Red, Green and Blue Softness parameters.

The Softness parameters set the red, green and blue softness of the grain. 

Some film stock’s grain structure varies in softness from one color channel to 

another, so individual control has been given. Normally, only minor softness 

adjustments are necessary, usually between a value of 0-1. 

7 Adjust the Response Position and Response Range to control where you will see 
grain in the image. 

In most cases, film grain is apparent over the entire image except the brightest 

whites with the black areas being the most affected. A low Response Position 

value places grain in the darkest image values, while a high Response Position 
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value places grain in the brightest areas. Response Range will increase or 

decrease the area where grain is added to the image based on the value of the 

slider.

8 If you want, use Response Minimum to set the minimum level of grain that is 
always added to the image.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Grain filter for more information.
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Halo
Halo causes dark areas to glow into bright areas and bright areas to glow into 

dark areas along with a bit of diffusion.

1 Apply Halo from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Diffusion > Blur and Opacity parameters to your liking.

The Halo effect is enhanced by using a combination of color correction controls 

in addition to the diffusion.

5 Change the Color Correct settings if necessary.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Halo filter for more information.
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Haze / Sky

Haze
Reduces excessive blue by absorbing UV light and eliminates haze which 

tends to wash out color and image clarity.

Sky
Reduces UV light, haze and is pink tinted for added warmth and better colors. 

It is especially useful for images shot in outdoor open shade and on overcast 

days.

1 Apply Haze or Sky from the Image category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Set the amount of haze to be removed from the scene using the Haze control.

5 Adjust the Temperature and Cyan/Magenta parameters to your liking. 

Note: Cyan/Magenta is only included in the Sky filter.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Haze and Sky filters for more information.
x User Guide



• 

Filter Tutorials  73 

• 
• 
• 
•
•
•

HDTV/FX®
With the increase in HD production for both TV and Motion Pictures, 

HDTV/FX® filters address both contrast and sharpness issues associated with 

HD. Creates a “film look” and provides subtle improvements in shadow detail.

1 Apply HDTV/FX® from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Change your View to Selection to see the selection values. 

In some of the filters, a selection is generated to create the desired effect--in 

this case, smoothing of image details.

The idea here is to generate a selection that isolates the areas of the image that 

need to be smoothed. For instance, you might be trying to isolate and smooth 

the skin on a person’s face. The white areas of the selection are the areas that 

will be smoothed. The selection has been preset to a midtone selection. This 

can be modified by using Selection > Position to select the luminance value and 

Selection > Range to select the amount of values to be used for the selection.

5 If needed, change the Selection > Position parameter so that the image areas you 
are trying to smooth are as white as possible in the selection.

6 Adjust the Selection > Range value so that the white values of the selection are 
limited as much as possible to the image areas that you are trying to isolate.

In the case of a person’s face, adjust the Selection > Position so that the face 

you are trying to smooth is as white as possible in the selection, and set the 

amount of white values in the person’s face using Position > Range.

7 Increase the Selection > Blur parameter if you want to soften the transition areas 
of the selection.

8 Change your View to Edge to see the edge values. 

The areas that are white in the edge is where detail in the image is retained.

9 Adjust the Edge > Brightness of the edge selection to make sure that you have 
sufficient levels of white in areas where you would like to retain detail.
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For a person’s face, make sure that you have sufficient levels of white edges in 

areas such as the eyes, nose and mouth.

10 Set the Edge > Blur to smooth out the edge selection.

11 Change your View to Output to see the filtered image.

12 Adjust the Horizontal and Vertical Blur to smooth out detail.

13 If the image is looking too soft, increase the Edge > Brightness, decrease the 
amount of Blur added to the scene or modify the Selection > Position and Range 
parameters.

In addition to reducing excessive sharpness, HDTV/FX® lowers contrast which 

can be adjusted using the Contrast > Shadows and Highlights controls.

14 Adjust the Contrast > Shadows and Highlights to your liking.

15 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the HDTV/FX® filter for more information.
x User Guide
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HFX® Star
Exciting and dazzling star effects are generated from original point or reflected 

light sources with the added glitter and sparkle of these exclusive, natural 

looking asymmetrical designs and shapes. Great for water scenes, candle 

flames, street lights and more!

1 Apply HFX® Star from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 You can also select different star types by choosing them from the Star > Type 
pop-up menu.

5 Adjust the Star > Brightness, Size and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, star effects.

6 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where stars will be 

introduced. The location of the stars within the scene can be adjusted by 

modifying the Threshold parameter.

7 Change the Threshold parameter if you want to select different values to be used 
for the selection.

8 Change your View to Stars to see the generated stars.

9 Change your View to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the HFX® Star filter for more information.
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High Contrast
Creates an extreme high contrast image.

1 Apply High Contrast from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Contrast and Amount sliders until you achieve the desired amount of 
contrast.

5 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the High Contrast filter for more information.
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Ice Halos
Ice halos are created when small ice crystals in the atmosphere generate halos 

by reflecting and refracting light. Most notably, circles form around the sun or 

moon as well as rare occurrences when the entire sky is painted with a web of 

arcing halos.

1 Apply Ice Halos from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 You can also choose different ice halos by adjusting the Halo > Sun Altitude 
slider.

5 Choose Light > Blend > Add or Screen blend mode.

Add will burn out highlights while Screen will retain them.

6 In the Light menu, adjust the Brightness as well as the Displacement and Blur of 
the ice halo if you’d like. 

7 Adjust the position of the ice halo by clicking and dragging the center image 
point to the desired location.

8 You can also use the Halo > Scale control to transform the ice halo.

9 Combine the ice halo with a selection by changing the Halo > Blend Mode from 
Halo Only to Selection.

Selection only adds the ice halo in the areas of the selection. If you are not 

seeing enough of the ice halo, your selection should be adjusted.

10 Change your View selector to Selection to see the selection values.

The default selection settings are preset to a highlight selection. The areas that 

are white in the selection are the areas where the ice halo will be added into the 

image. The location of the ice halo within the scene can be adjusted by 

changing the Selection > Position and Range parameters.

11 Change the View selector from Selection to Output.

12 Change the Selection > Position parameter if you want to change where you see 
the ice halo.
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13 Increase the Selection > Range value to add more of the ice halo to the scene. 
Decrease to see less of the ice halo.

14 Increase the Selection > Blur parameter to soften the selection.

15 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Ice Halos filter for more information.
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Infrared
Infrared simulates infrared filters used in conjunction with infrared sensitive film 

or sensors to produce very interesting black and white images with glow in 

highlight areas. 

1 Apply Infrared from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Choose the type of black and white filter to be applied to your color image from 
the Black and White pop-up menu.

The type of Black and White filter that you choose can dramatically change the 

look of your image.

5 Set the Mist > Brightness and Blur to your liking.

6 If you want, you can use the Color Correct controls to modify the Brightness, 
Contrast and Gamma of the image.

In some of the filters, a selection is generated to create the desired effect--in 

this case, diffusion.

7 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where diffusion will be 

introduced. The location of the diffusion within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

8 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

9 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

10 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

11 Change your View to Output to see the filtered image.
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12 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Infrared filter for more information.
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Kelvin
Degrees Kelvin is the standard unit of measure for color temperature which is 

a way to characterize the spectral properties of a light source. Low color 

temperature implies warmer (redder) light, while high color temperature implies 

a colder (bluer) light.

1 Apply Kelvin from the Image category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

The Color Temperature of the image is determined by the difference of the 

Destination and Source Kelvin parameters.

4 Adjust the Destination Kelvin slider.

Presets for a number of different light sources and conditions are provided in 

degrees Kelvin, the standard unit of measure for color temperature.

5 If you want less coloring of the image, turn down the Color Temperature > 
Opacity.

6 Image highlights can be retained by adjusting the Color Temperature > Preserve 
Highlights control to a value of 100.

The temperature adjustment can be applied through a gradient creating a 

graduated transition between the colored portion and the original image.

7 Click on the Grad > Enable checkbox to activate the Grad.

8 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

9 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.
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10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Kelvin filter for more information.
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Key Light
Using Key Light, an image can be relit by with either a directional or point light.

1 Apply Key Light from the Light category.

Parallel is the default light source type and creates a directional light source.

2 Adjust the Angle to change the direction of the light source.

3 Set the Strength slider for the desired light intensity.

4 Switch the Type to Point.

A point light is used where the light either emanates from or fades into a 

vanishing point depending on the state of the Invert control.

5 Move the point control in the center of the screen to change the Point light 
location.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter to move the Point light location.

6 Activate Invert and the light source will fade into a vanishing point.

7 Set the Strength slider.

See the Key Light filter for more information.
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Lens Distortion
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 

lenses. It is also useful for creating the look of a wide angle lens.

1 Apply Lens Distortion from the Lens category.

2 Start by adjusting the Distortion control to straighten out any curved lines that 
should be straight.

Note: Positive Distortion parameters correct Pin-cushioning while negative values 
correct Barrel distortion.

Depending on the lens that was used, you may need to also adjust the 

Anamorphic Squeeze and Curvature X and Y parameters.

See the Lens Distortion filter for more information.
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Light / Gobo
Light can be added to a scene where none existed before just as if you were 

adding light at the time of shooting. Realistic lighting and shadow is introduced 

using digital versions of the entire gobo libraries created by Gamproducts and 

Rosco.

1 Apply Light or Gobo from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the gobos are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new gobo group from the pop-up menu to see 
a different set of gobo presets.

5 Choose Light > Blend > Add, Screen or Subtract for the blend mode.

Add will burn out highlights while Screen will retain them. Subtract, on the other 

hand, will add shadow in place of light in the area of the gobo.

6 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

7 Adjust the position of the gobo by clicking and dragging the center image point 
to the desired location.

8 You can also use the Gobo > DVE controls to transform the gobo.

9 To apply a custom light color to the image, click on the Light > Color box and 
select a color.

Note: The Color picker allows you to treat the light with a custom color, but is only 
active when the Custom option has been selected in the Light > Gels pop-up menu.

10 To apply a colored gel to the light, select one from the Light > Gels pop-up menu.

11 Combine the gobo with a selection by changing the Gobo > Blend Mode from 
Gobo Only to Multiply.

I like the Multiply blend mode because it only adds the gobo in the areas of the 

selection.
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12 Change your View selector to Selection to see the selection values.

The default selection settings are preset to a highlight selection to create the 

light effect. If you are not seeing sufficient light, your selection should be 

adjusted. The areas that are white in the selection are the areas where light will 

be added into the image. The location of the light within the scene can be 

adjusted by changing the Selection > Position and Range parameters.

13 Change the Selection > Position parameter if you want to select different values 
to be used for the light.

14 Increase the Selection > Range value to add more light into the scene. Decrease 
for less light.

15 Increase the Selection > Blur parameter to soften the transition areas of the light.

16 Change the View selector from Selection to Output.

17 The softness of the light can also be adjusted using the Light > Blur setting.

18 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

19 To use your own image or sequence as the light source in Adobe After Effects:

• Select Input from the Gobo > Type menu. 

• Select a layer from the Gobo > Input menu. 

or

20 To use your own image or sequence as the light source in Adobe Premiere Pro:

• Select Input from the Gobo > Type menu. 

• Select a track from the Gobo > Input menu located below the Gobo > Type menu. 

or

21 To use your own image or sequence as the light source in Apple Final Cut Pro 
6&7:

• Select Input from the Gobo > Type menu.

• Drag and drop a clip onto the clip icon to the right of the Gobo > Input parameter.

Note: Using an image as a light source in Apple Final Cut Pro X is not supported 
because of limitations with it’s plug-in format.

or
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22 To use your own image or sequence as the light source in Avid Editing Systems:

• Select Input from the top most pop-up in the Gobo group. 

• Place the light source clip on a track below the clip you applied Light/Gobo to.

Note: If the camera is moving and you want to add a gobo, the gobo won’t 
automatically follow the camera. You will either need to manually move the gobo to 
follow the camera or better, use Motion Tracking software to Match Move the gobo to 
the camera move. Track the motion of your source image, set your View to Gobo, apply 
the tracker motion to your gobo and render it. To use the newly tracked and rendered 
gobo as a light source, follow the previous instructions listed for using your own image 
or sequence as the light source.

See the Light / Gobo filters for more information.
Dfx User Guide    
• 
• 
•
•
•



   Df

88 Filter Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Low Contrast
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 

bright areas bright.

1 Apply Low Contrast from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Contrast > Light Brightness and Contrast > Light Spread to control the 
brightness and distance of the light being spread into the shadow areas.

In some of the filters, a selection is generated to create the desired effect--in 

this case, low contrast.

5 Change your View to Selection to see the selection values. 

The areas that are white in the selection will be the image areas used to spread 

light into the shadow areas. The location of the low contrast within the scene 

can be adjusted by modifying the Selection > Position and Selection > Range 

parameters.

6 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

7 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

8 Change your View to Spread to see the special selection used to create the low 
contrast effect.

The Spread selection will change as the Contrast > Light Spread slider is 

adjusted.

9 Move the Contrast > Light Spread slider to see how it affects the Spread 
selection. Leave it at a value of 200 when you are done.

10 Change your View to Output to see the filtered image.

11 Adjust the Contrast > Shadow Brightness if your shadows are still too dark.
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12 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Low Contrast filter for more information.
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Match
Matches the Brightness, Color, Detail, Grain and Tone of one image and 

applies it to another.

Note: Match is not supported in Final Cut Pro X because of limitations in it’s plug-in 
format.

1 Apply the Match filter from the Image category to a target clip.

2 Select the source image to be matched using the Source selector.

• Adobe After Effects: Select the layer from the Source selector.

• Adobe Premiere Pro CS6 or later: Select the track from the Source selector located 
above the Match button.

• Apple Final Cut Pro 6&7: Drag and drop the source clip onto the filmstrip icon next 
to the Source parameter.

• Avid Editing Systems: Place the source clip on a track below the clip you applied 
the Match filter to.

3 Change the View from Output to Source.

4 Find the frame in the sequence that you would like to copy.

5 Make sure that your timeline/composition is set to high quality and the viewer is 
set to a 1:1 pixel ratio. Otherwise, the grain in the viewer won’t accurately match 
the rendered result.

6 Click the Match box.

The Color, Detail, Grain and Tone of the source image are analyzed and 

applied to your target image.

7 Switch the View from Source to Output.

8 Adjust the Brightness, Color, Detail, Grain and Tone parameters to your liking.

Note: The Brightness and Detail parameters behave differently depending on the 
source image. For instance, the Brightness slider can either brighten or darken while 
the Detail slider can either sharpen or soften. They are dual use controls.

See the Match filter for more information.
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Mono Tint
Mono Tint converts color images to black and white while applying a color tint.

1 Apply Mono Tint from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 In the Black and White > Filter pop-up menu, select a filter to convert your image 
to Black and White.

5 Adjust the Tint > Color, Opacity and Preserve Highlights sliders to your liking.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Mono Tint filter for more information.
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ND-Grad
The ND or Neutral Density Grad darkens only a portion of the image using a 

graduated transition between the darkened portion and the original image. It 

selectively adjusts brightness without affecting color balance. The most likely 

use for the ND-Grad would be to balance the difference between the sky and 

the ground.

1 Apply ND-Grad from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Exposure slider to vary the amount of neutral density being applied 
to the image.

5 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

6 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

7 If you want less darkening of the image in the area of the Grad, adjust F-Stop > 
Exposure.

8 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the ND-Grad filter for more information.
x User Guide



• 

Filter Tutorials  93 

• 
• 
• 
•
•
•

Night Vision
Night Vision creates the effect of a Night Vision lens by tinting the image green, 

blooming highlights and adding grain.

1 Apply Night Vision from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Choose the type of black and white filter to be applied to your color image from 
the Black and White pop-up menu.

The type of Black and White filter that you choose can dramatically change the 

look of your image.

5 Adjust the Glow > Brightness and Blur as well as the Grain > Size and Amount 
settings to your liking.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

6 If you want, you can use the Color Correct controls to modify the color of the 
image.

In some of the filters, a selection is generated to create the desired effect--in 

this case, glow.

7 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

8 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

9 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

10 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

11 Change your View to Output to see the filtered image.
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12 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Night Vision filter for more information.
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Nude/FX®
A series of different skin tone enhancing filters that offer ultimate flexibility and 

control for skintones. Perfect for headshots and close-ups.

1 Apply Nude/FX® from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Color > Opacity, Preserve Highlights and Exposure Compensation 
sliders to your liking.

The selected color can be applied through a gradient creating a graduated 

transition between the colored portion and the original image.

5 Click on the Grad > Enable checkbox to activate the Grad.

6 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Nude/FX® filter for more information.
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Old Photo
Images are treated to look like a variety of historical photographic processes 

including Cyanotype, Kallitype, Light Cyan, Palladium, Platinum, Sepia, Silver, 

Silver Gelatin and Van Dyck.

1 Apply Old Photo from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 From the Filter > Filter pop-up menu, select the type of black and white filter to 
be applied to your color image.

The look of the image will significantly change based on the type of black and 

white filter used.

5 Adjust the Tint > Color and Opacity sliders to your liking.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Old Photo filter for more information.
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Overexpose
Overexpose simulates the overexposure that occurs when a film camera is 

stopped.

1 Apply Overexpose from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust both the Amount and Blur controls to achieve the desired effect.

5 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Overexpose filter for more information.
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Ozone
The Ozone filter allows you to manipulate the color of an image with incredible 

flexibility and accuracy. The spectrum of image values is divided into 11 

discrete zones using proprietary image slicing algorithms. When using 

Luminance as the method for slicing up the image, the Position and Range 

sliders are preset so that each zone is twice as bright as the previous zone, 

proceeding from black towards white. The color values of each zone can then 

be independently adjusted until you’ve painted a new picture. Your adjustments 

occur on a zone by zone basis, but you view the result of all color corrections 

simultaneously.

1 Apply Ozone from the Image category.

2 Use the View menu to look at Zones 0-10.

The selected zone is represented as a black and white image. The values 

shown as white in the selected zone are the portions of the image that will be 

modified when using the color adjustments. As the values drop-off to black, so 

does the strength of whatever adjustments you’ll make. Although the zone’s 

Position and Range parameters are preset according to the Digital Zone 

system, they can be changed if you want.

3 If you’d like, change the Position and Range parameters for the selected zone.

The Position value pinpoints the color values to be used in the selected zone. 

For instance, if the zones are created using Luminance, a high Position value 

shows the brightest image values as white values in the zone. A low Position 

value shows the darkest image values as white values in the zone. The Range 

value increases or decreases the range of values in the selected zone.

4 Make sure that the View is set to Output.

The Viewer now shows the full color image.

5 To modify your image, adjust any combination of the Hue, Saturation, 
Brightness, Contrast, Gamma, Red, Green, Blue and Temperature sliders for 
each zone.

Your adjustments occur on a zone by zone basis, but you view the result of all 

color corrections simultaneously.

See the Ozone filter for more information.
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Pencil
Pencil converts your image to a pencil sketch.

1 Apply Pencil from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Vary your result by adjusting both the Amount and Color controls.

5 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Pencil filter for more information.
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Photographic
The most complete line of Kodak® filters for photographic uses is available in 

the form of gelatin films and are known as Wratten® Gelatin Filters. Our 

Photographic filter is a digital equivalent of the Wratten set and were created 

using the spectral transmission curves for each optical filter. The Color 

Conversion, Light Balancing and Color Compensating preset groups are 

subsets of the Photographic filters.

1 Apply Photographic from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 If you want less coloring of the image, turn down the Filters > Opacity.

6 Image highlights can be retained by adjusting the Filters > Preserve Highlights 
control to a value of 100.

The selected filter can be applied through a gradient creating a graduated 

transition between the colored portion and the original image.

7 Click on the Grad > Enable checkbox to activate the Grad.

8 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

9 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.
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10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Photographic filter for more information.
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Polarizer
The Polarizer creates a darkened, deep blue sky. Through the use of a 

selection and a gradient, the color of the sky can be adjusted. Warm Polarizer 

adds a warming filter.

1 Apply Polarizer or Warm Polarizer from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 Change your View to Selection to see the selection values. 

In some of the filters, a selection is generated to create the desired effect--in 

this case, polarization.

6 Change the Selection > Hue parameter if you want to select different blue values 
to be used for the sky selection.

A selection is generated based on the blue values in the sky. Skies vary in their 

color of blue, so you can adjust the selection to accommodate your sky. The 

blue that is used to create the selection can be modified by using Selection > 

Hue to select the exact blue value and Selection > Range to select the amount 

of blue values to be used for the selection.

7 Increase the Selection > Range control to add more values to the sky selection. 
Decrease for less values.

8 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

Remember, the areas that are white in the selection are the areas that will be 

polarized.

9 Change your View to Output to see the filtered image.
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10 Adjust the Sky color settings to make the sky look polarized--usually Brightness 
and Saturation.

11 If the polarization is affecting areas other than they sky, enable the Grad and 
adjust it to limit the areas of polarization.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

12 If you applied Warm Polarizer, adjust the Warming > Color and Opacity sliders to 
your liking.

13 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Polarizer filter for more information.
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Pro-Mist®
This popular motion picture effect creates a special atmosphere by softening 

excess sharpness and contrast. It generates a pearlescent halo around 

highlights. Black Pro-Mist® offers all the benefits of the Pro-Mist® filter in a 

more subtle form. Highlight flares are controlled and contrast is lowered for a 

more delicate effect. The Warm Pro-Mist’s® add a warming filter.

1 Apply Pro-Mist® from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 Adjust the Mist > Brightness, Blur and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, diffusion.

6 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where diffusion will be 

introduced. The location of the diffusion within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

7 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

8 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

9 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

10 Change your View to Output to see the filtered image.

11 If you applied one of the Warm Pro-Mist® presets, adjust the Temperature > Color 
and Opacity sliders to your liking
x User Guide



• 

Filter Tutorials  105 

• 
• 
• 
•
•
•

12 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Pro-Mist filters for more information.
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Rack Focus
Rack Focus replicates a true camera defocus by introducing lens Bokeh 

effects. Bokeh is the Japanese term that describes the quality of out-of-focus 

points of light. In defocused areas, each point of light becomes a shape--either 

a circle or a polygon. The shape grows in size as the amount of defocusing is 

increased.

1 Apply Rack Focus from the Lens category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Blur to your liking.

5 Set the Aperture > Brightness and Color settings.

6 Change the Aperture > Facets to control the polygon’s shape and use Angle to 
rotate the Bokeh.

7 Set the Aperture > Curvature to 100 if you prefer the Bokeh to be circular in 
shape.

In some of the filters, a selection is generated to create the desired effect--in 

this case, Bokeh effects.

8 Set your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where Bokeh will be 

introduced. The location of the Bokeh within the scene can be adjusted by 

modifying the Threshold parameter.

9 Change the Threshold parameter if you want to select different values to be used 
for the selection.

10 Set your View to Aperture to see the generated Bokeh.

11 Change your View back to Output to see the filtered image.

12 Click the Done button to return to the host application.
x User Guide



• 

Filter Tutorials  107 

• 
• 
• 
•
•
•

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Rack Focus filter for more information.
Dfx User Guide    
• 
• 
•
•
•



   Df

108 Filter Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Radial Exposure
Lightens and/or darkens the center or edges of an image to correct lens 

vignetting.

1 Apply Radial Exposure from the Lens category.

2 Adjust the Exposure > Edges or Center parameters.

The radial gradient used to lighten or darken the edges or center of the image 

can be adjusted to suit your image.

3 Adjust the Spot > Position, Radius, Falloff Radius and Falloff.

4 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

See the Radial Exposure filter for more information.
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Rainbow
Recreates arced rainbows of spectral colors, usually identified as red, orange, 

yellow, green, blue, indigo, and violet, that appear in the sky as a result of the 

refractive dispersion of sunlight in drops of rain or mist.

1 Apply Rainbow from the Light category.

2 Choose Light > Blend > Add, Screen or Normal blend mode.

Add will burn out highlights while Screen will retain them. Normal uses a normal 

composite function to add the rainbow.

3 In the Light menu, adjust the Brightness, and if you’d like, set the Displacement 
and Blur of the rainbow.

4 Set the base of the rainbow using Crop > Offset, Angle and Softness.

5 Use the Rainbow > Position control to move the rainbow.

6 Set the Rainbow > Radius, Aspect, Thickness and Softness as desired.

7 Combine the rainbow with a selection by changing the Rainbow > Blend Mode 
from Rainbow Only to Selection.

Selection only adds the rainbow in the areas of the selection. If you are not 

seeing enough of the rainbow, your selection should be adjusted.

8 Change your View selector to Selection to see the selection values.

The default selection settings are preset to a highlight selection. The areas that 

are white in the selection are the areas where the rainbow will be added into 

the image. The location of the rainbow within the scene can be adjusted by 

changing the Selection > Position and Range parameters.

9 Change the View selector from Selection to Output.

10 Change the Selection > Position parameter if you want to change where you see 
the rainbow.

11 Increase the Selection > Range value to add more of the rainbow to the scene. 
Decrease to see less of the rainbow.

12 Increase the Selection > Blur parameter to soften the selection.

See the Rainbow filter for more information.
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Rays
Create stunning and realistic light ray effects quickly and easily.

1 Apply Rays from the Light category.

2 Move the point control in the center of the screen to change the source point 
from which the rays will emanate.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter to move the Rays source location.

3 Adjust the Rays > Length, Color > Brightness and Color as desired.

4 To limit the amount of rays, increase the Rays > Threshold parameter.

Threshold controls the amount of rays based on a brightness threshold. Fewer 

rays with more definition are generated at higher threshold values.

5 Use the Shimmer > Amount and Phase to randomize the rays.

6 To create a shimmering effect with the rays, increase the Shimmer > Amount.

See the Rays filters for more information.
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ReLight
Light can be added to a scene where none existed before. A complete set of 

light source controls allow you to adjust the light just as you would at the time 

of shooting.

1 Apply the ReLight filter located in the Light category.

2 Using the Light Source > DVE controls, you can move the shape around.

3 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

4 To apply a custom light color to the image, click on the Light > Color box and 
select a color.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

5 To choose one of the GamColor gels, select a gel from the Light > GamColor 
Presets list.

6 Combine the light source with a selection by changing the Light Source > Blend 
Mode from Shape Only to Multiply.

I like the Multiply blend mode because it only adds the light source in the areas 

of the selection.

7 Change your View selector to Selection to see the selection values. 

The default Selection settings are preset to a highlight selection to create the 

light effect. If you are not seeing sufficient light, your selection should be 

adjusted. The areas that are white in the selection are the areas where light will 

be added into the image. The location of the light within the scene can be 

adjusted by changing the Selection > Position and Range parameters.

8 Change the Selection > Position parameter if you want to select different values 
to be used for the light.

9 Increase the Selection > Range value to add more light into the scene. Decrease 
for less light.

10 Change the View selector from Selection to Output.

11 Increase the Selection > Blur parameter to soften the transition areas of the 
selection. 

See the ReLight filter for more information.
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Reflector
Gold and Silver Reflector allow you to add white or gold light into shadow areas.

1 Apply Reflector from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 Adjust the Brightness and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, light reflecting into the shadow areas.

6 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where light will be 

introduced. The location of the light within the scene can be adjusted by 

modifying the Position and Range parameters.

7 Change the Position parameter if you want to select different values to be used 
for the selection.

8 Increase the Range controls to add more values to the selection. Decrease for 
less values.

9 Change your View to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Reflector filters for more information.
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Selective Color Correct
Colors can be selectively isolated through the use of a selection and adjusted 

using hue, saturation, brightness, gamma, contrast, red, green, and blue 

controls.

1 Apply Selective Color Correct from the Image category.

2 Change your View to Selection to see the selection values. 

In some of the filters, a selection is generated to create the desired effect--in 

this case, selective color correction.

3 Adjust the selection controls so that the areas that you want to color correct are 
white in the selection.

Go to the Selection parameters to see how they work.

4 Change your View to Output to see the image.

5 Adjust the color correct parameters to your liking.

See the Selective Color Correct filter for more information.
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Selective Saturation
The saturation of the image can be adjusted independently in the shadows, 

midtones and highlights.

1 Apply Selective Saturation from the Image category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Saturation in the Shadows, Midtones or Highlights.

In some of the filters, a selection is generated to create the desired effect--in 

this case, selective saturation. Shadow, midtone and highlight selections have 

been preset for you to adjust the saturation selectively in those areas.

5 Change your View to Shadows, Midtones or Highlights to see the selection 
values. 

The areas that are white in the selection are the areas that will be adjusted by 

the Saturation sliders. The areas defined as shadows, midtones or highlights 

can be adjusted by modifying the Position and Range parameters.

6 Use the Shadows, Midtones or Highlights Position parameters if you want to 
select different values to be used for the selection.

7 Increase the Shadows, Midtones or Highlights Range controls to add more 
values to the selection. Decrease for less values.

8 Change your View to Output to see the image.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Selective Saturation filter for more information.
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Sepia / 812® Warming
Sepia creates a warm brown tone for that nostalgic feeling while the 812® 

Warming filter, a Tiffen exclusive, improves skintones and is ideal for portraits 

taken on a cloudy day or in outdoor shade on a sunny day.

1 Apply Sepia or 812® Warming from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Color > Amount, Opacity, Preserve Highlights and Exposure 
Compensation sliders to your liking.

The Sepia or 812® Warming color can be applied through a gradient creating 

a graduated transition between the colored portion and the original image.

5 Click on the Grad > Enable checkbox to activate the Grad.

6 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Sepia and 812® Warming filters for more information.
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Smoque®
Mechanical smoke generators are often used to enhance realism where smoke 

is normally encountered. This can be difficult, costly and less desirable to work 

in a smoke-filled environment. The Smoque® filter creates the look of smoke 

without the cost and hassle of smoke generators.

1 Apply Smoque® from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Smoke > Brightness, Blur and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, smoke.

5 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where smoke will be 

introduced. The location of the smoke within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

6 Change the Selection > Position parameter if you want to select different 
luminance values to be used for the selection.

7 Increase the Selection > Range value to add more smoke into the scene. 
Decrease for less smoke.

8 Change your View to Output to see the filtered image.

9 Increase the Selection > Blur parameter to soften the transition areas of the 
selection.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Smoque® filter for more information.
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Soft Contrast
Soft Contrast diminishes highlights while retaining the darker look of the 

shadows.

1 Apply Soft Contrast from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

In some of the filters, a selection is generated to create the desired effect--in 

this case, lowering highlight contrast. 

4 Change your View to Highlights to see the selection values. 

The areas that are white in the selection are the areas that will be adjusted 

using the Highlights slider. The areas defined as highlights can be adjusted by 

modifying the Position and Range parameters.

5 Use the Position parameter if you want to select different values to be used for 
the selection.

6 Increase the Range control to add more values to the selection. Decrease for less 
values.

7 Change your View to Output to see the image.

8 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Soft Contrast filter for more information.
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Soft/FX® / Warm Soft/FX®
Softens and minimizes facial imperfections while retaining overall image clarity. 

Warm Soft/FX® Effects adds a warming filter.

1 Apply Soft/FX® from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

At the top left of the Presets window, the filters are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 Adjust the Blur and Opacity parameters to your liking.

6 If using a Warm Soft/FX® preset, adjust the Temperature > Color, Opacity, 
Preserve Highlights and Exposure Compensation sliders to your liking.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Soft/FX® / Warm Soft/FX® filters for more information.
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Soft Light
Provides soft, digitally diffused and virtually shadowless light.

1 Apply Soft Light from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Select either the Blend > Add or Screen Blend Mode. 

Add will burn out highlights while the Screen Mode will retain them.

5 Adjust the Brightness to set the intensity of the light. 

6 Use the Blur sliders to control the softness of the light.

7 To apply a custom light color to the image, click on the Color box and select a 
color.

Note: The Color picker allows you to treat the light with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

8 To apply a colored gel to the light, select one from the Gamcolor Presets pop-up 
menu.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Soft Light filter for more information.
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Split Field
Split Field splits the image with a line that can be positioned, rotated and 

blurred. On one side of the line, the image is blurred and on the other, it is in 

focus.

1 Apply Split Field from the Lens category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Blur controls.

5 Position, Rotate and Blur the split line using the Split controls.

6 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Split Field filter for more information.
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Split Tone
Shadows, midtones and highlights can be individually tinted with the Split tone 

filter.

1 Apply Split Tone from the HFX Grads/Tints category.

2 Turn up the Opacity slider in the Shadows, Midtones or Highlights.

3 Change the Tint colors by clicking on the Tint color boxes.

In some of the filters, a selection is generated to create the desired effect--in 

this case, split toning.

4 Change your View to Shadows, Midtones or Highlights to see the selection 
values. 

The areas that are white in the selection are the areas that will be tinted by the 

selected tint color. The areas defined as Shadows, Midtones or Highlights can 

be adjusted by modifying the Position and Range parameters.

5 Adjust the Shadows, Midtones or Highlights > Position and Range controls to 
change what is considered to be Shadows, Midtones or Highlights.

6 Change your View to Output to see the image.

See the Split Tone filter for more information.
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Star
Six point star patterns are generated on highlights in the image. 

1 Apply Star from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Star > Brightness, Size and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, a star filter.

5 Change your View to Selection to see the selection values.

The selection has been preset to a highlight selection to generate the stars. 

Different luminance values can be selected with the Selection > Position 

parameter and the range of selection values can be adjusted using Selection > 

Range.

6 Change the Selection > Position parameter if you want to select different 
luminance values to be used for the selection.

Stars will be generated wherever there are white values in the selection.

7 Change your View to Stars to see the generated stars.

8 Increase the Selection > Range value to add more stars into the scene. Decrease 
for less stars.

9 Change your View to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Star filter for more information.
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Streaks
The Streaks filter creates horizontal or vertical streaks around highlights in the 

image.

1 Apply Streaks from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust either the Vertical or Horizontal Streaks controls.

Note: If you adjust both the Vertical and Horizontal Streak controls at the same time, 
the Streak effect will be lost.

5 Select either the Add or Screen Blend Mode. Add will burn out highlights while 
the Screen Mode will retain them.

6 Adjust the Streak > Brightness and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, streaks.

7 Change your View to Selection to see the selection values.

The areas that are white in the selection are the areas where streaks will be 

introduced. The location of the streaks within the scene can be adjusted by 

modifying the Selection > Position and Selection > Range parameters.

8 Change the Selection > Position parameter if you want to select different values 
to be used for the selection.

9 Increase the Selection > Range control to add more values to the selection. 
Decrease for less values.

10 Change your View to Output to see the filtered image.

11 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Streaks filter for more information.
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Strip Grad
Strip Grad colors only a portion of the image in the form of a narrow strip using 

Color-Grad® filters.

1 Apply Strip Grad from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

The white area of the Grad will be tinted.

6 If you want less coloring of the image, turn down the Filters > Opacity.

7 Image highlights can be retained by adjusting the Filters > Preserve Highlights 
control to a value of 100.

8 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Strip Grad filter for more information.
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Sunset/Twilight
Sunset/Twilight applies three photographic filters to the image which are 

blended together with a gradient.

1 Apply Sunset/Twilight from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 To apply a custom color to the image, select Custom from the Color 1, 2 or 3 > 
Presets pop-up menu and click on the Color 1, 2 or 3 > Color box and select a 
color.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu as well 
as the Color 1, 2 or 3 > Presets pop-up menu.

6 If you want less coloring of the image, turn down Color 1, Color 2 or Color 3 > 
Opacity.

7 Image highlights can be retained by adjusting the Preserve Highlights control to 
a value of 100.

8 Change your View to Grad to see the color gradient being applied to the image.

9 Change your View back to Output to see the filtered image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Sunset/Twilight filter for more information.
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Texture
Applies textures to an image for a stylized look.

1 Apply Texture from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Amount slider to control how much texture is applied to the image.

5 Increase the Complexity to generate a more detailed, repetitive texture.

6 Use Randomize to change the look of the texture.

7 Adjust the position of the texture by clicking and dragging the center image point 
to the desired location.

8 You can also use the DVE controls to transform the texture.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Texture filter for more information.
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Three Strip / Two Strip

Three Strip
Known and celebrated for it ultra-realistic, saturated levels of color, the 

Technicolor® Three Strip process was commonly used for musicals, costume 

pictures and animated films. It was created by photographing three black and 

white strips of film each passing through red, green and blue filters on the 

camera lens and then recombining them in the printing process. Our Three 

Strip filter was created under the direction of Academy Award Winning Visual 

Effects Supervisor Rob Legato.

Two Strip
The Technicolor® Two Strip process was the first stab at producing color 

motion pictures and consisted of simultaneously photographing two black and 

white images using red and green filters. This look creates an odd but pleasing 

hand-painted look where faces appear normal and green takes on a blue-green 

quality, while the sky and all things blue appear cyan. Our Two Strip filter was 

created under the direction of Academy Award Winning Visual Effects 

Supervisor Rob Legato.

1 Apply Three Strip or Two Strip from the Film Lab category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Change your View to Red, Green or Blue to see the selection values.

In some of the filters, a selection is generated to create the desired effect--in 

this case, modifying the intensity of the red, green and blue values.

Normally, the areas that are white in the selection are the areas that will be 

adjusted by a particular filter or control. The Red, Green and Blue Intensities, 

on the other hand, make adjustments where you see black in the selection.
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5 Adjust the Intensity of whatever color channel you are viewing and you will see 
that certain values become darker. These are the values that will be intensified in 
the color image.

6 Change your View to Output to see the color image.

7 Adjust the Red, Green and Blue Intensities until you have the desired levels of 
red, green and blue in the image. 

Note: When using the Two Strip filter, adjusting the Blue Intensity will darken image 
areas that were blue in the source image.

8 You may need to use the Red, Green and Blue Smooth controls to smooth out 
any noise that may have appeared if the intensities were turned up to high 
values. 

The Smooth controls are set to a low value by default.

9 Set the Opacity to a lower level if the strength of the effect looks too strong.

Color Correct controls are also provided for additional control.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Three Strip / Two Strip filters for more information.
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Tint
Tints the entire image with a selected color.

1 Apply Tint from the HFX Grads/Tints category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 To apply a different color to the image, click on the Tint > Color box and select a 
new color.

5 If you want less tinting of the image, turn down the Tint > Opacity.

You can also use a gradient in combination with the Tint.

6 To use a gradient with the Tint, click on Grad > Enable.

7 Adjust the Grad > Direction, Corner Points and Size.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

8 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Tint filter for more information.
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Ultra Contrast
Tiffen was recognized with a Technical Achievement Award from the Academy 

of Motion Picture Arts and Sciences for the Ultra Contrast optical filter which 

redistributes ambient light to capture details that would be lost in shadows. 

Contrast is lowered evenly throughout the image with no flare or halation.

1 Apply Ultra Contrast from the HFX Diffusion category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Shadows > Shadows slider to brighten shadow areas.

5 Adjust the Highlights > Highlights slider to darken highlight areas.

In some of the filters, a selection is generated to create the desired effect--in 

this case, lowering contrast. 

6 Change your View to Shadows or Highlights to see the selection values. 

The areas that are white in the selection are the areas that will be adjusted by 

either the Shadows or Highlights sliders. The areas defined as Shadows or 

Highlights can be adjusted by modifying the Position and Range parameters.

7 Use the Shadows or Highlights > Position parameters if you want to select 
different values to be used for the selection.

8 Increase the Shadows or Highlights > Range controls to add more values to the 
selection. Decrease for less values.

9 Change your View to Output to see the image.

10 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Ultra Contrast filter for more information.
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Vari-Star
Variable multi-point star patterns are generated on highlights in the image.

1 Apply Vari-Star from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Star > Brightness, Spokes, Size and Color settings to your liking.

In some of the filters, a selection is generated to create the desired effect--in 

this case, star effects.

5 Change your View to Selection to see the selection values. 

The areas that are white in the selection are the areas where stars will be 

introduced. The location of the stars within the scene can be adjusted by 

modifying the Threshold parameter.

6 Change the Threshold parameter if you want to select different values to be used 
for the selection.

7 Change your View to Stars to see the generated stars.

8 Change your View to Output to see the filtered image.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Vari-Star filter for more information.
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Vignette
A vignette, or soft fade, is a popular photographic effect where the photo 

gradually fades into the background, usually in a circular or rectangular shape. 

The vignette can be any color as well as thrown out of focus.

1 Apply Vignette from the Lens category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Adjust the Shape > Roundness to make the vignette either circular or rectangular 
and use Shape > Softness to control the softness of the vignette’s edge.

5 To give the vignette’s edge a random shape, use the Distortion, Distortion Size 
and Randomize controls.

6 Set the Vignette > Color and Opacity.

The vignette can be either colored or defocused or a combination of the two.

7 Turn down the Vignette > Opacity if you would like to see only a blurred vignette.

8 Turn up the Vignette > Horizontal and Vertical Blur to your liking.

9 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Vignette filter for more information.
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Water Droplets
Simulates the circular, rainbow colored optical effects produced by tiny water 

droplets in clouds, mist and fog.

1 Apply Water Droplets from the Light category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 Choose Light > Blend > Add or Screen blend mode.

Add will burn out highlights while Screen will retain them.

5 In the Light menu, adjust the Brightness as well as the Displacement and Blur of 
the rainbow if you’d like. 

6 Adjust the position of the rainbow by clicking and dragging the center image 
point to the desired location.

7 You can also use the Rainbow > Scale control to transform the rainbow.

8 Combine the rainbow with a selection by changing the Rainbow > Blend Mode 
from Rainbow Only to Selection.

Selection only adds the rainbow in the areas of the selection. If you are not 

seeing enough of the rainbow, your selection should be adjusted.

9 Change your View selector to Selection to see the selection values.

The default selection settings are preset to a highlight selection. The areas that 

are white in the selection are the areas where the rainbow will be added into 

the image. The location of the rainbow within the scene can be adjusted by 

changing the Selection > Position and Range parameters.

10 Change the View selector from Selection to Output.

11 Change the Selection > Position parameter if you want to change where you see 
the rainbow.

12 Increase the Selection > Range value to add more of the rainbow to the scene. 
Decrease to see less of the rainbow.

13 Increase the Selection > Blur parameter to soften the selection.
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14 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the Water Droplets filter for more information.
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Wide Angle Lens
Simulates the effect of a wide angle lens.

1 Apply Wide Angle Lens from the Lens category.

2 Start by adjusting the Distortion control to add the desired wide angle look.

You may need to also adjust the X and Y Correction parameters which 

compensate for the deformation introduced with the Distortion parameter.

See the Wide Angle Lens filter for more information.
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X-Ray
Simulates the look of X-Ray images.

1 Apply X-Ray from the Special Effects category.

2 Open the Dfx Interface:

• After Effects/Avid/Final Cut Pro: Click the Dfx Interface button.

• Premiere Pro: Click on the Setup icon located to the right of the filter name.

The Dfx user interface opens and consists of Presets, Parameters and Viewer 

windows.

3 Try out some of the presets.

4 From the Black and White > Filter pop-up menu, select the type of black and 
white filter to be applied to your color image.

Your choice of filter can dramatically change the black and white result.

5 Use the Brightness, Contrast and Gamma controls to further adjust the image.

6 Adjust the Color if you would like to tint the image to something other than blue.

7 Click the Done button to return to the host application.

The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

See the X-Ray filter for more information.
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 DFX USER GUIDE

Dfx is comprised of 3 main components: Viewer, Presets and Parameters and 

can be opened by selecting the Dfx Interface button.

Viewer

Parameters

Presets
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Viewer
The Viewer is where images are viewed, edited and manipulated.
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Presets and Parameters

Presets
The Presets window allows you to select from existing filter presets.
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Parameters
The Parameters window displays the current filter’s parameters. Adjusting the 

parameters will update and change the image in the Viewer.
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Variations
The Variations window allows you to create your own filter variations and 

becomes visible when a parameter name is selected in the Parameters 

window.
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Histogram
A histogram is a specialized graph that plots the number of pixels at each color 

intensity level. It is very useful in seeing how an image’s pixels are distributed.

Toolbar
The Toolbar contains Done and Cancel buttons.
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Sashes
By clicking and dragging the sashes, dividing lines between areas of the 

screen, you can customize the Dfx interface.

Tool Tips
Hovering the cursor over an icon will pop up a tool tip that displays its function.
Dfx User Guide    
• 
• 
•
•
•



   Df

144 Dfx User Guide

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Value Field Length
You can resize the Value field by clicking and dragging the dividing line between 

Parameter and Value at the top of the Parameters window. This is useful if the 

Parameter names are getting cut off.

Parameter Groups
Parameter groups in the Parameters window can be expanded and collapsed 

using the plus and minus icons located to the left of the group.

Slider Precision
You can adjust any slider with finer precision by pressing Ctrl(Win)/Cmd(Mac) 

while dragging the slider.
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Setups
A Setup takes a snapshot of the filter’s parameters. Setups can be saved and 

loaded and are independent of the image they were originally applied to. If you 

are loading a Setup containing multiple filters that was saved from the 

standalone or photo plug-in versions, only the filter that you are currently 

working with is modified by the settings contained in the Setup. 

Open Setup
Opens a previously saved Setup.

Save Setup
Takes a snapshot of the filter’s parameters and saves it as a Setup file. This 

Setup file can later be loaded to the same or a different image.

Preferences
Preferences allow you to customize default settings.

Language

Normal
The language displayed in Dfx is set according to your operating system.

English
Forces the language to English.

French
Forces the language to French.

German
Forces the language to German.

Japanese
Forces the language to Japanese.

Spanish
Forces the language to Spanish.

Note: A restart is required after changing the Language preference for the selected 
language to be displayed.
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Thumbnail Size
You can select whether the Dfx interface uses either a small or large thumbnail 

size. Medium thumbnails are the default.

Small
Small thumbnails are used in the Dfx interface.

Medium
Medium thumbnails are used in the Dfx interface.

Large
Large thumbnails are used in the Dfx interface.

Preview Size
Dfx works at a maximum resolution as defined by the Preview Size--the default 

being 1024 by 1024 pixels. Never fear, when your image is saved, Dfx always 

processes at the resolution of the original image.

1024
Dfx works at a maximum resolution of 1024 x 1024 pixels.

2048
Dfx works at a maximum resolution of 2048 x 2048 pixels.

Preview Scaling

Point
Uses a lower quality scaling method when displaying the image in the Viewer. 

Point is more accurate when applying filters such as grain and sharpen, but 

when zooming in, the image will display “chunky” artifacts.

Bicubic
Uses a smooth scaling method when displaying the image in the Viewer. 

Bicubic can mask the effect of grain and sharpen filters because of its inherent 

smoothing, but doesn’t suffer from the Point methods chunkiness when 

zooming in.
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Edit

Undo/Redo
Undo or redo operations. 

Undo/Redo History
Undo/Redo has a history, so you can jump to any item in the history by picking 

it from the menu.

Histogram
Opens or closes the Histogram window. See Histogram for more information.

Parameters
Opens or closes the Parameters window. See Parameters for more 

information.

Presets
Opens or closes the Presets window. See Presets for more information.

Variations
Opens or closes the Variations window. See Variations for more information.

Reset
Resets the window layout the next time Dfx is started. This is useful if you have 

tweaked your windows beyond recognition.

Zoom In
Zooms the image in.

Zoom Out
Zooms the image out.

Fit Image to Window
Fits the image to the window.

Layouts
There are 4 preset layouts that automatically arrange the interface windows 

into different configurations.
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Default Layout
The interface is configured with the default Dfx layout where all windows are 

shown.

Edit Layout
The Edit Layout shows the Viewer, Presets and Parameters windows.

View Layout
The View Layout shows only the Viewer.

Dual Monitor Layout
The Dual Monitor Layout shows the Viewer on the left monitor and all other 

windows on the right monitor.

Layout Shortcuts

Help

User Guide
Opens the Dfx User Guide.

Shortcut Action

F2 Selects the Default Layout

F3 Selects the Edit Layout

F4 Selects the View Layout

F5 Selects the Dual Monitor Layout
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Help Shortcuts

About
Shows the Dfx version.

Shortcut Action

F1 Opens the Dfx User Guide
Dfx User Guide    
• 
• 
•
•
•



   Df

150 Viewer

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 VIEWER

The Viewer is where images are viewed, edited and manipulated.

Zoom and Pan

Zoom In
Zooms the image in.

Zoom Level
Displays the zoom level as a percentage. 
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Zoom Out
Zooms the image out.

Zoom to Fit
Fits the entire image inside the Viewer.

Zoom
Select the Zoom Region icon and drag select a square region in the Viewer to 

zoom in on that area.

Pan
Pans the image left, right, up and down.

See the Viewer Keyboard Shortcuts for more zooming and panning options.

Compare
Compares images using Side-by-Side, Vertical Split, Horizontal Split or A/B 

comparison modes. By default, the current filter and original image are selected 

for comparison. Choose one of the comparison modes using the icons above 

the Viewer.
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Side-by-Side Comparison
Compares images side by side in the Viewer.
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Vertical Split Comparison
Compares images using a vertical split. Move your cursor into the image area 

over the split line and when the cursor changes to a double-arrow, click and 

drag to move the split. Depending on the filter used, the split line may not be 

obvious, so triangular sashes on the outside of the image help you find it. If you 

drag the sash all the way around, it will swap directions.
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Horizontal Split Comparison
Compares images using a horizontal split. Move your cursor into the image 

area over the split line and when the cursor changes to a double-arrow, click 

and drag to move the split. Depending on the filter used, the split line may not 

be obvious, so triangular sashes on the outside of the image help you find it. If 

you drag the sash all the way around, it will swap directions.

A/B Comparison
Click the A/B Comparison icon to cycle though the images.
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Histogram
A histogram is a specialized graph that plots the number of pixels at each color 

intensity level. It is very useful in seeing how an image’s pixels are distributed.

Viewer Keyboard Shortcuts

Shortcut Action

Middle-mouse drag Pans the image

Space Bar-drag Pans the image

I Key Zooms the image in

O Key Zooms the image out

Zoom icon-Drag a square Zooms into the defined area

Scroll wheel over image Zooms the image in and out

Middle-mouse double click Fits the image to the window

F Fits the image to the window

H Opens the Histogram window
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 PRESETS AND PARAMETERS

The Dfx interface can be opened to select presets and adjust parameters by:

• After Effects/Avid/Final Cut Pro: Clicking the Dfx Interface button.

• Premiere Pro: Clicking on the Setup icon located to the right of the filter name.

Presets
The Presets window allows you to select from a set of pre-defined presets. 

Presets for most filters have been created so that you can easily click through 

the various choices.
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Most filters contain multiple preset groups which are selectable at the top of the 

window.

Clicking once on a preset modifies the image in the Viewer. As you click on 

different presets, the image in the Viewer will update. This allows you to quickly 

try out several different presets.

Preset Searching
Presets can be searched for by entering text in the search field located at the 

top of the Presets window. The pattern remains in effect when you switch filters, 

but it will clear automatically when you switch layers in the Effect window or 

apply a preset. Clear the search text to return the Presets window to it’s normal 

state.

To search for a preset:

1 Select a filter, for instance HFX Grads/Tints > Gels.

2 In the Presets window search field, type red.

All presets with red in the name are shown.
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3 In the search field, type sun|blue.

Any preset with sun or blue in the name is shown.

Favorites
Presets can be tagged as a Favorite allowing them to be sorted separately in 

the Presets window.

You can tag a preset as a Favorite by selecting the preset and pressing the 

Toggle Favorite icon located at the top right of the Presets window.

Presets tagged as a favorite display a yellow star at the top right of the preset.

To sort the Presets window by Favorites, select Favorites in the Presets pop-

up menu.

Presets Right-Click Menu
Right-click over a preset to open Preset options.

Rename
Right-click on a preset, select Rename and type in the new name.
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Delete
Right-click on a preset and select Delete.

Make Default
Right-click on a preset and select Make Default. The default preset is the one 

that is applied to the image when a filter is selected and the one shown in the 

Filter window. Changing the default will take effect the next time you start Dfx.

Restore

Default Presets
Restores the Default preset for each filter. The restore happens the next time 

you select the filter.

Deleted Presets
Restores deleted presets.

Renamed Presets
Restores renamed presets. The restore happens the next time you select the 

filter.

To Factory Default
Restores all presets to the default factory settings.

Parameters
The Parameters window displays the current filter’s parameters.
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Adjusting the parameters will update and change the image in the Viewer.

Slider controls can be adjusted in the following ways:

• Clicking and dragging the slider.

• You can adjust with finer precision by pressing Ctrl(Win)/Cmd(Mac) while 
dragging the slider.

• Clicking on the number to the right of the slider, typing in the desired value and 
hitting Enter.

• Hover the cursor over a slider and use the mouse scroll wheel to make the 
adjustment. Scrolling up raises the value while scrolling down lowers it.

Pop-up menus can be adjusted in the following ways:

• Click on the pop-up menu and make a selection.

• Hover the cursor over a pop-up menu and use the mouse scroll wheel to change 
the selection.

Create Custom Preset
Creates a custom preset in the Presets window based on the current parameter 

settings. You must name the preset prior to creating it by using the name field 

to the left of the Add Preset icon.
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Reset to Defaults
Resets all of the parameters for the currently selected preset to the built-in 

defaults.
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 VARIATIONS

Variations based on either one or two parameters can be created and are 

displayed as thumbnails in a window below the Presets window.

To display the Variations window and create variations, pick a filter and click on 

a parameter name in the Parameters window.
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Ranges, Toggles, and Color parameters are available for creating variations. 

When you select a parameter, the Variations window appears and you'll see the 

variations being generated on that parameter. Click on a second parameter and 

it will generate variations between the two.

The first parameter you click on will be the dominant parameter - it'll go across 

the top of the Variations tab. So, you can get different results depending on the 

order you select the parameters. Click on a selected parameter to toggle it back 

off again.

Note: You can only have one or two parameters selected at a time. If you click on a 
third parameter, the last parameter you clicked on will deselect itself. If you deselect 
both of the parameters or switch effects, the Variations window will disappear because 
the variations are no longer being generated.

Variations are generated based on the current effect parameters. So, you can 

pick some parameters for your variation, then go back to the Presets window 

and pick a different Preset, and the variations will regenerate.

Variation Controls

Maximum Number of Variations
Sets the number of variations.

Parameter Value Spread
Determines the difference from one variation to another.
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Auto Generate
Variations are constantly being generated every time you select a parameter or 

click on a variation thumbnail.

Generate
When Auto Generate is off, you must click the Generate icon to update the 

variations after new parameters are selected.
x User Guide



• 

Toolbar  165 

• 
• 
• 
•
•
•

 TOOLBAR

The Toolbar contains Done and Cancel icons.

Done
The values of the parameter adjustments in the Dfx user interface are 

transferred to your host application.

Cancel
Closes the Dfx user interface without making any changes.
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 COMMON FILTER CONTROLS

There are a number of common filter controls that appear in Dfx. For simplicity 

they are listed here.

View
Chooses what to view. The choices in this menu will change depending on the 

filter.

Dfx Interface
Opens the Dfx interface comprised of Viewer, Presets and Parameter windows. 

Here, you can select, view, adjust and save filter presets.

Note: In Premiere Pro, the Dfx interface is opened by clicking on the Setup icon located 

to the right of the filter name in the Effect Controls window.

Blur
Horizontal Blur
The image is blurred by a quality blur along the X-axis.

Vertical Blur
The image is blurred by a quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. Slide the 

horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Black and White
Selects the type of black and white filter to be applied to your color image.
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Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

DVE
The DVE allows you to transform your image using Position, Scale, Rotation, 

Corner Pin, Shear and Crop controls. Why the name DVE? DVE is an acronym 

for digital video effects and refers to a real-time image manipulation device 

which does pans, rotations, flips as well as various hardware-specific effects 

such as page turns or customized wipes. In the film and video post production 

industry, DVE is frequently used in reference to transforming the image in some 

way.

Crop
Top
Crops the image from the top down.

Bottom
Crops the image from the bottom up.

Left 
Crops the image from left to right.
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Right
Crops the image from right to left.

Corner Pin
The image can be corner pinned by adjusting the Corner Pin sliders as well as 

dragging the four points on the corners of the screen.

Note: You may need to zoom the image out a bit to see the corner points. In addition, 
to see and adjust the corner points in After Effects, make sure that the effect title in the 
Effect Controls window is highlighted. For Final Cut Pro, you must activate the cross 
hair icon next to the corner position parameters to see and adjust the corner points on 
the screen.

Upper-Left
Controls the X and Y position of the Upper Left Point.

Upper-Right
Controls the X and Y position of the Upper Right Point.

Lower-Right
Controls the X and Y position of the Lower Right Point.

Lower-Left
Controls the X and Y position of the Lower Left Point.

Position
Position can be adjusted by clicking and dragging an on-screen control in the 

center of the image.

Position X
The horizontal position.

Position Y
The vertical position.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter.
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Scale
Scale X
The horizontal scale.

Scale Y
The vertical scale.

Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Note: When Gang is turned on, the Scale Y slider doesn’t physically move. However, 
the Scale Y value will follow the value of the Scale X slider when Gang is turned on.

Rotate
In addition to the standard position and scale controls, you can rotate. Positive 

values rotate clockwise and negative values rotate counter-clockwise.

Shear
Shear X
Skews left and right.

Shear Y
Skews up and down.

Anchor
Anchor X
Defines the point on the X axis around which position, rotation, scaling or 

shearing takes place.

Anchor Y
Defines the point on the Y axis around which position, rotation, scaling or 

shearing takes place.

Grad
Grad is the gradient transition area between the filtered image and the original. 

Its direction, corners and size can be adjusted.
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Enable
Turns the Grad on and off.

ND Brightness
Darkens the colored portion of the Grad.

Direction
Controls the direction of the Grad.

Top-to-bottom
The direction of the Grad is from top to bottom.

Bottom-to-top
The direction of the Grad is from bottom to top.

Left-to-right
The direction of the Grad is from left to right.

Right-to-left
The direction of the Grad is from right to left.
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Corner Pin
There are four points around the four corners of the image. By clicking and 

dragging any of the four points, the Grad can be adjusted.

Note: You may need to zoom the image out a bit to see the corner points. In addition, 
to see the corner points in After Effects, make sure that the filter name in the Effect 
Controls window is highlighted. For Final Cut Pro, you must activate the cross hair icon 
next to the corner position parameters to see and adjust the corner points on the 
screen.

Upper Left
Controls the X and Y position of the Upper Left Point.

Upper Right
Controls the X and Y position of the Upper Right Point.

Lower Right
Controls the X and Y position of the Lower Right Point.

Lower Left
Controls the X and Y position of the Lower Left Point.

Photo © THINKSTOCK LLC--www.thinkstock.com
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Size
The size of the Grad.

Selection
In some of the filters, a selection is generated to create the desired effect. The 

Selection controls consist of Position, Range and Blur parameters, and they 

work the same in all of the filters. The white areas of the selection are the areas 

that will be affected by the filter, while the black areas remain unaffected. The 

selection is extracted based on luminance, in most cases, and is created using 

the Position and Range parameters.

Position
Selects the values to be included in the selection. A higher Position value 

shows more white values from the original image as white values in the 

selection. A lower Position value shows more black values from the original 

image as white values in the selection.

Position 0, Range 25 Position 100, Range 25Original

Photo © THINKSTOCK LLC--www.thinkstock.com
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Range
Controls the range of values to be used for the selection. Once you’ve selected 

the “Position”, you can then add or subtract the “Range” of values to be 

included in the selection. A higher Range value includes more white values in 

the selection while a lower Range value includes less values in the selection. 

Blur
The selection is blurred by a quality blur.

Spot
A spot in the form of a radial gradient is used to limit the effect of the filter.

Position
There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the spot can be adjusted.

Position X
The horizontal position of the spot.

Position 100, Range 25 Position 100, Range 75Original
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Position Y
The vertical position of the spot.

Note: To see the on-screen control in After Effects, you may need to highlight the filter 
name in the Effect Controls window, and in Final Cut Pro, you will have to click on the 
crosshair icon to the right of the Position parameter. On Avid Editing Systems, the 
Position parameters are named only X and Y.

Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the spot centerpoint.

Temperature

Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the warming or cooling.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 

warming or cooling.
x User Guide



• 

Common Filter Controls  175 

• 
• 
• 
•
•
•

Warming and Cooling

Color
Sets the color of the warming or cooling through the use of a standard color 

picker.

Opacity
Sets the opacity of the warming or cooling.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 

warming or cooling.

16-bit Processing
Turns 16 bit processing on or off.

A Force 16-bit processing function allows you to process in 16 bit even if your 

source images are 8 bit. 16 bit processing take longer to render, but will remove 

banding artifacts associated with 8 bit processing.
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 AMBIENT LIGHT

Description
Ambient creates light without a defined source and contributes to the overall 

brightness of a scene without casting shadows.

Go to the Ambient Light Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Brightness
Sets the intensity of the light.

Before After
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GamColor Presets
Digital equivalents of the lighting gels created by Gamproducts can be applied 

to your light source. Select one of the GamColor presets from the pop-up list. 

For detailed information about Gamproducts gels, visit their website at 

www.gamonline.com.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.
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 .BLACK AND WHITE

Description
Black and White converts color images to black and white simulating the look 

of Black and White photographic filters.

Go to the Black and White Tutorial to see how the filter works.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.

Before After
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Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.
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 BLEACH BYPASS

Description
Bleach Bypass is a film laboratory technique where, by skipping the bleach 

stage in the color processing sequence, silver is retained in the image along 

with the color dyes. The result is effectively a black and white image 

superimposed on a color image. Bleach Bypass images have increased 

contrast, reduced saturation, often giving a pastel effect.

Go to the Bleach Bypass Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Sets the intensity of the bleach effect.
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Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Temperature
Sets the color temperature of the image. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).
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 BLUR

Description
It’s fast, high quality and blurs outside the frame which removes the dark inward 

bleeding edges of most blurs. Horizontal, vertical or both, Blur uses either 

Gaussian or Box quality settings.

Go to the Blur Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Quality
Selects the quality of the blur.
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Box
A fast, lower quality box blur.

Gaussian
A slower, higher quality gaussian blur.

Blur
Sets how much the image is blurred.
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 CENTER SPOT / WARM CENTER SPOT

Description

Center Spot
Diffuses and blurs distracting backgrounds while keeping a center spot in 

focus. The center spot can be moved, sized and the amount of blur can be 

controlled.
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Warm Center Spot
Combines the benefits of Center Spot with a warming filter making it ideal for 

portraits and skintones.

Go to the Center Spot / Warm Center Spot Tutorial to see how the filters 

work.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Blur
Sets how much the image is blurred.
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Spot
A spot in the form of a radial gradient is used to control where blur is added to 

the image. Go to the Spot section of Common Filter Controls to see how the 

Spot controls work.

Temperature
Applies a warming filter to the image. Go to the Temperature section of 

Common Filter Controls to see how the Temperature controls work.
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 CHROMATIC ABERRATION

Description
Chromatic aberration is caused by a lens having a different refractive index for 

different wavelengths of light and is seen as fringes of color around the edges 

of the image. This fringing is removed by un-distorting the individual color 

channels.

Go to the Chromatic Aberration Tutorial to see how the filter works.

There are some new types of color fringes that are not chromatic aberration. 

These effects might be visible as purple or blue fringes and are visible around 

overexposed areas in most cases. If the following conditions apply, your image 

most likely has true chromatic aberration as opposed to color fringing caused 

by sensor overloading:

• Corners should show most color fringes whereas the center should show none.

• Color fringes should be not only at the edges of overexposed areas but at lower 
contrast edges, too.

• Color fringes should be of complementary color (red-cyan, green/magenta, and 
blue-yellow) on opposite sides of a dark or bright area.

• Color fringes should be in all corners with the same direction and pointing out 
from the center.

Category
Lens.
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Controls

Red/Cyan, Green/Magenta, Blue/Yellow
Use the appropriate color group to remove the chromatic aberration. For 

instance, if you see red/cyan fringing, use the Red/Cyan group. Start by 

adjusting the Distortion parameter.

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 

image inward while positive values pull the corners of the image outward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 

picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 

anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been adjusted.

Center X and Y
Determines the center point for the distortion.
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 CLOSE-UP LENS

Description
Simulates close-up lenses that allow you to zoom in extra close using high 

quality digital filtering.

Go to the Close-Up Lens Tutorial to see how the filter works.

Category
Lens.

Controls

Scale X
The horizontal scale of the image.

Scale Y
The vertical scale of the image.

Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Note: When Gang is turned on, the Scale Y slider doesn’t physically move. However, 
the Scale Y value will follow the value of the Scale X slider when Gang is turned on.
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Position
The position of the image can be adjusted by clicking and dragging an on-

screen control in the center of the image.

Position X
The horizontal position of the image.

Position Y
The vertical position of the image.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter.

Rotate
Rotates the image. Positive values rotate clockwise and negative values rotate 

counter-clockwise.
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 COLOR CORRECTORS

Description
Dfx includes a number of different color correctors that are handy for adjusting 

an image’s color. They include: Color Correct, F-Stop, Printer Points, Telecine 

and Temperature.

Color Correct
Color Correct manipulates red, green and blue values of the overall image and 

separately in user definable shadow, midtone and highlight areas. Hue, 

saturation, brightness, contrast and gamma controls allow for further control.

F-Stop
F-Stop manipulates red, green and blue values of the overall image and 

separately in user definable shadow, midtone and highlight areas using F-Stops 

as the unit of measure. In camera terminology, F-Stops measure the size of the 

lens opening, otherwise known as aperture. Each F-Stop is twice as bright as 

the next. 

Printer Points
Printer Points manipulate the red, green and blue values of the overall image 

and separately in user definable shadow, midtone and highlight areas using 

motion picture laboratory printer points as the unit of measure. When creating 
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color prints for motion pictures, a contact printer performs scene-to-scene color 

corrections. The most popular printing method is additive printing that uses 

three separate colored sources - red, green, and blue which are combined to 

form the light source that exposes the film. The red, green, and blue light valves 

in the printer are adjusted in values of 1, 2, 3... up to 60 for each primary color 

and are called printer points or printer lights. 

Telecine
Telecine emulates the method of color correction done in a telecine film to tape 

transfer suite. Hue, saturation, brightness, contrast, gamma and pedestal 

values of the overall image can be adjusted as well as separately in user 

definable shadow, midtone and highlight areas.

Temperature
Temperature manipulates the temperature, cyan/magenta and brightness 

values of the overall image and separately in user definable shadow, midtone 

and highlight areas.

Go to the Color Correctors Tutorial to see how the filters work.

Category
Image.

Master, Shadows, Midtones, Highlights
All of the color correctors can adjust an image by using it’s master, shadows, 

midtones and highlight groups. The Telecine filter uses the following 

terminology: Lift (shadows), Gamma (midtones) and Gain (highlights). The 

master settings affect the entire image while adjusting parameters within the 

shadows, midtones and highlights will only affect those specific areas.

If you are unsure about what values are included in the shadows, midtones and 

highlights, you can use the View pop-up menu. It will allow you to view the 

shadows, midtones and highlights as a black and white selection. The white 

areas are the areas that will be adjusted by that particular group. For instance, 

if you see white areas while viewing the midtones, then midtone color 
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adjustments will affect only those white areas. If you want to change the default 

areas defined by the shadows, midtones and highlights, you would use the 

Position and Range sliders.

Position
The Position slider pinpoints the values to be considered as shadows, 

midtones, or highlights. A low Position value uses the darkest image values, 

while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 

or highlights. A low Range value indicates a narrow range of values, while a 

high Range value indicates a large range of values.

Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.

Original Shadows Midtones Highlights
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Color Correct

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Flashing
The Flash parameters mix a color into the image through the use of a standard 

color picker. The default color is white. What in the world is this for? It is a great 

way to add atmosphere to an element. Flash comes from the film term 

“flashing”, which describes the optical process of lowering the contrast of an 

image by flashing it with light.
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Flash Amount 
Sets the opacity of the Flash Color. 

Flash Color
The Flash Color can be set through the use of a standard color picker.
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F-Stop

Red Exposure
Adds or subtracts red from the image.

Green Exposure
Adds or subtracts green from the image.

Blue Exposure
Adds or subtracts blue from the image.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 

Drag the Red Exposure slider to affect all three values.

Note: When Gang is turned on, the Green and Blue sliders don’t physically move. 
However, they will follow the value of the Red slider when Gang is turned on.
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Printer Points
The Red, Green and Blue Exposure are set to a value of 25 which represent no 

adjustment. Printer “lights” or points set to 25, 25, 25 are considered to be the 

normal or standard printer setup at most motion picture labs.

Red Exposure
Adds or subtracts red from the image. As in motion picture printing, higher 

values subtract and lower values add.

Green Exposure
Adds or subtracts green from the image. As in motion picture printing, higher 

values subtract and lower values add.

Blue Exposure
Adds or subtracts blue from the image. As in motion picture printing, higher 

values subtract and lower values add.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 

Drag the Red Exposure slider to affect all three values.

Note: When Gang is turned on, the Green and Blue sliders don’t physically move. 
However, they will follow the value of the Red slider when Gang is turned on.
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Telecine

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Pedestal
Adjusts the black level of the image.
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Temperature

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Brightness
Adjusts the brightness of the image.
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 COLOR-GRAD®

Description
Color-Grad® can transform an average sunrise or sunset into something 

spectacular or convert a dull, washed-out sky to a breathtaking blue. No other 

filter has done as much to improve landscape photography as the graduated 

filter. Add color selectively while leaving the rest of the scene unaffected by 

using a graduated transition for a smooth color blend between the colored 

portion and the original image. Presets for your favorite Color-Grad® filters are 

provided as well as the ability to create custom colors.

Go to the Color-Grad® Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Before After

Copyright © 2008--www.iofoto.com
x User Guide



• 

Color-Grad®  201 

• 
• 
• 
•
•
•

Filters

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad
Grad is the transition area that goes from the tinted image to the original image. 

Its direction, corners and size can be adjusted. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.
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 COLOR INFRARED

Description
Color Infrared simulates infrared filters used in conjunction with infrared 

sensitive film or sensors to produce very interesting false-color images with a 

dreamlike or sometimes lurid appearance.

Go to the Color Infrared Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Magenta
Adjusts the amount of magenta.
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Blue
Adjusts the amount of blue.

Hue
Adjusts the hue in any non-blue areas.

Contrast
Adjusts the contrast of the image.
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 COLOR SHADOW

Description
Creates a high contrast image overlayed with a gradient.

Go to the Color Shadow Tutorial to see how the filter works.

Category
Special Effects

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Threshold
Sets the amount of image detail.

Invert
Changes whether the gradient is in the background or foreground. 
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Background Color
Sets the color of the background. Select the desired color using the color 

picker.

Color 1
Sets the color for the top half of the image. Select the desired color using the 

color picker.

Color 2
Sets the color for the bottom half of the image. Select the desired color using 

the color picker.

Grad 
Grad is the transition area between the two colors. Its direction, corners and 

size can be adjusted. Go to the Grad section of Common Filter Controls to see 

how the Grad controls work.
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 COLOR SPOT

Description
Tints the image using presets for common photographic filters except for a 

center spot which retains normal color. The center spot can be moved, sized 

and the amount of blur can be controlled.

Go to the Color Spot Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Color
Color
The Color parameter sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Spot
A spot in the form of a radial gradient is used to control where color is added to 

the image. Go to the Spot section of Common Filter Controls to see how the 

Spot controls work.
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 CROSS PROCESSING

Description
Cross-processing is a photographic technique where print film (C41) is 

processed in the set of chemicals usually used to process slide film (E6) or vice 

versa. The final result yields images with oddly skewed colors and increased 

contrast and saturation. Different film stocks produce different results, so we 

have created what we feel is a representative look.

Go to the Cross Processing Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Amount
Sets the intensity of the cross process effect.

Mode
Print to Slide
Simulates the effect of print film (C41) being processed in slide (E6) chemicals.

Slide to Print
Simulates the effect of slide film (E6) being processed in print (C41) chemicals.
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 DAY FOR NIGHT

Description
Day for Night simulates a technique used for shooting exteriors in daylight 

made to look like they were photographed at night. Typically, it involves 

underexposing by two to two-and-a-half stops and using a filter to provide a tint, 

that is often a lavender-blue, as it mimics twilight and appears to emulate the 

mood of moonlight.

Go to the Day for Night Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Diffusion
Blur
Sets how much the image is diffused.
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Opacity
Sets the amount of diffusion mixed into the original image. The higher the 

setting, the more the image is blurred.

Moonlight
Color
The Color parameter sets the color of the moonlight through the use of a 

standard color picker. The default color is blue.

Opacity
Sets the opacity of the moonlight color.

Preserve Highlights
Preserves the white areas of the image.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 DEBAND

Description
DeBand removes banding artifacts from an image by smoothing pixels in 

banded areas while retaining detail. It is also surprisingly good for smoothing 

out skin.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Sets the amount of debanding.
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 DEBLOCK

Description
Blocking artifacts created as a result of high compression factors can be 

removed with the DeBlock filter.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Sets the amount of deblocking.
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 DEFOG

Description
Using advanced deweathering algorithms, Defog restores clear day contrasts 

and colors of a scene taken in bad weather such as fog and mist. It is also 

successful in removing the effects of optical Fog and Diffusion filters.

Go to the Defog Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Defog
Color
The Color parameter sets the color of the fog to be removed through the use of 

a standard color picker. The default color is white.
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Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 

to remove fog. By default, the vanishing point is set to the center of the screen. 

Essentially, the fog is removed in a radial pattern emanating from the vanishing 

point. So at the default center position, fog is removed in a circular pattern with 

a greater amount of fog being removed from the center while falling off at the 

edges. For instance, if your fog moves in the direction of top right to bottom left, 

set your vanishing point towards the top right corner and the fog removal will 

be more intense at the upper right and fall off at the bottom left. However, in 

most cases, the vanishing point can be left in the center of the screen and you 

will obtain acceptable results.

There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the vanishing point can be 

adjusted.

Position X
The horizontal position of the vanishing point.

Position Y
The vertical position of the vanishing point.

Note: To see the on-screen control in After Effects, you may need to highlight Defog in 
the Effect Controls window, and in Final Cut Pro, you will have to click on the crosshair 
icon to the right of the vanishing point parameter. On Avid Editing Systems, the 
Vanishing Point parameters are named only X and Y.

Defog
Sets the amount of fog to be removed from the scene.

Min Depth
Controls how much fog is removed from the darker areas of the image.

Max Depth
Controls how much fog is removed from the brighter areas of the image.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 DEFRINGE

Description
Purple or blue fringing around overexposed areas is a result of sensor 

overloading in video as well as digital still cameras. Defringe isolates and 

removes the various types of color fringing.

Go to the Defringe Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Red
Red
Adjusts the saturation of red values in areas defined by the Position and Range 

controls. Positive values saturate, negative values desaturate.
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Position
A selection is generated to isolate red fringing. The areas that are white in the 

red selection are the areas that will be defringed. Moving the Position slider will 

change the hue that is used for the red selection.

Range
Increases or decreases the range of values considered as red fringing. A low 

Range value indicates a narrow range of values, while a high Range value 

indicates a large range of values.

Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.

Green, Blue, Cyan, Magenta, and Yellow
The Green, Blue, Cyan, Magenta and Yellow groups work in a similar fashion 

to the Red group.
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 DENOISE

Description
Removes film grain and noise.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Sets the amount of denoising.

Note: You may not see an accurate representation of the grain and noise removal in 
the viewer unless your timeline/composition is set to high quality and the viewer is set 
to a 1:1 pixel ratio.
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 DEPTH OF FIELD

Description
Depth of Field can be added to a scene by isolating and blurring only a portion 

of the image. The amount of blurring is directly proportionate to the luminance 

of the selection settings, a gradient or an input image.

Go to the Depth of Field Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Depth
Depth
Selects the source for the depth of field effect.

Selection
Uses the selection for the depth source.

Grad
Uses a gradient for the depth source.

Strip
Uses a strip gradient for the depth source. 

Note: Since the strip grad is only horizontal or vertical, selecting Top-to-bottom and 
Bottom-to-top have the same result as do Left-to-right and Right-to-left.

Input
Uses an image as the depth source. This is useful for 3D programs which 

render out depth mattes.

To use an image as the depth source in Adobe After Effects:

• Change Depth > Depth to Input. 

• Select the layer you want to use from the Depth > Input selector.

To use an image as the depth source in Adobe Premiere Pro:

• Change Depth > Depth to Input. 

• Select the track you want to use from the Depth > Input selector located below the 
Depth > Depth pop-up.

To use an image as the depth source in Apple Final Cut Pro 6&7:

• Change Depth > Depth to Input. 

• Drag and drop a clip onto the clip icon to the right of the Depth > Input parameter.

Note: Using an image as a depth source in Apple Final Cut Pro X is not supported 
because of limitations with it’s plug-in format.

To use an image as the depth source in Avid Editing Systems:

• Change Depth > Depth to Input. 

• The track below the one that you added Depth of Field to is used as the depth 
source. 
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Blur
Sets how much the image is blurred.

Grad 
Depth of Field can optionally use a gradient that limits where the filter is applied. 

Grad is the transition area that goes from the blurred portion to the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of Common Filter Controls to see how the Grad controls work.

Selection
A selection can be used to create the depth of field effect. Go to the Selection 

section of Common Filter Controls to see how the Selection controls work.
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 DIFFUSION

Description
Diffusion creates atmosphere by reducing contrast while creating a glow 

around highlights or shadows. It simulates diffusion and fog filters as well as 

glows. In addition, a texture library allows you to add realistic diffusion to 

scenes as if you were adding diffusion directly to your camera lens.

Go to the Diffusion Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Diffusion
Blend
Determines the blend mode to be used to create the diffusion effect.

Add
The diffusion is added to your image.
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Screen
The diffusion is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the diffusion.

Blur
Sets the softness of the diffusion.

Color
The Color parameter sets the color of the diffusion through the use of a 

standard color picker. The default color is white.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Selection
A selection can be used to create the diffusion effect. Go to the Selection 

section of Common Filter Controls to see how the Selection controls work.

Texture
Texture
Selects the texture which will be used to add diffusion to the image.

Blend
Textures can be used as the source of the diffusion as well as combined with a 

selection using a variety of Blend modes. Go to Blend Modes for explanations 

of the various modes.

I like the Multiply blend mode for combining textures with the selection because 

it only puts the texture within the areas of the generated selection.

DVE
The DVE allows you to transform your texture using Position, Scale, Rotation, 

Corner Pin, Shear and Crop controls. Why the name DVE? DVE is an acronym 

for digital video effects and refers to a real-time image manipulation device 

which does pans, rotations, flips as well as various hardware-specific effects 
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such as page turns or customized wipes. In the film and video post production 

industry, DVE is frequently used in reference to transforming the image in some 

way. Go to the DVE section of Common Filter Controls to see how the DVE 

Controls work.
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 DIFFUSION/FX®

Description

Black Diffusion/FX®
Gives a silky-smooth look to textured surfaces, suppresses facial blemishes 

and wrinkles, while maintaining a clear, focused image. Creates a diffused 

image that doesn't look like it's been shot through a filter.

Gold Diffusion/FX®
Offers all the benefits of the Black Diffusion/FX® filter, but also infuses special 

warmth by adding a soft, golden tint to shadows.

Go to the Diffusion/FX Tutorial to see how the filters works.

Category
HFX Diffusion.

Before Black After
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Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Blur
Fine image details are smoothed by softening the image based on a selection 

with areas of detail being retained by using an edge detect.

Edge
Edge detail lost as a result of the blurring is restored through the use of an edge 

detect.

Brightness
Determines the brightness of the edge selection.

Blur
Blurs the edge selection.

Opacity
Determines the opacity of the edge detail added back to the image.

Selection
A selection is used to smooth image details. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.

Temperature
Applies a warming filter to the image. Go to the Temperature section of 

Common Filter Controls to see how the Temperature controls work.
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 DOUBLE FOG

Description
The Double Fog filter creates a soft, misty atmosphere over the image by first 

applying fog using a vanishing point along the direction of increasing distance 

in the image. Then, a second pass blooms image highlights. 

Go to the Double Fog Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Fog
Color
The Color parameter sets the color of the fog to be added through the use of a 

standard color picker. The default color is white.

Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 

to add fog. By default, the vanishing point is set to the center of the screen. 

Essentially, the fog is added in a radial pattern emanating from the vanishing 

point. So at the default center position, fog is added in a circular pattern with a 

greater amount of fog being added in the center while falling off at the edges. 

For instance, if you would like your fog to move in the direction of top right to 

bottom left, set your vanishing point towards the top right corner and the fog will 

be more intense at the upper right and fall off at the bottom left. However, in 

most cases, the vanishing point can be left in the center of the screen and you 

will obtain acceptable results. 

There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the vanishing point can be 

adjusted.

Position X
The horizontal position of the vanishing point.

Position Y
The vertical position of the vanishing point.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the vanishing point can be adjusted. To see the 
on-screen control in After Effects, you may need to highlight Double Fog in the Effect 
Controls window, and in Final Cut Pro, you will have to click on the crosshair icon to the 
right of the vanishing point parameter. On Avid Editing Systems, the Vanishing Point 
parameters are named only X and Y.

Fog
Sets the amount of fog to be added to the scene.

Min Depth
Controls how much fog is added in the darker areas of the image.
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Max Depth
Controls how much fog is added in the brighter areas of the image.

Glow
The Glow controls are used to add additional atmosphere and are useful in 

adding glow to highlights. By default, a wide selection of highlights are glowed 

in the image and blended with the Screen blend mode. This works well for 

adding additional fog. To add glow around highlights such as light sources, it is 

best to set the Blend mode to Add and lower the Selection > Range parameter 

to limit the areas of glow to only include the light sources.

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
The Color parameter sets the color of the glow through the use of a standard 

color picker. The default color is white.

Selection
A selection is used to create the glow effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 DUAL GRAD

Description
Dual Grad applies two photographic filters to the image which are blended 

together with a gradient. Presets for your favorite Color-Grad® filters are 

provided as well as the ability to create custom colors.

Go to the Dual Grad Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Color 1
Sets the color for the top half of the image. Select the desired color using the 

color picker or choose a filter preset.
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Presets
Select one of the filters from the pop-up list.

Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 

to the bottom half of the image.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
Grad is the transition area between the two tints. Its direction, corners and size 

can be adjusted. Go to the Grad section of Common Filter Controls to see how 

the Grad controls work.
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 EDGE GLOW

Description
Edge Glow isolates lines and edges in an image and then adds glow only to 

these areas resulting in a stylized look.

Go to the Edge Glow Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Glow
Blend
Determines the blend mode to be used to create the edge glow effect.
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Add
The edge glow is added to your image.

Screen
The edge glow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the edge glow.

Blur
Sets the softness of the edge glow.

Color
The Color parameter sets the color of the edge glow through the use of a 

standard color picker. The default color is white.

Edge
An edge selection is created to produce the edge glow effect.

Brightness
Determines the brightness of the edge selection.

Blur
Blurs the edge selection.
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 ENHANCING 

Description
Makes reds, rust browns and oranges pop, with minimal effect on other colors. 

Perfect for fall foliage, earthtone rock formations, architecture, woodwork, 

faded rustic barns and any photos where red, brown and orange subjects 

should be enriched or appear more intense. In addition, the green or blue areas 

of the image can be isolated and enhanced with minimal effect on other colors.

Go to the Enhancing Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Enhancing
Adjusts the saturation of red, green or blue hues.
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Selection
Presets
A selection is created based on the hue of the image to create the 

enhancement effect. Select from Red, Green or Blue preset hue selections 

from the pop-up list or use the Hue eyedropper to pick a color off of the screen.

Hue
When adjusting the Hue parameter, you are selecting the hue of the image 

which will be enhanced.

Note: The Hue Color picker allows you to select a custom selection color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Range
Increases or decreases the range of values in the hue selection. A low Range 

value indicates a narrow range of values. A high Range value indicates a large 

range of values included in the selection.

Blur
Sets the softness of the selection by using a fast, quality blur.

Go to the Selection parameters to see how they work.
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 EYE LIGHT

Description
Creates a targeted light to be placed around a person's eyes.

Go to the Eye Light Tutorial to see how the filter works.

Category
Light.

Controls

Light
Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.
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Blur
Sets the softness of the light.

GamColor Presets
Digital equivalents of the lighting gels created by Gamproducts can be applied 

to your light source. Select one of the GamColor presets from the pop-up list. 

For detailed information about Gamproducts gels, visit their website at 

www.gamonline.com.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

Shadow
Brightness
Sets the intensity of the shadows. The Brightness parameter will darken only 

those areas that are not being brightened by the Light settings. 

DVE
The DVE allows you to transform your eye light using Position, Scale, Rotation 

and Corner Pin controls. Why the name DVE? DVE is an acronym for digital 

video effects and refers to a real-time image manipulation device which does 

pans, rotations, flips as well as various hardware-specific effects such as page 

turns or customized wipes. In the film and video post production industry, DVE 

is frequently used in reference to transforming the image in some way. Go to 

the DVE section of Common Filter Controls to see how the DVE Controls work.
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 FAUX FILM

Description
The Faux Film filter attempts to give digital images the look of photographic 

film. It reduces contrast, creates a soft mist around highlights and adds film 

grain.

Go to the Faux Film Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Mist
Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist.

Color
The Color parameter sets the color of the mist through the use of a standard 

color picker. The default color is white.

Grain
Go to the Grain filter to see how the Grain controls work.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Selection
A selection is used to create the mist effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 FILM STOCKS

Description
Film Stocks is a unique filter that simulates a 113 different color and black and 

white photographic film stocks.

Go to the Film Stocks Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Amount
Sets the amount of the selected preset.
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Black and White
Red, Green and Blue controls allow you to determine the contribution of each 

color channel in the black and white conversion.

Enable
Enables the Black and White conversion.

Red
Sets the amount of the red channel that contributes to the black and white 

conversion.

Green
Sets the amount of the green channel that contributes to the black and white 

conversion.

Blue
Sets the amount of the blue channel that contributes to the black and white 

conversion.

Film Response
To mimic the characteristics of a particular film stock, a combination of settings 

for the RGB channels have been set.

RGB
Controls the RGB film response curve. If you are using a black and white 

preset, the grayscale film response curve will be adjusted.

Red
Controls the Red film response curve.

Green
Controls the Green film response curve.

Blue
Controls the Blue film response curve.
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Color Correct
Color Correct manipulates the Temperature, Cyan/Magenta, Brightness, 

Contrast, Shadow, Midtone, Highlight, and Saturation values of the image. Go 

to the Color Corrector filters to see how it works.

Filter
Adds a color filter to the image.

Presets
Select one of the filters from the pop-up list.

Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Sharpen
Amount
Determines how much contrast is added at the edges.

Radius
Controls the size of the edges you wish to sharpen.

Threshold
The threshold setting is used to sharpen more pronounced edges, while 

leaving more subtle edges untouched. Low values sharpen more image areas 

while higher threshold values sharpen less.

Diffusion
Blur
Sets the softness of the image.
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Amount
Sets the amount of diffusion mixed into the original image. The higher the 

setting, the more the image is blurred.

Vignette
A vignette is a popular photographic effect where the photo gradually fades into 

a color. Go to the Vignette filter to see how it works.

Grain
Grain simulates film grain with individual control of red, green, and blue grain 

size, softness and intensity. In addition, a Film Response parameter controls 

where you will see grain in the image. Go to the Grain filter to see how it works. 

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.
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 FLASHING

Description
Flashing allows you to use photographic filters to lower the contrast of your 

shadows or highlights. The motion picture lab can expose a small amount of 

light to the film at various stages of the developing and printing process. For 

example, Negative plus Dupe Negative flashing lifts blacks, while Print plus 

Master Positive flashing softens whites.

Go to the Flashing Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Shadows
Brightness
Raises the brightness of the shadows using either the Shadow > Color or 

Shadow > Presets.
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Presets
Select one of the filters from the pop-up list.

Color
The Color parameter sets the color of the flashing through the use of a standard 

color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows. 

Highlights
Brightness
Lowers the brightness of the highlights using either the Highlights > Color or 

Highlights > Presets.

Presets
Select one of the filters from the pop-up list.

Color
The Color parameter sets the color of the flashing through the use of a standard 

color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights.
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Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.
x User Guide



• 

FL-B/D®  247 

• 
• 
• 
•
•
•

 FL-B/D®

Description
Provides correct color, removing the harsh green cast caused by fluorescent 

bulbs.

Go to the FL-B/D® Tutorial to see how the filter works.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Temperature
Removes the greenish tone caused by photographing under fluorescent lights.
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 FLAG / DOT

Description
Flags and Dots are rectangular and circular lighting control devices used to 

create shadow areas on a motion picture or photographic set. This concept has 

been extended to digital so that areas of the image can be selectively 

darkened.

Go to the Flag / Dot Tutorial to see how the filters works.

Category
Light.

Controls

Flag / Dot
Brightness
Sets the intensity of the flag or dot.
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Blur
Sets the softness of the flag or dot.

DVE
The DVE allows you to transform your flag or dot using Position, Scale, 

Rotation and Corner Pin controls. Why the name DVE? DVE is an acronym for 

digital video effects and refers to a real-time image manipulation device which 

does pans, rotations, flips as well as various hardware-specific effects such as 

page turns or customized wipes. In the film and video post production industry, 

DVE is frequently used in reference to transforming the image in some way. Go 

to the DVE section of Common Filter Controls to see how the DVE Controls 

work.
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 FOG

Description
The Fog filter creates a soft, misty atmosphere over the image and glows 

highlights.

Go to the Fog Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Fog
Blend
Determines the blend mode to be used to create the fog effect.
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Add
The fog is added to your image.

Screen
The fog is combined with the image using a Screen blend mode. This looks kind 

of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the fog.

Blur
Sets the softness of the fog.

Color
The Color parameter sets the color of the fog through the use of a standard 

color picker. The default color is white.

Selection
A selection is used to create the fog effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 GELS

Description
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whether they want to create a romantic moonlit setting or 

a vicious, angry fight, they have the colors they need to achieve the effect. In 

cooperation with Gamproducts and Rosco, we have created digital versions of 

their popular gels.

Go to the Gels Tutorial to see how the filter works.

Category
HFX Grads/Tints.

GamColor Gels
Digital equivalents of the lighting gels created by Gamproducts can be applied 

to the entire image or inside a gradient. Three GamColor gel groups contain 

digital gels from the GamColor, CineFilters and Naked Cosmetics collections.

For detailed information about Gamproducts gels, visit their website at 

www.gamonline.com.
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GamColor
The GamColor system divides the visible spectrum into nine color sections 

convenient to the lighting designer. It is a circular classification of colors by hue, 

referencing the primaries, secondaries and important subdivisions. The 

GamColor gels are arranged according to this system, making it easy to locate 

any color in a logical manner.
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GamColor CineFilters
CineFilters change the color temperature to balance your lighting situation 

using a variety of filters including CTO(sunlight to incandescent), 

CTB(incandescent to daylight), ND(light reducing), Minus Green(eliminates the 

peak green output of fluorescent lights) and Plus Green(incandescent to 

fluorescent).

GamColor Naked Cosmetics
Naked Cosmetics™ are designed to modify skin tones. Use them to blend and 

enhance skin tones while masking undesirable undertones. The choice of 

which Naked Cosmetics™ gel to use depends on a few variables. Skin color of 

the subjects, costumes, make-up, the recording medium, the desired effect, 

and most important, your artistic taste.

Gels
A set of generic lighting gels are provided in the Gels preset group.

Rosco Gels
Digital equivalents of the lighting gels created by Rosco can now be applied to 

the entire image or inside a gradient. Four Rosco gel groups contain gels from 

the Calcolor, Cinegel, Cinelux and Storaro Selection collections.

For detailed information about Rosco gels, visit their website at 

www.rosco.com.

Rosco Calcolor
Calibrated color, by Rosco, is a series of color effects lighting gels designed 

specifically to the spectral sensitivity of color film. The series includes the 

primary colors Blue, Green and Red, along with the secondary colors Yellow, 

Magenta and Cyan followed by Pink and Lavender. Each color is designed in 

four densities: 15, 30, 60 and 90, corresponding to the familiar ½, 1, 2 and 3 

stop calibrations.
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Rosco Cinegel
The Rosco Cinegel range includes over 75 tools for controlling light including 

Tungsten Conversion Filters, Daylight Conversion Filters, Sun 85 & Neutral 

Density Filters, Filters for Controlling Carbon ARC & HMI Lighting as well as 

Fluorescent Light Filters. In 1974, Cinegel won an Academy Award for 

technical achievement.

Rosco Cinelux

Cinelux is a selection from the Roscolux range of color gels.

Rosco Storaro Selection
The Storaro Selection contains ten color effects lighting gels designed to the 

personal specifications of eminent cinematographer Vittorio Storaro. These ten 

colors represent key chromatic elements of the visible spectrum, and are 

intended for dramatic effect and strong emotional response.

Controls

Presets
To select a gel, open the Dfx interface and pick one from the Presets window. 

If you would like to view presets from a different category, use the pop-up menu 

at the top left of the Presets window.

Gels
Color
The Color parameter sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the gel 

application.
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Grad 
Gels can optionally use a gradient that limits where the filter is applied. Grad is 

the transition area between the colored portion and the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 GLIMMERGLASS®, BRONZE GLIMMERGLASS®

Description

Glimmerglass®
Softens fine details in a unique manner, while adding a mild glow to highlights.

Bronze Glimmerglass®
Same as Glimmerglass® but combined with a warming filter.

Go to the Glimmerglass® / Bronze Glimmerglass® Tutorial to see how the 

filters work.

Category
HFX Diffusion.
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Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Blur
Fine image details are smoothed by softening the image based on a selection 

with areas of detail being retained by using an edge detect.

Edge
Edge detail lost as a result of the blurring is restored through the use of an edge 

detect.

Brightness
Determines the brightness of the edge selection.

Blur
Blurs the edge selection.

Opacity
Determines the opacity of the edge detail added back to the image.

Selection
A selection is used to smooth image details. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.

Mist
The Mist controls add a mild glow to image highlights.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist.
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Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Temperature
Applies a warming filter to the image. Go to the Temperature section of 

Common Filter Controls to see how the Temperature controls work.
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 GLOW

Description
The Glow filter creates glows around selected areas of the image.

Go to the Glow Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Glow
Blend
Determines the blend mode to be used to create the glow effect.
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Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
The Color parameter sets the color of the glow through the use of a standard 

color picker. The default color is white.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Selection
A selection is used to create the glow effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 GLOW DARKS

Description
Glows and grows the darks areas of the image.

Go to the Glow Darks Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Glow
Amount
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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Selection
A selection is used to create the glow effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 GRAIN

Description
Grain simulates film grain with individual control of red, green, and blue size, 

intensity and softness. In addition, a Film Response parameter controls where 

you will see grain in the image. Popular film stock presets are provided as a 

starting point to adding grain.

Go to the Grain Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Monochrome
When checked, the grain is monochrome. In this mode, only the Red Size, Red 

Amount and Red Softness sliders are active. Since the grain is monochrome, 

only one slider is needed.
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Size
The Size parameters control the size of the grain. Sometimes a film stock’s 

grain structure varies in size from one color channel to another, so individual 

control has been given. The larger the Size settings, the larger the grain will be.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Red Size
Controls the size of the red grain.

Green Size
Controls the size of the green grain.

Blue Size
Controls the size of the blue grain.

Amount
The Amount parameters set the red, green and blue intensities of the grain. 

Film stocks generally have varying amounts of red, green and blue intensities 

with the blue intensity generally higher than the rest. If you turn the red, green 

and blue amount sliders to a value of 0, the grain will disappear.

Red Amount
Controls the intensity of the red grain.

Green Amount
Controls the intensity of the green grain.

Blue Amount
Controls the intensity of the blue grain.

Softness
The Softness parameters control the softness of the grain. Some film stock’s 

grain structure varies in softness from one color channel to another, so 

individual control has been given. Normally, only minor softness adjustments 

are necessary, usually between a value of 0-1.
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Red Softness
Controls the softness of the red grain.

Green Softness
Controls the softness of the green grain.

Blue Softness
Controls the softness of the blue grain.

Film Response
The Film Response parameter allows the adjustment of where you will see 

grain in the image. In most cases, film grain is apparent over the entire image 

except the brightest whites with the black areas being the most affected.

Position
The Position slider defines the portions of the image where grain will be added. 

A low Position value places grain in the darkest image values, while a high 

Position value places grain in the brightest areas.

Range
Increases or decreases the area where grain is added to the image based on 

the value of the Position slider. A low Range value indicates a narrow range of 

values, while a high Range value indicates a large range of values.

Minimum
Sets the minimum level of grain that is always added to the image.

Note: A Position value of 0 and a Range of 80 is typical of standard film, with grain 
applied to the entire range except the brightest whites with black being the most 
affected.
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 HALO

Description
Halo causes dark areas to glow into bright areas and bright areas to glow into 

dark areas along with a bit of diffusion.

Go to the Halo Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Diffusion
Blur
Sets the softness of the image.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 

setting, the more the image is blurred.
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Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 HAZE / SKY

Description

Haze
Reduces excessive blue by absorbing UV light and eliminates haze which 

tends to wash out color and image clarity.
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Sky
Reduces UV light, haze and is pink tinted for added warmth and better colors. 

It is especially useful for images shot in outdoor open shade and on overcast 

days

Go to the Haze / Sky Tutorial to see how the filter works.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Haze
Sets the amount of haze to be removed from the scene.
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Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Note: Cyan/Magenta is only included in the Sky filter.
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 HDTV/FX®

Description
With the increase in HD production for both TV and Motion Pictures, 

HDTV/FX® filters address both contrast and sharpness issues associated with 

HD. Creates a “film look” and provides subtle improvements in shadow detail.

Go to the HDTV/FX® Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Blur
Fine image details are smoothed by softening the image based on a selection 

with areas of detail being retained by using an edge detect.
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Edge
Edge detail lost as a result of the blurring is restored through the use of an edge 

detect.

Brightness
Determines the brightness of the edge selection.

Blur
Blurs the edge selection.

Opacity
Determines the opacity of the edge detail added back to the image.

Selection
A selection is used to smooth image details. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.

Contrast
Shadows
Raises the brightness of the shadows.

Highlights
Lowers the brightness of the highlights.
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 HFX® STAR

Description
Exciting and dazzling star effects are generated from original point or reflected 

light sources with the added glitter and sparkle of these exclusive, natural 

looking asymmetrical designs and shapes. Great for water scenes, candle 

flames, street lights and more!

Go to the HFX® Star Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Star
The Star settings control the various qualities of the star patterns.

Type
Chooses the type of star pattern to use.

Hyper Star

Hollywood Star
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North Star

Vector Star

Blend
Determines the blend mode to be used when adding the stars.

Add
The stars are added to your image.

Screen
The stars are combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Brightness
Determines the brightness of the stars.

Size
Sets the star size.

Angle
Rotates the stars.

Color
Sets the star color.

Threshold
Controls the amount of stars. The higher the threshold value, the less stars you 

will see.
Dfx User Guide    
• 
• 
•
•
•



   Df

278 High Contrast

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 HIGH CONTRAST

Description
Creates an extreme high contrast image.

Go to the High Contrast Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Contrast
Sets the amount of contrast to be applied to the scene.

Amount
Sets the mix amount between the original and filtered version.

Before After

Copyright © 2008--www.iofoto.com
x User Guide



• 

Ice Halos  279 

• 
• 
• 
•
•
•

 ICE HALOS

Description
Ice halos are created when small ice crystals in the atmosphere generate halos 

by reflecting and refracting light. Most notably, circles form around the sun or 

moon as well as rare occurrences when the entire sky is painted with a web of 

arcing halos.

Go to the Ice Halos Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Light
Blend
Determines the blend mode to be used to add the ice halo.

Add
The ice halo is added to your image.
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Screen
The ice halo is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the ice halo.

Displacement
Displaces the ice halo by the luminance values of the image. This “fakes” the 

effect of the ice halo wrapping over objects in the image.

Blur
Sets the softness of the ice halo.

Halo
Blend Mode
The ice halo can be added to the entire image or limited to a selection. 

Halo Only
The ice halo is added to the entire image.

Selection
The ice halo is added only in areas of the selection.

Sun Altitude
Selects the appropriate ice halo pattern based on the sun’s altitude.

Position
The ice halo position can be adjusted by clicking and dragging an on-screen 

control in the center of the image.

Position X
The horizontal position of the ice halo.

Position Y
The vertical position of the ice halo.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter.
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Scale

Scale X
The horizontal scale of the ice halo.

Scale Y
The vertical scale of the ice halo.

Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Note: When Gang is turned on, the Scale Y slider doesn’t physically move. However, 
the Scale Y value will follow the value of the Scale X slider when Gang is turned on.

Selection
A selection can be used to limit where the ice halo will be placed. Wherever 

there is white in the selection is where the ice halo will be added. Go to the 

Selection parameters to see how they work.

Note: To use a selection to limit where the ice halo will be added, the Halo > Blend 
Mode must be set to Selection.
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 INFRARED

Description
Infrared simulates infrared filters used in conjunction with infrared sensitive film 

or sensors to produce very interesting black and white images with glow in 

highlight areas.

Go to the Infrared Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Black and White
Selects the type of black and white filter to be applied to your color image. Go 

to the Black and White section of Common Filter Controls to see how the 

Black and White controls work.

Mist
Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Selection
A selection is used to create the glow effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 KELVIN

Description
Degrees Kelvin is the standard unit of measure for color temperature which is 

a way to characterize the spectral properties of a light source. Low color 

temperature implies warmer (redder) light, while high color temperature implies 

a colder (bluer) light. Presets for a number of different light sources and 

conditions are provided in degrees Kelvin.

Go to the Kelvin Tutorial to see how the filter works.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Color Temperature
The Color Temperature of the image is determined by the difference of the 

Destination and Source Kelvin parameters. For instance, if your Source Kelvin 

is 3200 degrees Kelvin and you adjust the Destination Kelvin to 6500 degrees, 
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your image would turn blue. This is the same as using tungsten indoor film 

meant to be used with lighting balanced for 3200 degrees Kelvin outside in 

daylight which is 6500 degrees Kelvin.

Destination Kelvin
Sets the destination color temperature of the image in degrees Kelvin.

Source Kelvin
Sets the source color temperature of the image in degrees Kelvin.

Opacity
Sets the opacity of the color temperature adjustment.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the color 

temperature application.

Grad 
Kelvin can optionally use a gradient that limits where the filter is applied. Grad 

is the transition area between the colored portion and the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 KEY LIGHT

Description
Using Key Light, an image can be relit by with either a directional or point light. 

The result looks natural even though the relighting is done without computing 

any scene geometry.

Go to the Key Light Tutorial to see how the filter works.

Category
Light.

Controls

Type
Parallel
A directional light source.

Point
A point light where the light either emanates from or fades into a vanishing 

point. Move the point control in the center of the screen to change the Point light 

location.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter to move the Point light location.
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Strength
Sets the strength of the light.

Angle
Used in conjunction with Parallel, Angle sets the direction of the light source.

Invert
Used in conjunction with Point, Invert determines whether the light source 

emanates from or fades into a vanishing point.
Dfx User Guide    
• 
• 
•
•
•



   Df

288 Lens Distortion

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 LENS DISTORTION

Description
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 

lenses. It is also useful for creating the look of a wide angle lens.

Go to the Lens Distortion Tutorial to see how the filter works.

Category
Lens.

Barrel Distortion Pin Cushion Distortion

Original
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Controls

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 

image outward while positive values pull the corners of the image inward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 

picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 

anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been moved.

Center
Determines the center point for the distortion. There is an on-screen control in 

the center of the image. By clicking and dragging the on-screen control, the 

Center can be adjusted.
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 LIGHT / GOBO

Description
Light can be added to a scene where none existed before just as if you were 

adding light at the time of shooting. Realistic lighting and shadow is introduced 

using digital versions of the entire gobo libraries created by Gamproducts and 

Rosco. 

Gobos (patterns) are widely used by designers in theatre, film, photography 

and television to create atmosphere, project scenery, and generally enhance 

the visual impact of their lighting. Normally used in front of lights during 

photography, these same exact gobos can be applied digitally to the entire 

image or inside a selection.

Go to the Light / Gobo Tutorial to see how the filters work.

Category
Light.
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Presets
To select a gobo, open the Dfx interface and pick one from the Presets window. 

If you would like to view gobos from a different category, use the pop-up menu 

at the top left of the Presets window.

Light

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Subtract
The light is subtracted from your image creating shadow instead of light.

Brightness
Sets the intensity of the light.

Displacement
Displaces the gobo by the luminance values of the image. This “fakes” the 

effect of light wrapping over objects in the image.

Blur
Sets the softness of the light.

Gels
Digital equivalents of the lighting gels created by Gamproducts and Rosco can 

be applied to the light source. Light uses GamColor gels while Gobo uses 

Rosco gels. Select one of the gel presets from the pop-up list. For detailed 

information about Gamproducts and Rosco gels, visit their websites at 

www.gamonline.com and www.rosco.com.

Displaced Gobo
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Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Gels pop-up menu.

Shadow

Brightness
Sets the intensity of the shadows. The Brightness parameter will darken only 

those areas that are not being affected by the Light settings. 

Selection
A selection can be used to create areas of light or limit where gobos will be 

added. Wherever there is white in the selection is where the light will be added. 

When using the Light and Gobo filters, it is usually helpful to blur the selection. 

Go to the Selection parameters to see how they work.

Note: To use a selection to create light, the Gobo > Blend Mode must be set to 
something other than Gobo Only for the Selection controls to be active.

Selection
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Gobos
The gobos are organized into different categories. Light uses Gamproducts 

gobos while Gobo uses Rosco gobos. For detailed information about 

Gamproducts and Rosco gobos, visit their websites at www.gamonline.com 

and www.rosco.com.

Gamproducts Gobos
The Gamproducts line of gobos are used in Light with 565 designs to choose 

from including Breakups; Fire, Water & Natural Elements; Flowers, Foliage & 

Trees; Holidays, Symbols & Religion; Pinspots, Vignettes & Spirals; Signage, 

Themes & Class of; Sky, Stars, Clouds & Moons; Skylines, Structures, Fences 

& Stone; Windows, Graphics, Grids & Grilles.
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Rosco Gobos
The Rosco line of gobos are used in Gobo with 1300 designs to choose from 

including Abstract; Architectural & Retail; Boundaries & Wildlife; Breakups; 

Churches & Heraldics; Clouds Water & Sky; Fire & Ice; Foliage Breakups; 

Graphics & Grills; Occasions & Holidays; Rotation, Symbols & Signs; Trees & 

Flowers; Windows, Doors & Blinds; and World Around Us.

Type
Gobo

Uses the gobo selected in the Presets window.

Input
Input allows you to use your own image or sequence as the light source.

Note: You must first select Input from the Gobo > Type pop-up menu before you can 
use your own image or sequence as the light source.
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To use your own image or sequence as a light source:

Adobe After Effects
• Select Input from the Gobo > Type menu. 

• Select a layer from the Gobo > Input menu. 

Adobe Premiere Pro
• Select Input from the Gobo > Type menu. 

• Select a track from the Gobo > Input menu located below the Gobo > Type menu. 

Apple Final Cut Pro 6&7
• Select Input from the Gobo > Type menu.

• Drag and drop a clip onto the clip icon to the right of the Gobo > Input parameter.

Note: Using an image as a light source in Apple Final Cut Pro X is not supported 
because of limitations with it’s plug-in format.

Avid Editing Systems
• Select Input from the top most pop-up in the Gobo group. 

• Place the light source clip on a track below the clip you applied Light/Gobo to.

Note: If the camera is moving and you want to add a gobo, the gobo won’t 
automatically follow the camera. You will either need to manually move the gobo to 
follow the camera or better, use Motion Tracking software to Match Move the gobo to 
the camera move. Track the motion of your source image, set your View to Gobo, apply 
the tracker motion to your gobo and render it. To use the newly tracked and rendered 
gobo as a light source, follow the previous instructions listed for using your own image 
or sequence as the light source.

Blend Mode
The gobo can be added to a selection using a variety of Blend modes. Go to 

Blend Modes for explanations of the various modes.
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I like the Multiply blend mode for combining gobos with the selection because 

it only puts the gobo within the areas of the selection.

Opacity
Sets the opacity of the gobo.

Selection Gobo

Multiply
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Blur
Sets the softness of the gobo.

DVE
The DVE allows you to transform your gobo using Position, Scale, Rotation, 

Corner Pin, Shear and Crop controls. Why the name DVE? DVE is an acronym 

for digital video effects and refers to a real-time image manipulation device 

which does pans, rotations, flips as well as various hardware-specific effects 

such as page turns or customized wipes. In the film and video post production 

industry, DVE is frequently used in reference to transforming the image in some 

way. Go to the DVE section of Common Filter Controls to see how the DVE 

Controls work.

Selection with Shape Blur=20
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 LOOKS: BLACK/WHITE & COLOR

Description
Looks is a unique filter meant to simulate a variety of color and black and white 

photographic/film looks, diffusion and color grad camera filters, lighting gels, 

film stocks and optical lab processes. By selecting from the available presets, 

parameters in the various modules are automatically set to achieve a variety of 

different effects.

Original Reminiscing Cool

Antique Steel Bleach

Glamour Day for Night Halo

Copyright © 2008--www.iofoto.com
Dfx User Guide    
• 
• 
•
•
•



   Df

300 Looks: Black/White & Color

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Category
Special Effects.

Controls
The Looks filters are made up of Color Correct, Diffusion, Color-Grad®, Gels, 

Lab, Grain and Post Color Correct groups. Together, they simulate a variety of 

photographic and film looks. By selecting from the available presets, 

parameters in the various groups are automatically set to achieve a variety of 

different effects.

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Color Correct
Color Correct manipulates the Black and White, Hue, Saturation, Brightness, 

Contrast, Gamma, Red, Green and Blue values of the image. Go to the Color 

Correct filter to see how it works.

Diffusion
Diffusion creates atmosphere by reducing contrast while creating a glow 

around highlights or shadows. It simulates diffusion and fog filters as well as 

glows. Go to the Pro-Mist filter to see how it works.

Color-Grad®
Color-Grad® can transform an average sunrise or sunset into something 

spectacular or convert a dull, washed-out sky to a breathtaking blue. No other 

filter has done as much to improve landscape photography as the graduated 

filter. Add color selectively while leaving the rest of the scene unaffected by 

using a graduated transition for a smooth color blend between the colored 

portion and the original image. Presets for your favorite Color-Grad® filters are 

provided as well as the ability to create custom colors. Go to the Color-Grad® 

filter to see how it works.
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Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whether they want to create a romantic moonlit setting or 

a vicious, angry fight, they have the colors they need to achieve the effect. We 

have created digital equivalents to the lighting gels and these same exact 

colors can be applied to the entire image. Go to the Gels filter to see how it 

works.

Lab
The Lab group simulates a variety of different optical lab processes including 

Bleach Bypass, Cross Processing, Flashing and Overexposure. Go to the 

Bleach Bypass filter, Cross Processing filter, Flashing and the Overexpose 

filter to see how they work.

Grain
Grain simulates film grain with individual control of red, green, and blue grain 

size, softness and intensity. In addition, a Film Response parameter controls 

where you will see grain in the image. Go to the Grain filter to see how it works.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Post Color Correct
Post Color Correct gives you further color correction after all other operations 

have been processed. This is often helpful as some of the operations affect the 

brightness, contrast and color of the image. In addition, Temperature controls 

allow you to make the scene warmer or cooler, and cyan or magenta. Go to the 

Color Correct filter to see how it works.
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 LOW CONTRAST

Description
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 

bright areas bright.

Go to the Low Contrast Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Contrast
Light Brightness
Sets the intensity of the light that is spread into darker areas.
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Light Spread
Sets how far light is spread from bright areas to darker areas.

Shadow Brightness
Adjusts the brightness of the shadow areas.

Selection
A selection is used to create the light spread effect. Go to the Selection section 

of Common Filter Controls to see how the Selection controls work.
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 MATCH

Description
Matches the Brightness, Color, Detail, Grain and Tone of one image and 

applies it to another.

Go to the Match Tutorial to see how the filter works.

Note: Match is not supported in Final Cut Pro X because of limitations in it’s plug-in 
format. For Premiere Pro, Match requires CS6 or later for matching capability.

Category
Image.

Controls

Brightness
Matches the brightness of the source image.

Note: The Brightness parameter behaves differently depending on the source image. 
For instance, the slider can either brighten or darken. It is a dual use control.

Source Target
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Color
Matches the color of the source image.

Detail
Matches the sharpness of the source image.

Note: The Detail parameter behaves differently depending on the source image. For 
instance, the slider can either sharpen or soften. It is a dual use control.

Grain
Simulates the grain of the source image.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Tone
Matches the tint of the source image. With some source images, a duotone 

effect is created.

Source
Selects a source image to be matched.

• Adobe After Effects: Select the layer from the Source selector.

• Adobe Premiere Pro CS6 or later: Select the track from the Source selector located 
above the Match button.

• Apple Final Cut Pro: Drag and drop the source clip onto the filmstrip icon next to 
the Source parameter.

• Avid Editing Systems: Place the source clip on a track below the clip you applied 
Match to.

Match
Analyzes the source image’s settings at the selected frame.

Note: Switch the View from Output to Source to view the source frame you want to 
copy.

Matching Clips:

1 Apply the Match filter to a target clip.

2 Select the source image to be matched using the Source selector.

3 Change the View from Output to Source.

4 Find the frame in the sequence that you would like to copy.
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5 Make sure that your timeline/composition is set to high quality and the viewer is 
set to a 1:1 pixel ratio. Otherwise, the grain in the viewer won’t accurately match 
the rendered result.

6 Click the Match box.

The Color, Detail, Grain and Tone of the source image are analyzed and 

applied to your target image.

7 Switch the View from Source to Output.

8 Adjust the Color, Detail, Grain and Tone parameters to your liking.
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 MONO TINT

Description
Mono Tint converts color images to black and white while applying a color tint.

Go to the Mono Tint Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Black and White
Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Tint
Color
The Color parameter sets the color of the tint through the use of a standard 

color picker.

Opacity
Sets the opacity of the tint.

Preserve Highlights
Preserves the white areas of the image.
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 ND-GRAD

Description
The ND or Neutral Density Grad darkens only a portion of the image using a 

graduated transition between the darkened portion and the original image. It 

selectively adjusts brightness without affecting color balance. The most likely 

use for the ND-Grad would be to balance the difference between the sky and 

the ground. 

Go to the ND-Grad Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

F-Stop
Presets
Select one of the ND-Grad presets from the pop-up list.
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Exposure
Darkens the image using F-Stops as the unit of measure.

Preserve Highlights
Preserves the white areas of the image.

Grad
Grad is the transition area between the darkened portion and the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of Common Filter Controls to see how the Grad controls work.
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 NIGHT VISION

Description
The Night Vision filter creates the effect of a Night Vision lens--that green, 

glowy, grainy look.

Go to the Night Vision Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Black and White
Selects the type of black and white filter to be applied to your color image. Go 

to the Black and White section of Common Filter Controls to see how the 

Black and White controls work.
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Tint

Color
Sets the color that the image will be tinted with. The color is preset to a night 

vision green, but feel free change it by using the color picker.

Opacity
Sets the opacity of the tint color.

Glow

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Additional Controls

Grain
Grain Size
Controls the size of the grain.

Note: You may not see an accurate representation of the grain in the viewer unless 
your timeline/composition is set to high quality and the viewer is set to a 1:1 pixel ratio.

Grain Amount
Controls the intensity of the grain.
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Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Selection
A selection is used to create the glow effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 NUDE/FX®

Description
A series of different skin tone enhancing filters that offer ultimate flexibility and 

control for skintones. Perfect for headshots and close-ups.

Go to the Nude/FX® Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Color
Color
The Color parameter sets the color through the use of a standard color picker.
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Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
The Nude/FX® filters can optionally use a gradient that limits where the filter is 

applied. Grad is the transition area between the colored portion and the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of Common Filter Controls to see how the Grad controls work.
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 OLD PHOTO

Description
Images are treated to look like a variety of historical photographic processes 

including Cyanotype, Kallitype, Light Cyan, Palladium, Platinum, Sepia, Silver, 

Silver Gelatin and Van Dyck.

Go to the Old Photo Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Cyanotype
Blue photographic prints employing light sensitive iron salts, most commonly on 

paper.
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Kallitype
A silver-iron method for making permanent prints in gold, palladium and 

platinum metals.

Light Cyan
A lighter, less saturated version of Cyanotype.

Palladium
Palladium was introduced as a cheaper alternative to Platinum prints, and 

possesses a remarkable range of tones and surface texture.

Platinum
Platinum prints are an iron (non-silver) process for making photographic prints 

in which platinum is reduced from a salt to form the image. 

Sepia
Sepia toning replaces silver in the black and white photographic print with silver 

sulphide, which is brown.

Silver
Prints made on paper coated with a solution of albumen (egg whites) and 

ammonia salt, which is then sensitized with silver nitrate and printed (usually 

using a collodion negative).

Silver Gelatin
The silver gelatin process uses gelatin as the binder and developed silver as 

the image material.

Van Dyck
The Vandyke print gets its name from its similarity in color to the deep brown 

pigment, Vandyke brown, used by the Flemish painter Van Dyck.

Filter
Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.
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Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Tint
Color
Sets the color that the image will be tinted with. Select the desired color using 

the color picker. The default color is a cyan tone.

Opacity
Sets the opacity of the tint.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 OVEREXPOSE

Description
Overexpose simulates the overexposure that occurs when a film camera is 

stopped.

Go to the Overexpose Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Controls the amount of overexposure.
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Intensity
Sets the intensity of the overexposure.

Blur
Sets the softness of the overexposure.
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 OZONE

Description
The Ozone filter allows you to manipulate the color of an image with incredible 

flexibility and accuracy. Inspired by Ansel Adams’ Zone System for still 

photography, we have created “The Digital Zone System”. Just what is the 

Digital Zone System? The world around us contains an infinite palette of colors, 

tones and brightness. To reproduce this vast range of brightness, the Digital 

Zone System takes the spectrum of image values and divides them into 11 

discrete zones using proprietary image slicing algorithms. Zones can be 

created using luminance, hue, saturation, average, red, green, blue, cyan, 

magenta, and yellow values. Look at how the image below is divided into hue 

zones. 

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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With Ozone, the color values of each zone can be independently adjusted until 

you’ve painted a new picture. Your adjustments occur on a zone by zone basis, 

but you view the result of all color corrections simultaneously.

Go to the Ozone Tutorial to see how the filter works.

Category
Image.

Extract On
The Extract On pop-up menu allows you to specify the image values to be used 

for dividing the image into the 11 individual zones.

Luminance
Zones are created using the image’s luminance values.

Hue
Zones are created using the image’s hue. When adjusting the Position 

parameter, you are selecting different hues.

Saturation
Zones are created using the image’s saturation values.

Before After

Copyright © 2008--www.iofoto.com
x User Guide



• 

Ozone  323 

• 
• 
• 
•
•
•

Average
Zones are created based on the average of the image’s RGB values.

Red
Zones are created using the image’s red values.

Green
Zones are created using the image’s green values.

Blue
Zones are created using the image’s blue values.

Cyan
Zones are created using the image’s cyan values.

Magenta
Zones are created using the image’s magenta values.

Yellow
Zones are created using the image’s yellow values.

Zone Controls
When using Luminance as the method for slicing up the image, the Position 

and Range sliders are preset so that each zone is twice as bright as the 

previous zone, proceeding from black towards white.

Pure black is defined as Zone 0, Zone 5 as middle gray and pure white as Zone 

10. By using the View menu, you can look at the zone which is helpful in 

determining the portions of the image you are going to adjust. The values 

shown as white in the selected zone are the areas of the image that will be 

modified by the color adjustments.Go to the Selection section of Common 

Filter Controls to see how the Position and Range controls work.

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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Position
The Position value pinpoints the color values to be used in the selected zone. 

This value has been preset according to the Digital Zone System, but can be 

changed if you choose. If the zones are created using Luminance, a high 

Position value shows the brightest image values as white values in the zone. A 

low Position value shows the darkest image values as white values in the zone.

Range
The Range value increases or decreases the range of values in the selected 

zone. This value has been preset according to the Digital Zone System, but can 

be changed if you want.

Hue
Rotates the hue of the zone.

Saturation
Adjusts the saturation of the zone. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the zone. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the zone. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the zone. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the zone.

Green
Adds or subtracts green from the zone.
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Blue
Adds or subtracts blue from the zone.

Temperature
Sets the color temperature of the zone. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).
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Zone Thumbnail
At the bottom of the Parameter window is a thumbnail of the selected zone to 

help you see which areas of the image will be adjusted.
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 PENCIL

Description
Pencil converts your image to a pencil sketch.

Go to the Pencil Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Sets the intensity of the pencil effect.
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Color
The Color parameter sets the color of the pencil effect through the use of a 

standard color picker.
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 PHOTOGRAPHIC 

Description
The most complete line of Kodak® filters for photographic uses is available in 

the form of gelatin films and are known as Wratten® Gelatin Filters. Our 

Photographic filter is a digital equivalent of the Wratten set and were created 

using the spectral transmission curves for each optical filter. The Color 

Conversion, Light Balancing and Color Compensating preset groups are 

subsets of the Photographic filters. 

Go to the Photographic Tutorial to see how the filter works.

Photographic
Digital versions of the complete line of Kodak® Wratten® Gelatin Filters.

Color Conversion
Color Conversion filters correct for significant differences in color temperature 

between your light source and recording media.
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Light Balancing
Light Balancing filters correct for minor differences in color temperature 

between your light source and recording media.

Color Compensating
Color Compensating filters control color by attenuating specific parts of the 

spectrum. They can be used to make changes in color balance or compensate 

for deficiencies in the image’s spectral quality.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Filters
Color
The Color parameter sets the color of the filter through the use of a standard 

color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.
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Grad 
These filters can optionally use a gradient that limits where the filter is applied. 

Grad is the transition area between the colored portion and the original image. 

Its direction, corners and size can be adjusted. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.
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 POLARIZER / WARM POLARIZER

Description

Polarizer
The greatest use of polarizing filters is to achieve a darkened, deep blue sky. 

Our digital version of the Polarizer is designed to do just that. Through the use 

of a selection and an adjustable gradient, the color of the sky can be adjusted.
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Warm Polarizer
Combines the benefits of the Polarizer with a warming filter making it ideal for 

portraits and scenics.

Go to the Polarizer Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Sky
Color Correct controls are provided to adjust the sky.

Hue
Rotates the hue of the sky.
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Saturation
Adjusts the saturation of the sky. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the sky. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the sky. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the sky. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the sky.

Green
Adds or subtracts green from the sky.

Blue
Adds or subtracts blue from the sky.

Temperature
Sets the color temperature of the sky. Dragging the slider to the right makes the 

sky cooler (bluer) and dragging the slider to the left makes the sky warmer 

(redder).

Warming
Applies a warming filter to the image. Go to the Warming section of Common 

Filter Controls to see how the Warming controls work.
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Grad
The Polarizer can optionally use a gradient that limits where the filter is applied. 

For instance, if the polarization is affecting areas other than the sky, enable the 

Grad and adjust it to limit the areas of polarization. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.

Selection
Hue
The Polarizer isolates the sky using a selection based on a blue hue. Use the 

Hue eyedropper to select the exact color of the sky if you are not seeing enough 

polarization.

Range
Increases or decreases the range of values in the hue selection. A low Range 

value indicates a narrow range of values. A high Range value indicates a large 

range of values included in the selection.

Blur
Sets the softness of the selection by using a quality blur.

Go to the Selection parameters to see how they work.
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 PRO-MIST®

Description

Pro-Mist®
This popular motion picture effect creates a special atmosphere by softening 

excess sharpness and contrast. It generates a pearlescent halo around 

highlights.

Warm Pro-Mist®
Same as Pro-Mist® but combined with a warming filter. It is useful in outdoor 

open shade situations where there is excessive blue in the image and when 

total control over lighting may not be possible.
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Cool Pro-Mist®
Same as Pro-Mist® but combined with a cooling filter.

Black Pro-Mist®
Offers all the benefits of the Pro-Mist® filter in a more subtle form. Highlight 

flares are controlled and contrast is lowered for a more delicate effect.
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Warm Black Pro-Mist®
Same as Black Pro-Mist® but combined with a warming filter.

Go to the Pro-Mist® Tutorial to see how the filters work.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Mist
Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist.

Color
The Color parameter sets the color of the mist through the use of a standard 

color picker. The default color is white.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Temperature
Applies a filter to the image to achieve either warming or cooling. Go to the 

Temperature section of Common Filter Controls to see how the Temperature 

controls work.

Selection
A selection is used to create the mist effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 RACK FOCUS

Description
Rack Focus replicates a true camera defocus by introducing lens Bokeh 

effects. Bokeh is the Japanese term that describes the quality of out-of-focus 

points of light. In defocused areas, each point of light becomes a shape--either 

a circle or a polygon. The shape grows in size as the amount of defocusing is 

increased.

Go to the Rack Focus Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Blur
The image is blurred by using a quality blur.

Aperture
Blend
Determines the blend mode to be used when adding Bokeh.

Add
Bokeh’s are added to your image.

Screen
The Bokeh are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Brightens the Bokeh.

Facets
Set the number of Bokeh facets when the Curvature parameter is set to 0.

Curvature
Controls the curvature of the Bokeh. When set to 100, the Bokeh are 

completely round. Set to a value of 0 to see a polygonal shape.

Angle
Rotates the Bokeh.

Color
Sets the Bokeh color.

Threshold
Controls the amount of Bokeh. The higher the threshold value, the less Bokeh 

you will see.

Blur
Sets the softness of the Bokeh. This can be useful when using high threshold 

values.
Dfx User Guide    
• 
• 
•
•
•



   Df

342 Radial Exposure

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 RADIAL EXPOSURE

Description
Lightens and/or darkens the center or edges of an image to correct lens 

vignetting.

Go to the Radial Exposure Tutorial to see how the filter works.

Category
Lens.

Controls

Exposure
Edges
Lightens or darkens the edges of the image.

Center
Lightens or darkens the center of the image.
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Spot
A radial gradient is used to lighten or darken the edges or center of the image. 

Go to the Spot section of Common Filter Controls to see how the Spot controls 

work.
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 RAINBOW

Description
Recreates arced rainbows of spectral colors, usually identified as red, orange, 

yellow, green, blue, indigo, and violet, that appear in the sky as a result of the 

refractive dispersion of sunlight in drops of rain or mist.

Go to the Rainbow Tutorial to see how the filter works.

Category
Light.

Controls

Light
Blend
Determines the blend mode to be used to add the rainbow.

Add
The rainbow is combined with the image using an Add blend mode.

Screen
The rainbow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.
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Normal
The rainbow is added to the image using a normal composite function.

Amount
Sets the intensity of the rainbow.

Displacement
Displaces the rainbow by the luminance values of the image. This “fakes” the 

effect of the rainbow wrapping over objects in the image.

Blur
Sets the softness of the rainbow.

Rainbow
Blend Mode
The rainbow can be added to the entire image or limited to a selection. 

Rainbow Only
The rainbow is added to the entire image.

Selection
The rainbow is added only in areas of the selection.

Position
The rainbow position can be adjusted by clicking and dragging an on-screen 

control in the center of the image.

Position X
The horizontal position of the rainbow.

Position Y
The vertical position of the rainbow.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter.

Radius
The size of the rainbow.
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Aspect
Sets the aspect ratio of the rainbow. Positive values stretch the rainbow 

horizontally and negative values stretch it vertically.

Thickness
Sets the thickness of the rainbow’s bands.

Softness
Sets the softness of the rainbow’s bands.

Crop
Offset
The rainbow is cropped based on the Offset value. The higher the value, the 

more rainbow you see. A value of -100 shows no rainbow at all while 100 

displays a complete 360 degree rainbow.

Angle
Sets the angle of the crop.

Softness
Sets the softness of the crop’s edge.

Selection
A selection can be used to limit where the rainbow will be placed. Wherever 

there is white in the selection is where the rainbow will be added. Go to the 

Selection parameters to see how they work.

Note: To use a selection to limit where the rainbow will be added, the Rainbow > Blend 
Mode must be set to Selection.
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 RAYS

Description
Create stunning and realistic light ray effects quickly and easily. Known as 

volumetric lighting in computer graphics or crepuscular rays in atmospheric 

optics, this dramatic effect adds polish and style. Since the rays are only added 

to highlight areas, they have the effect of passing through objects and add a 

third dimensional quality. Add shafts of light streaming through clouds, rays 

filtering through a forest canopy, beams of light on a foggy night or rays 

shooting out from text. Rays adds a striking and dramatic quality to any image.

Go to the Rays Tutorial to see how the filter works.

Category
Light.

Before After
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Controls

Rays
Length
Sets the ray length.

Threshold
Controls the amount of rays based on a brightness threshold. Fewer rays with 

more definition are generated at higher threshold values.

Position
Move the point control in the center of the screen to change the source point 

from which the rays will emanate.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter to move the Rays source location.

Color
Brightness
Sets the brightness of the rays.

Color
Sets the color of the rays.

Shimmer
Randomizes the rays.

Amount
Sets the amount of shimmering.

Phase
Sets the randomness of the shimmering.

Opacity
Rays
Sets the opacity of the rays.
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Source
Sets the opacity of your image.
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 RELIGHT

Description
Light can be added to a scene where none existed before. A complete set of 

light source controls allow you to adjust the light just as you would at the time 

of shooting.

Go to the ReLight Tutorial to see how the filter works.

Category
Light.

Light

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Before After
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Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.

Displacement
Displaces the light source by the luminance values of the image. This “fakes” 

the effect of light wrapping over objects in the image.

Blur
Sets the softness of the light.

GamColor Presets
Digital equivalents of the lighting gels created by Gamproducts can be applied 

to your light source. Select one of the GamColor presets from the pop-up list. 

For detailed information about Gamproducts gels, visit their website at 

www.gamonline.com.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

Selection
A selection can be used to limit the area of added light. Wherever there is white 

in the selection is where the light will be added. When using ReLight, it is 

usually helpful to blur the selection. Go to the Selection parameters to see how 

they work.

Note: Light Source > Blend Mode must be set to something other than Shape Only for 
the Selection controls to be active.
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Light Source

Blend
The light source can be added to the selection using a variety of Blend modes. 

Go to Blend Modes for explanations of the various modes.

I like the Multiply blend mode for combining the light source with the selection 

because it only puts the light source within the areas of the selection.

Opacity
Sets the opacity of the light source.

Radius
The un-blurred radius of the light.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the light centerpoint.

DVE
The DVE allows you to transform your light source using Position, Scale, 

Rotation, Corner Pin, Shear and Crop controls. Why the name DVE? DVE is an 

acronym for digital video effects and refers to a real-time image manipulation 

device which does pans, rotations, flips as well as various hardware-specific 

effects such as page turns or customized wipes. In the film and video post 

production industry, DVE is frequently used in reference to transforming the 

image in some way. Go to the DVE section of Common Filter Controls to see 

how the DVE Controls work.
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 REFLECTOR

Description
One of the oldest and still most popular means of lighting an exterior set is by 

taking a reflective surface and redirecting sunlight or artificial light exactly 

where it is needed. Unfortunately, it is nearly impossible for actors to keep their 

eyes open when looking into a reflector, resulting in squinting eyes. Our silver 

and gold reflectors allow you to add white or gold light into shadow areas 

without the squinting.

Go to the Gold / Silver Reflector Tutorial to see how the filters work.

Category
Light.

Before After
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Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Brightness
Sets the intensity of the reflector.

Color
The Color parameter sets the color of the reflector through the use of a 

standard color picker. The default color is gold for Gold Reflector and white for 

Silver Reflector.

Position
Selects the shadow values that will be adjusted with the Brightness slider.

Range
Controls the range of shadow values that will be adjusted with the Brightness 

slider.

Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.
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 SELECTIVE COLOR CORRECT

Description
Colors can be selectively isolated through the use of a selection and adjusted 

using hue, saturation, brightness, gamma, contrast, red, green, and blue 

controls.

Go to the Selective Color Correct Tutorial to see how the filter works.

Category
Image.

Color Correct
Certain parts of the image are isolated by the creation of a selection. Whatever 

is shown as white in the selection can be adjusted by the color controls below. 

Hue
Rotates the hue of the image.

Before
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Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Temperature
Sets the color temperature of the image. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).
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Selection
A selection is created to isolate areas to be color corrected. Using advanced 

image slicing algorithms, selections are created using luminance, hue, 

saturation, average, red, green, blue, cyan, magenta, and yellow values.

Extract On
Extract On selects the type of selection. Select whichever type isolates the 

desired values.

A selection is created based on one of the following:

Luminance
A selection is created based on the luminance of the image.

Hue
A selection is created based on the hue of the image. When adjusting the 

Position parameter, you are selecting different hues.

Saturation
A selection is created based on the saturation of the image.

 Original                                                       Selection

Hue Selection
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Average
A selection is created based on the average of the image’s RGB values.

Red
A selection is created based on the image’s red values.

Green
A selection is created based on the image’s green values.

Blue
A selection is created based on the image’s blue values.

Cyan
A selection is created based on the image’s cyan values.

Magenta
A selection is created based on the image’s magenta values.

Yellow
A selection is created based on the image’s yellow values.

Position
The Position value pinpoints the color values to be used in the selection. For a 

luminance selection, a Position value of 100 would make a white selection of 

the highlights and a value of 0 would make a white selection of the shadows. In 

the flower image below, look at how the selection varies for different Position 

values in a red extraction. When the Position is at a value of 100, the red 

flowers are shown as white in the selection.

Position=100, Range=25
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When the Position is moved to 50, the red flowers turn black.

Range
Increases or decreases the range of values in the selection. A low Range value 

indicates a narrow range of values. A high Range value indicates a large range 

of values included in the selection.

Black Clip
Blacks in the selection are made blacker by increasing the value of the slider. 

As the slider value increases, more values are clipped to black. This is helpful 

for getting rid of unwanted grey areas in what should be the black part of the 

selection. 

Position=50, Range=25

Position=100, Range=50

Selection with No Black Clip                                 Black Clip=50
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White Clip
Whites in the selection are made whiter by increasing the value of the slider. As 

the slider value increases, more values are clipped to white. This is helpful for 

getting rid of unwanted grey areas in what should be the white part of the 

selection. 

Shrink/Grow
Shrinks or grows the selection. Negative values shrink and positive values 

grow the selection.

Selection with No White Clip                               White Clip=50

Original

                    Shrink=-2                                              Grow=1.5
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Blur
Blurs the selection.

Invert
• Off

Does nothing to the selection.

• On

Inverts the luminance values of the selection.                         

No Blur                                                   Blur=10 

Invert Off                                                 Invert On
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 SELECTIVE SATURATION

Description
The saturation of the image can be adjusted independently in the shadows, 

midtones and highlights.

Go to the Selective Saturation Tutorial to see how the filter works.

Category
Image.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Shadows
Saturation
Adjusts the saturation of the image in the shadows. Positive values saturate, 

negative values desaturate.

Position
Selects the shadow values to be adjusted.

Before After
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Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows.

Midtones
Saturation
Adjusts the saturation of the image in the midtones. Positive values saturate, 

negative values desaturate.

Position
Selects the midtones values to be adjusted.

Range
Controls the range of values to be used for the midtones. A higher Range value 

considers more values as midtones.

Highlights
Saturation
Adjusts the saturation of the image in the highlights. Positive values saturate, 

negative values desaturate.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights.

Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.
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 SEPIA / 812® WARMING

Description

Sepia
Creates a warm brown tone for that nostalgic feeling.

812® Warming
The 812® Warming filter, a Tiffen exclusive, improves skintones and is ideal for 

portraits taken on a cloudy day or in outdoor shade on a sunny day.

Go to the Sepia / 812® Warming Tutorial to see how the filters work.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Before After
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Color
Amount
Determines the intensity of the color added to the image.

Opacity
Sets the opacity of the filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
Sepia and 812® Warming can optionally use a gradient that limits where the 

filter is applied. Grad is the transition area between the colored portion and the 

original image. Its direction, corners and size can be adjusted. Go to the Grad 

section of Common Filter Controls to see how the Grad controls work.
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 SMOQUE®

Description
Mechanical smoke generators are often used to enhance realism where smoke 

is normally encountered. This can be difficult, costly and less desirable to work 

in a smoke-filled environment. The Smoque® filter creates the look of smoke 

without the cost and hassle of smoke generators.

Go to the Smoque® Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Smoke
Blend
Determines the blend mode to be used to create the smoke effect.

Add
The smoke is added to your image.

Screen
The smoke is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the smoke.

Blur
Sets the softness of the smoke.

Color
The Color parameter sets the color of the smoke through the use of a standard 

color picker. The default color is white.

Selection
A selection is used to create the smoke effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 SOFT CONTRAST

Description
Soft Contrast diminishes highlights while retaining the darker look of the 

shadows.

Go to the Soft Contrast Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Highlights
Lowers the brightness of the highlights.
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Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights. 

Go to the Selection section of Common Filter Controls to see how the 

Selection controls work.
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 SOFT/FX®, WARM SOFT/FX®

Description

Soft/FX®
Softens and minimizes facial imperfections while retaining overall image clarity. 

Ideal portrait filter.

Warm Soft/FX®
Combines all of the benefits of Soft/FX® with a warming filter.

Go to the Soft/FX® / Warm Soft/FX® Tutorial to see how the filters work.

Category
HFX Diffusion.
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Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window. If you would like to view presets from a different category, use the pop-

up menu at the top left of the Presets window.

Blur
Sets the softness of the image.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 

setting, the more the image is blurred.

Temperature
Applies a warming filter to the image. Go to the Temperature section of 

Common Filter Controls to see how the Temperature controls work.
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 SOFT LIGHT

Description
Provides soft, digitally diffused and virtually shadowless light.

Go to the Soft Light Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.
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Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.

Blur
Sets the softness of the light.

GamColor Presets
Digital equivalents of the lighting gels created by Gamproducts can be applied 

to your light source. Select one of the GamColor presets from the pop-up list. 

For detailed information about Gamproducts gels, visit their website at 

www.gamonline.com.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.
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 SPLIT FIELD

Description
Split Field splits the image with a line that can be positioned, rotated and 

blurred. On one side of the line, the image is blurred and on the other, it is in 

focus.

Go to the Split Field Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Blur
Sets the softness of the split portion of the image.
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Split
The Split controls manipulate the position, rotation and blur of the split line.

Position
There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the split line can be adjusted.

Position X
The horizontal position of the split line.

Position Y
The vertical position of the split line.

Note: To see the on-screen control in After Effects, you may need to highlight Split Field 
in the Effect Controls window, and in Final Cut Pro, you will have to click on the 
crosshair icon to the right of the Position parameter. On Avid Editing Systems, the 
Position parameters are named only X and Y.

Rotate
Rotates the split line.

Blur
Blurs the split line using a quality blur.
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 SPLIT TONE

Description
Shadows, midtones and highlights can be individually tinted with the Split tone 

filter.

Go to the Split Tone Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Shadows
Opacity
Set the opacity of the tint color.

Tint
The Tint parameter sets the color of the shadow tint through the use of a 

standard color picker.

Position
Selects the shadow values to be adjusted.
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Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows. 

Midtones
Opacity
Set the opacity of the tint color.

Tint
The Tint parameter sets the color of the midtone tint through the use of a standard color 
picker.

Position
Selects the midtone values to be adjusted.

Range
Controls the range of values to be used for the midtones. A higher Range value 

considers more values as midtones. 

Highlights
Opacity
Set the opacity of the tint color.

Tint
The Tint parameter sets the color of the highlight tint through the use of a standard color 
picker.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights.

Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.
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Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 

tinting.
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 STAR

Description
Six point star patterns are generated on highlights in the image.

Go to the Star Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Star
Brightness
Sets the intensity of the stars.

Size
Controls the size of the stars.
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Color
The Color parameter sets the color of the stars through the use of a standard 

color picker. The default color is white.

Note: When adding stars to images with a lot of dark values, you may need to increase 
the Star > Brightness value.

Selection
A selection is used to create the star effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 STREAKS

Description
The Streaks filter creates horizontal or vertical streaks around highlights in the 

image.

Go to the Streaks Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Streaks
Blend
Determines the blend mode to be used to create the streak effect.
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Add
The streaks are added to your image.

Screen
The streaks are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the streaks.

Streaks

Horizontal Streaks
Creates horizontal streaks.

Vertical Streaks
Creates vertical streaks.

Color
The Color parameter sets the color of the streaks through the use of a standard 

color picker. The default color is white.

Selection
A selection is used to create the streak effect. Go to the Selection section of 

Common Filter Controls to see how the Selection controls work.
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 STRIP GRAD

Description
Strip Grad colors only a portion of the image in the form of a narrow strip. 

Presets for your favorite Color-Grad® filters are provided as well as the ability 

to create custom colors. There is a graduated transition for a smooth color 

blend between the colored portion and the original image. Strip Grad is 

especially good for changing and enhancing a narrow portion of the sky.

Go to the Strip Grad Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Filters
Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad
Grad is the transition area between the colored portion and the original image. 

Its direction, corners and size can be adjusted. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.
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 SUNSET/TWILIGHT

Description
Sunset/Twilight applies three photographic filters to the image which are 

blended together with a gradient. Presets for your favorite Color-Grad® filters 

are provided as well as the ability to create custom colors.

Go to the Sunset/Twilight Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Color 1
Sets the color for the top third of the image. Select the desired color using the 

color picker or choose a filter preset.

Presets
Select one of the filters from the pop-up list.
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Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 

to the middle third of the image.

Color 3
The Color 3 controls are the same as the controls for Color 1 except it is applied 

to the bottom third of the image.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
Grad is the combination of the three blended tints. Its direction, corners and 

size can be adjusted.Go to the Grad section of Common Filter Controls to see 

how the Grad controls work.
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 TEXTURE

Description
Applies textures to an image for a stylized look.

Go to the Texture Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Amount
Sets the amount of texture applied to the image.

Complexity
Generates a more detailed, repetitive texture.
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Randomize
Randomizes the texture.

DVE
The DVE allows you to transform your texture using Position, Scale, Rotation, 

Corner Pin, Shear and Crop controls. Why the name DVE? DVE is an acronym 

for digital video effects and refers to a real-time image manipulation device 

which does pans, rotations, flips as well as various hardware-specific effects 

such as page turns or customized wipes. In the film and video post production 

industry, DVE is frequently used in reference to transforming the image in some 

way. Go to the DVE section of Common Filter Controls to see how the DVE 

Controls work.
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 THREE STRIP / TWO STRIP

Three Strip
Known and celebrated for it ultra-realistic, saturated levels of color, the 

Technicolor® Three Strip process was commonly used for musicals, costume 

pictures and animated films. It was created by photographing three black and 

white strips of film each passing through red, green and blue filters on the 

camera lens and then recombining them in the printing process. Our Three 

Strip filter was created under the direction of Academy Award Winning Visual 

Effects Supervisor Rob Legato.

Two Strip
The Technicolor® Two Strip process was the first stab at producing color 

motion pictures and consisted of simultaneously photographing two black and 

white images using red and green filters. This look creates an odd but pleasing 

hand-painted look where faces appear normal and green takes on a blue-green 
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quality, while the sky and all things blue appear cyan. Our Two Strip filter was 

created under the direction of Academy Award Winning Visual Effects 

Supervisor Rob Legato.

Go to the Three Strip / Two Strip Tutorial to see how the filters work.

Category
Film Lab.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Opacity
Sets the intensity of the of the effect.

Strips
Red Intensity
Intensifies red values in the image.
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Red Smooth
Blurs the red selection that is used to isolate the red values. Use this control to 

smooth out any noise that may appear if the Red Intensity is turned up to a high 

value.

Green Intensity
Intensifies green values in the image.

Green Smooth
Blurs the green selection that is used to isolate the green values. Use this 

control to smooth out any noise that may appear if the Green Intensity is turned 

up to a high value.

Blue Intensity
Intensifies blue values in the image when using the Three Strip filter, but 

darkens image areas that were blue in the source image when using the Two 

Strip filter.

Blue Smooth
Blurs the blue selection that is used to isolate the blue values. Use this control 

to smooth out any noise that may appear if the Blue Intensity is turned up to a 

high value.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 TINT

Description
Tints the entire image with a selected color.

Go to the Tint Tutorial to see how the filter works.

Category
HFX Grads/Tints.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Tint
Color
Sets the color that the image will be tinted with. Select the desired color using 

the color picker. The default color is a sepia tone.
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Opacity
Sets the opacity of the tint color.

Grad
Tint can optionally use a gradient that limits where the filter is applied. Grad is 

the transition area that goes from the tinted image to the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 ULTRA CONTRAST

Description
Tiffen was recognized with a Technical Achievement Award from the Academy 

of Motion Picture Arts and Sciences for the Ultra Contrast optical filter which 

redistributes ambient light to capture details that would be lost in shadows. 

Contrast is lowered evenly throughout the image with no flare or halation.

Go to the Ultra Contrast Tutorial to see how the filter works.

Category
HFX Diffusion.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Shadows
Shadows
Raises the brightness of the shadows.

Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows. 

Highlights
Highlights
Lowers the brightness of the highlights.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights. 

Go to the Selection section of Common Filter Controls to see how the Position 

and Range controls work.
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 VARI-STAR

Description
Variable multi-point star patterns are generated on highlights in the image.

Go to the Vari-Star Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Star
The Star settings control the various qualities of the generated star patterns.

Blend
Determines the blend mode to be used when adding the stars.
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Add
The stars are added to your image.

Screen
The stars are combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Determines the brightness of the stars.

Spokes
Controls the number of star spokes.

Size
Sets the star size.

Angle
Rotates the stars.

Color
Sets the star color.

Threshold
Controls the amount of stars. The higher the threshold value, the less stars you 

will see.
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 VIGNETTE

Description
A vignette, or soft fade, is a popular photographic effect where the photo 

gradually fades into the background, usually in a circular or rectangular shape. 

The vignette can be any color as well as thrown out of focus.

Go to the Vignette Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Vignette
Color
The Color parameter sets the color of the vignette through the use of a standard 

color picker. The default color is black.
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Opacity
Sets the opacity of the colored vignette. For defocused vignettes, you may want 

to turn down the Opacity so you can see the defocused effect.

Blur
Sets the softness of the image in the area of the vignette.

Shape
Roundness
Sets the roundness of the vignette. The vignette can either be circular or square 

or anywhere in between.

Size
Sets the size of the vignette.

Aspect Ratio
Changes the aspect ratio of the vignette. A value of -100 would be wider, and 

100 would be taller.

Rotation
Rotates the vignette.

Distortion
Distorts the edge of the vignette.

Distortion Size
Sets the size of the distortion.

Randomize
Randomizes the distortion.

Softness
The Softness parameters control the softness of the vignette edge.
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 WATER DROPLETS

Description
Simulates the circular, rainbow colored optical effects produced by tiny water 

droplets in clouds, mist and fog.

Go to the Water Droplets Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.

Light
Blend
Determines the blend mode to be used to add the rainbow.
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Add
The rainbow is added to your image.

Screen
The rainbow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the rainbow.

Displacement
Displaces the rainbow by the luminance values of the image. This “fakes” the 

effect of the rainbow wrapping over objects in the image.

Blur
Sets the softness of the rainbow.

Rainbow
Blend Mode
The rainbow can be added to the entire image or limited to a selection. 

Rainbow Only
The rainbow is added to the entire image.

Selection
The rainbow is added only in areas of the selection.
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Type

Corona
A corona has a bright center and is surrounded by a number of concentric 

colored rings.

Fogbow
A fogbow is similar to a rainbow, but because of the very small size of water 

droplets that cause fog, the fogbow has little color and appears white.
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Glory
Formed when light is scattered backwards by water droplets, glories have 

multiple colored rings with a bright center, but not as bright as a corona’s. In 

addition, the rings dissipate much slower than those of the corona.

Position
The rainbow position can be adjusted by clicking and dragging an on-screen 

control in the center of the image.

Position X
The horizontal position of the rainbow.

Position Y
The vertical position of the rainbow.

Note: For Final Cut Pro, you must activate the cross hair icon next to the Position 
parameter.

Scale

Scale X
The horizontal scale of the rainbow.

Scale Y
The vertical scale of the rainbow.
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Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Note: When Gang is turned on, the Scale Y slider doesn’t physically move. However, 
the Scale Y value will follow the value of the Scale X slider when Gang is turned on.

Selection
A selection can be used to limit where the rainbow will be placed. Wherever 

there is white in the selection is where the rainbow will be added. Go to the 

Selection parameters to see how they work.

Note: To use a selection to limit where the rainbow will be added, the Rainbow > Blend 
Mode must be set to Selection.
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 WIDE ANGLE LENS

Description
Simulates the effect of a wide angle lens.

Go to the Wide Angle Lens Tutorial to see how the filter works.

Category
Lens.

Distortion
Pulls the corners of the image outward.

X and Y Correction
X and Y Correction compensate for the deformation introduced with the 

Distortion parameter.
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 X-RAY

Description
Simulates the look of X-Ray images.

Go to the X-Ray Tutorial to see how the filters work.

Category
Special Effects.

Controls

Presets
To select a preset, open the Dfx interface and pick one from the Presets 

window.
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Black and White
Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

darken the midtones, negative values lighten the midtones.

Color
Opacity
Sets the opacity of the color.

Color
The Color parameter sets the color of the x-ray through the use of a standard 

color picker and defaults to blue.
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 BLEND MODES

Blend modes are used to combine images in a variety of different ways.

Normal
Edits each pixel to make it the result color. This is the default mode. Changing 

the opacity results in a mix between two layers.

Darken
Looks at the color information in each channel and selects the base or blend 

color—whichever is darker—as the result color. Pixels lighter than the blend 

color are replaced, and pixels darker than the blend color do not change.

Multiply
Looks at the color information in each channel and multiplies the base color by 

the blend color. The result color is always a darker color. Multiplying any color 

with black produces black. Multiplying any color with white leaves the color 

unchanged.

Color Burn
Looks at the color information in each channel and darkens the base color to 

reflect the blend color by increasing the contrast between the two. Blending 

with white produces no change.

Linear Burn
Looks at the color information in each channel and darkens the base color to 

reflect the blend color by decreasing the brightness. Blending with white 

produces no change.

Darker Color
Compares the total of all channel values for the blend and base color and 

displays the lower value color. Darker Color does not produce a third color, 

which can result from the Darken blend, because it chooses the lowest channel 

values from both the base and the blend color to create the result color.
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Lighten
Looks at the color information in each channel and selects the base or blend 

color—whichever is lighter—as the result color. Pixels darker than the blend 

color are replaced, and pixels lighter than the blend color do not change.

Add
The pixels of one image are added to another image

Screen
Looks at each images color information and multiplies the inverse of the two 

images. This looks kind of like the Add blend mode, but highlights are retained.

Color Dodge
Looks at the color information in each channel and brightens the base color to 

reflect the blend color by decreasing contrast between the two. Blending with 

black produces no change.

Linear Dodge (Add)
Looks at the color information in each channel and brightens the base color to 

reflect the blend color by increasing the brightness. Blending with black 

produces no change.

Lighter Color
Compares the total of all channel values for the blend and base color and 

displays the higher value color. Lighter Color does not produce a third color, 

which can result from the Lighten blend, because it chooses the highest 

channel values from both the base and blend color to create the result color.

Overlay
Multiplies or screens the colors, depending on the base color. Patterns or colors 

overlay the existing pixels while preserving the highlights and shadows of the 

base color. The base color is not replaced, but mixed with the blend color to 

reflect the lightness or darkness of the original color.
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Soft Light
Darkens or lightens the colors, depending on the blend color. The effect is 

similar to shining a diffused spotlight on the image. If the blend color (light 

source) is lighter than 50% gray, the image is lightened as if it were dodged. If 

the blend color is darker than 50% gray, the image is darkened as if it were 

burned in.

Hard Light
Multiplies or screens the colors, depending on the blend color. The effect is 

similar to shining a harsh spotlight on the image. If the blend color (light source) 

is lighter than 50% gray, the image is lightened, as if it were screened. This is 

useful for adding highlights to an image. If the blend color is darker than 50% 

gray, the image is darkened, as if it were multiplied. This is useful for adding 

shadows to an image.

Vivid Light
Burns or dodges the colors by increasing or decreasing the contrast, 

depending on the blend color. If the blend color (light source) is lighter than 50% 

gray, the image is lightened by decreasing the contrast. If the blend color is 

darker than 50% gray, the image is darkened by increasing the contrast.

Linear Light
Burns or dodges the colors by decreasing or increasing the brightness, 

depending on the blend color. If the blend color (light source) is lighter than 50% 

gray, the image is lightened by increasing the brightness. If the blend color is 

darker than 50% gray, the image is darkened by decreasing the brightness.

Pin Light
Replaces the colors, depending on the blend color. If the blend color (light 

source) is lighter than 50% gray, pixels darker than the blend color are 

replaced, and pixels lighter than the blend color do not change. If the blend 

color is darker than 50% gray, pixels lighter than the blend color are replaced, 

and pixels darker than the blend color do not change. This is useful for adding 

special effects to an image.
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Difference
Looks at the color information in each channel and subtracts either the blend 

color from the base color or the base color from the blend color, depending on 

which has the greater brightness value. Blending with white inverts the base 

color values; blending with black produces no change.

Exclusion
Creates an effect similar to but lower in contrast than the Difference mode. 

Blending with white inverts the base color values. Blending with black produces 

no change.

Subtract
Looks at the color information in each channel and subtracts the blend color 

from the base color. In 8 and 16-bit images, any resulting negative values are 

clipped to zero.

Hue
Creates a result color with the luminance and saturation of the base color and 

the hue of the blend color.

Saturation
Creates a result color with the luminance and hue of the base color and the 

saturation of the blend color.

Color
Creates a result color with the luminance of the base color and the hue and 

saturation of the blend color. This preserves the gray levels in the image and is 

useful for coloring monochrome images and for tinting color images.
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 KEYBOARD SHORTCUTS

Help Shortcuts

Shortcut Action

F1 Opens the Dfx User Guide
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Viewer Keyboard Shortcuts

Shortcut Action

Middle-mouse drag Pans the image

Space Bar-drag Pans the image

I Key Zooms the image in

O Key Zooms the image out

Zoom icon-Drag a square Zooms into the defined area

Scroll wheel over image Zooms the image in and out

Middle-mouse double click Fits the image to the window

F Fits the image to the window

H Opens the Histogram window
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	Defog
	Description
	Category

	Controls
	Presets
	Defog
	Color Correct


	Defringe
	Description
	Category

	Controls
	Presets
	Red
	Green, Blue, Cyan, Magenta, and Yellow


	DeNoise
	Description
	Category

	Controls
	Presets
	Amount


	Depth of Field
	Description
	Category

	Controls
	Presets
	Depth
	Blur
	Grad
	Selection


	Diffusion
	Description
	Category

	Controls
	Presets
	Diffusion
	Color Correct
	Selection
	Texture


	Diffusion/FX®
	Description
	Black Diffusion/FX®
	Gold Diffusion/FX®
	Category

	Controls
	Presets
	Blur
	Edge
	Selection
	Temperature


	Double Fog
	Description
	Category

	Controls
	Presets
	Fog
	Glow
	Selection


	Dual Grad
	Description
	Category

	Controls
	Presets
	Color 1
	Color 2
	Preserve Highlights
	Exposure Compensation
	Grad


	Edge Glow
	Description
	Category

	Controls
	Presets
	Glow
	Edge


	Enhancing
	Description
	Category

	Controls
	Presets
	Enhancing
	Selection


	Eye Light
	Description
	Category

	Controls
	Light
	Shadow
	DVE


	Faux Film
	Description
	Category

	Controls
	Presets
	Mist
	Grain
	Color Correct
	Selection


	Film Stocks
	Description
	Category

	Controls
	Presets
	Amount
	Black and White
	Film Response
	Color Correct
	Filter
	Sharpen
	Diffusion
	Vignette
	Grain


	Flashing
	Description
	Category

	Controls
	Presets
	Shadows
	Highlights


	FL-B/D®
	Description
	Category

	Controls
	Presets
	Temperature


	Flag / Dot
	Description
	Category

	Controls
	Flag / Dot
	DVE


	Fog
	Description
	Category

	Controls
	Presets
	Fog
	Selection


	Gels
	Description
	Category
	GamColor Gels
	Gels
	Rosco Gels

	Controls
	Presets
	Gels
	Grad


	Glimmerglass®, Bronze Glimmerglass®
	Description
	Glimmerglass®
	Bronze Glimmerglass®
	Category

	Controls
	Presets
	Blur
	Edge
	Selection
	Mist
	Color Correct
	Temperature


	Glow
	Description
	Category

	Controls
	Presets
	Glow
	Color Correct
	Selection


	Glow Darks
	Description
	Category

	Controls
	Presets
	Glow
	Color Correct
	Selection


	Grain
	Description
	Category

	Controls
	Presets
	Monochrome
	Size
	Amount
	Softness
	Film Response


	Halo
	Description
	Category

	Controls
	Presets
	Diffusion
	Color Correct


	Haze / Sky
	Description
	Haze
	Sky
	Category

	Controls
	Presets
	Haze
	Temperature
	Cyan/Magenta


	HDTV/FX®
	Description
	Category

	Controls
	Presets
	Blur
	Edge
	Selection
	Contrast


	HFX® Star
	Description
	Category

	Controls
	Presets
	Star


	High Contrast
	Description
	Category

	Controls
	Presets
	Contrast
	Amount


	Ice Halos
	Description
	Category

	Controls
	Presets
	Light
	Halo
	Selection


	Infrared
	Description
	Category

	Controls
	Presets
	Black and White
	Mist
	Color Correct
	Selection


	Kelvin
	Description
	Category

	Controls
	Presets
	Color Temperature
	Grad


	Key Light
	Description
	Category

	Controls
	Type
	Strength
	Angle
	Invert


	Lens Distortion
	Description
	Category

	Controls
	Distortion
	Anamorphic Squeeze
	Curvature X and Y
	Center


	Light / Gobo
	Description
	Category

	Presets
	Light
	Blend
	Brightness
	Displacement
	Blur
	Gels
	Color

	Shadow
	Brightness

	Selection
	Gobos
	Type
	Blend Mode
	Opacity
	Blur
	DVE


	Looks: Black/White & Color
	Description
	Category

	Controls
	Presets
	Color Correct
	Diffusion
	Color-Grad®
	Gels
	Lab
	Grain
	Post Color Correct


	Low Contrast
	Description
	Category

	Controls
	Presets
	Contrast
	Selection


	Match
	Description
	Category

	Controls
	Brightness
	Color
	Detail
	Grain
	Tone
	Source
	Match


	Mono Tint
	Description
	Category

	Controls
	Presets
	Black and White
	Tint


	ND-Grad
	Description
	Category

	Controls
	Presets
	F-Stop
	Grad


	Night Vision
	Description
	Category

	Controls
	Presets
	Black and White

	Tint
	Color
	Opacity

	Glow
	Blend
	Brightness
	Blur

	Additional Controls
	Grain
	Color Correct
	Selection


	Nude/FX®
	Description
	Category

	Controls
	Presets
	Color
	Grad


	Old Photo
	Description
	Category

	Controls
	Presets
	Filter
	Tint
	Color Correct


	Overexpose
	Description
	Category

	Controls
	Presets
	Amount
	Intensity
	Blur


	Ozone
	Description
	Category
	Extract On

	Zone Controls
	Position
	Range
	Hue
	Saturation
	Brightness
	Contrast
	Gamma
	Red
	Green
	Blue
	Temperature

	Zone Thumbnail

	Pencil
	Description
	Category

	Controls
	Presets
	Amount
	Color


	Photographic
	Description
	Photographic
	Color Conversion
	Light Balancing
	Color Compensating
	Category

	Controls
	Presets
	Filters
	Grad


	Polarizer / Warm Polarizer
	Description
	Polarizer
	Warm Polarizer
	Category

	Controls
	Presets
	Sky
	Warming
	Selection


	Pro-Mist®
	Description
	Pro-Mist®
	Warm Pro-Mist®
	Cool Pro-Mist®
	Black Pro-Mist®
	Warm Black Pro-Mist®
	Category

	Controls
	Presets
	Mist
	Color Correct
	Temperature
	Selection


	Rack Focus
	Description
	Category

	Controls
	Presets
	Blur
	Aperture


	Radial Exposure
	Description
	Category

	Controls
	Exposure
	Spot


	Rainbow
	Description
	Category

	Controls
	Light
	Rainbow
	Crop
	Selection


	Rays
	Description
	Category

	Controls
	Rays
	Color
	Shimmer
	Opacity


	ReLight
	Description
	Category

	Light
	Blend
	Brightness
	Displacement
	Blur
	GamColor Presets
	Color

	Selection
	Light Source
	Blend
	Opacity
	Radius
	Falloff Radius
	Falloff
	DVE


	Reflector
	Description
	Category

	Controls
	Presets
	Brightness
	Color
	Position
	Range


	Selective Color Correct
	Description
	Category

	Color Correct
	Hue
	Saturation
	Brightness
	Contrast
	Gamma
	Red
	Green
	Blue
	Temperature

	Selection
	Extract On
	Position
	Range
	Black Clip
	White Clip
	Shrink/Grow
	Blur
	Invert


	Selective Saturation
	Description
	Category

	Controls
	Presets
	Shadows
	Midtones
	Highlights


	Sepia / 812® Warming
	Description
	Sepia
	812® Warming
	Category

	Controls
	Presets
	Color
	Grad


	Smoque®
	Description
	Category

	Controls
	Presets
	Smoke
	Selection


	Soft Contrast
	Description
	Category

	Controls
	Presets
	Highlights
	Position
	Range


	Soft/FX®, Warm Soft/FX®
	Description
	Soft/FX®
	Warm Soft/FX®
	Category
	Presets
	Blur
	Temperature


	Soft Light
	Description
	Category

	Controls
	Presets
	Blend
	Brightness
	Blur
	GamColor Presets
	Color


	Split Field
	Description
	Category

	Controls
	Presets
	Blur
	Split


	Split Tone
	Description
	Category

	Controls
	Shadows
	Midtones
	Highlights
	Preserve Highlights
	Exposure Compensation


	Star
	Description
	Category

	Controls
	Presets
	Star
	Selection


	Streaks
	Description
	Category

	Controls
	Presets
	Streaks
	Selection


	Strip Grad
	Description
	Category

	Controls
	Presets
	Filters
	Grad


	Sunset/Twilight
	Description
	Category

	Controls
	Presets
	Color 1
	Color 2
	Color 3
	Preserve Highlights
	Exposure Compensation
	Grad


	Texture
	Description
	Category

	Controls
	Presets
	Amount
	Complexity
	Randomize
	DVE


	Three Strip / Two Strip
	Three Strip
	Two Strip
	Category
	Controls
	Presets
	Opacity
	Strips
	Color Correct


	Tint
	Description
	Category

	Controls
	Presets
	Tint
	Grad


	Ultra Contrast
	Description
	Category

	Controls
	Presets
	Shadows
	Highlights


	Vari-Star
	Description
	Category

	Controls
	Presets
	Star


	Vignette
	Description
	Category

	Controls
	Presets
	Vignette
	Shape


	Water Droplets
	Description
	Category

	Controls
	Presets
	Light
	Rainbow
	Selection


	Wide Angle Lens
	Description
	Category
	Distortion
	X and Y Correction


	X-Ray
	Description
	Category

	Controls
	Presets
	Black and White
	Color


	Blend Modes
	Normal
	Darken
	Multiply
	Color Burn
	Linear Burn
	Darker Color
	Lighten
	Add
	Screen
	Color Dodge
	Linear Dodge (Add)
	Lighter Color
	Overlay
	Soft Light
	Hard Light
	Vivid Light
	Linear Light
	Pin Light
	Difference
	Exclusion
	Subtract
	Hue
	Saturation
	Color

	Keyboard Shortcuts

